HeartStart Event Review Pro
User Guide
About this edition
HeartStart Event Review Pro version 5.0
Publication date: December 2015
Document part number: 453564556351

The information in this document applies to the product version indicated above. This information is subject to change without notice.

Philips Medical Systems shall not be liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of the material.

Copyright © 2015 Philips North America Corp.

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any human or computer language in any form by any means without the consent of the copyright holder.

Unauthorized copying of this publication may not only infringe copyright but also reduce the ability of Philips Medical Systems to provide accurate and up-to-date information to users and operators alike.

Medical device directive
Event Review Pro complies with the requirements of the Medical Device Directive 93/42/EEC and carries the CE mark accordingly.

Trademarks
HeartStart Event Review Pro, HeartStart FR3, HeartStart FRx, HeartStart HS1, HeartStart Defibrillator, HeartStart MRx, HeartStart XL+, Efficia DFMI00, and the HeartStart logo are either trademarks or registered trademarks of Koninklijke Philips N.V.

The Event Review Pro application uses Bluetooth wireless technology. The Bluetooth wordmark and logos are either trademarks or registered trademarks of Bluetooth SIG, Inc. The Bluetooth wordmark and logos are owned by Bluetooth SIG, Inc.

Adobe, Acrobat, and Reader are either trademarks or registered trademarks of Adobe Systems Incorporated in the United States and/or other countries. Microsoft® Windows, Windows 7, Windows 8.1, Windows 10, Windows Explorer, Microsoft .NET Framework, and Internet Explorer are either trademarks or registered trademarks of Microsoft® Corporation in the United States and/or other countries.

Actiontec is either a trademark or a registered trademark of Actiontec Electronics, Inc. CompactFlash is either a trademark or a registered trademark of SanDisk Corporation. IrDA and IR logo are trademarks or registered trademarks of Infrared Data Association. Kingston is either a trademark or a registered trademark of Kingston Technologies Company. Microsoft, Windows, Internet Explorer, Excel, Word, and Outlook are either trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries. Q-CPR is either a trademark or a registered trademark of Laerdal Medical.

Authorized EU representative
Philips Medizin Systeme
Boeblingen GmbH
Hewlett-Packard Strasse 2
71034 Boeblingen, Germany
(+49) 7031 463-2254

Manufacturer
Philips Medical Systems
22100 Bothell Everett Highway
Bothell, WA 98021-8431, USA
# Table of contents

## Installing Event Review Pro
- About the Event Review Pro software .............................................. 9
- System requirements ........................................................................... 9
- Downloading the software ................................................................. 12
- Checking for software updates ............................................................ 13
- The installation procedure ................................................................. 13
- Activating the software ...................................................................... 14
  - Activate over the Internet ................................................................. 15
  - Activate by email ............................................................................. 15
  - Activate later .................................................................................. 17
- Uninstalling the software .................................................................... 17
- Product compatibility .......................................................................... 18

## Getting started
- Intended use ...................................................................................... 19
- What’s new in this release ................................................................. 19
- Getting assistance ............................................................................... 20
- Conventions used in this guide .......................................................... 21

## Starting the application
- Understanding the Getting Started options ...................................... 23
- Using the navigation pane ................................................................. 24
- Using the Administration workspace .................................................. 25

## Understanding the application window
- Understanding the Case Editor ......................................................... 28
- Using the application tables and logs .................................................. 32
  - Working with columns ..................................................................... 35
  - Grouping and sorting entries ......................................................... 35
- Filtering entries ................................................................................ 37
- Removing filters ............................................................................... 39
- Printing table entries ....................................................................... 39
- Exporting data to Excel .................................................................... 40
- Completing fields ............................................................................ 40
Table of contents

Event Review Pro User Guide

Resizing panes and workspaces ................................................................. 41
Using a Tablet PC ....................................................................................... 41
Saving your work ....................................................................................... 42
Restoring confirmation messages ............................................................. 42

Working with cases .................................................................................... 43
Searching for cases ................................................................................... 44
Using queries ............................................................................................. 46
Creating a case (including ECG) with wizards .......................................... 47
Creating a case .......................................................................................... 50
Attaching ECGs ......................................................................................... 51
  Attaching ECGs table .............................................................................. 54
  Attaching an ECG from a data card ......................................................... 55
  Attaching an ECG from a USB port ......................................................... 56
  Attaching an ECG using an FR3 Bluetooth transmission ...................... 56
  Downloading an ECG using a HeartStart MRx Bluetooth transmission ... 57
  Downloading an ECG from an infrared connection ............................... 58
  Attaching an ECG from a file ................................................................. 60
  After you add an ECG ............................................................................ 60
Removing ECGs from a case ..................................................................... 61
Displaying case details ............................................................................. 61
Sorting and grouping cases ...................................................................... 62
Hiding and displaying grouped cases ....................................................... 63
Importing case files manually .................................................................. 64
Importing case files automatically ........................................................... 65
Saving cases ............................................................................................. 66
Adjusting the date and time of the defibrillator data .............................. 66
Erasing the data source ............................................................................ 67
Printing case information ........................................................................ 69
Exporting cases ....................................................................................... 69
Emailing a case ......................................................................................... 71
Deleting cases .......................................................................................... 72
Reviewing cases with duplicate ECGs ..................................................... 73
Merging related cases .............................................................................. 74
Merging related cases automatically ....................................................... 76

Adding case details ................................................................................... 78
Identifying the case .................................................................................. 79
Describing the conditions at the scene .................................................... 84
Documenting events .................................................................................. 85
  Adding, describing, and removing events .............................................. 85
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sorting events</td>
<td>86</td>
</tr>
<tr>
<td>Changing the date and time of the event</td>
<td>87</td>
</tr>
<tr>
<td>Documenting the patient's outcome</td>
<td>87</td>
</tr>
<tr>
<td>Working with ECGs</td>
<td>88</td>
</tr>
<tr>
<td>Understanding the Case Editor</td>
<td>88</td>
</tr>
<tr>
<td>Using the Events pane</td>
<td>93</td>
</tr>
<tr>
<td>Viewing waveforms</td>
<td>97</td>
</tr>
<tr>
<td>Working with waveforms</td>
<td>97</td>
</tr>
<tr>
<td>Displaying and hiding waveforms</td>
<td>99</td>
</tr>
<tr>
<td>Arranging sections of the ECG display</td>
<td>99</td>
</tr>
<tr>
<td>Magnifying waveforms</td>
<td>100</td>
</tr>
<tr>
<td>Changing the display time</td>
<td>100</td>
</tr>
<tr>
<td>Changing the time scale</td>
<td>101</td>
</tr>
<tr>
<td>Scrolling through the waveform</td>
<td>102</td>
</tr>
<tr>
<td>Customizing waveforms</td>
<td>102</td>
</tr>
<tr>
<td>Changing the waveform offset</td>
<td>104</td>
</tr>
<tr>
<td>Changing the waveform scale</td>
<td>106</td>
</tr>
<tr>
<td>Reviewing waveform information</td>
<td>106</td>
</tr>
<tr>
<td>Defining and viewing ECG selections</td>
<td>108</td>
</tr>
<tr>
<td>Creating ECG selections</td>
<td>109</td>
</tr>
<tr>
<td>Managing ECG selections</td>
<td>109</td>
</tr>
<tr>
<td>Naming, finding, and sorting ECG selections</td>
<td>111</td>
</tr>
<tr>
<td>Using selection templates</td>
<td>112</td>
</tr>
<tr>
<td>Copying ECGs to the Clipboard</td>
<td>113</td>
</tr>
<tr>
<td>Exporting waveform data</td>
<td>113</td>
</tr>
<tr>
<td>Managing notes on the waveform</td>
<td>114</td>
</tr>
<tr>
<td>Zooming in and out of the waveform</td>
<td>116</td>
</tr>
<tr>
<td>Customizing the ECG display</td>
<td>117</td>
</tr>
<tr>
<td>Reviewing vital trends data</td>
<td>117</td>
</tr>
<tr>
<td>Working with 12-lead ECGs</td>
<td>119</td>
</tr>
<tr>
<td>Configuring the 12-lead view</td>
<td>121</td>
</tr>
<tr>
<td>Reviewing the 12-lead ECG</td>
<td>122</td>
</tr>
<tr>
<td>Magnifying 12-lead ECGs</td>
<td>122</td>
</tr>
<tr>
<td>Working with CPR data</td>
<td>123</td>
</tr>
<tr>
<td>Customizing CPR episodes</td>
<td>123</td>
</tr>
<tr>
<td>Creating CPR exclusions</td>
<td>125</td>
</tr>
<tr>
<td>Removing CPR exclusions</td>
<td>126</td>
</tr>
<tr>
<td>Adding CPR annotations</td>
<td>127</td>
</tr>
<tr>
<td>Adding CPR responder annotations</td>
<td>128</td>
</tr>
<tr>
<td>Using key command and mouse shortcuts</td>
<td>129</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>-----</td>
</tr>
<tr>
<td><strong>Reviewing case details</strong></td>
<td>133</td>
</tr>
<tr>
<td>Reviewing case events</td>
<td>133</td>
</tr>
<tr>
<td>Attaching files to a case</td>
<td>135</td>
</tr>
<tr>
<td>Completing a final case review</td>
<td>137</td>
</tr>
<tr>
<td><strong>Using the Import Service</strong></td>
<td>138</td>
</tr>
<tr>
<td>Managing Import Service inboxes</td>
<td>139</td>
</tr>
<tr>
<td>Configuring the Import Service</td>
<td>141</td>
</tr>
<tr>
<td>Managing Import Service archives</td>
<td>142</td>
</tr>
<tr>
<td>Using the HTTP Import Service</td>
<td>143</td>
</tr>
<tr>
<td><strong>Working with the System Log</strong></td>
<td>145</td>
</tr>
<tr>
<td><strong>Working with reports</strong></td>
<td>147</td>
</tr>
<tr>
<td>Selecting cases for reports</td>
<td>148</td>
</tr>
<tr>
<td>Selecting CPR Guidelines for reporting</td>
<td>150</td>
</tr>
<tr>
<td>Generating reports</td>
<td>151</td>
</tr>
<tr>
<td>Generating a report for an open case</td>
<td>151</td>
</tr>
<tr>
<td>Generating a report using the Reports workspace</td>
<td>152</td>
</tr>
<tr>
<td>Working in Report Preview</td>
<td>153</td>
</tr>
<tr>
<td>Printing reports</td>
<td>154</td>
</tr>
<tr>
<td>Exporting reports</td>
<td>154</td>
</tr>
<tr>
<td>Working with case reports</td>
<td>155</td>
</tr>
<tr>
<td>Working with ECG reports</td>
<td>155</td>
</tr>
<tr>
<td>Working with 12-lead reports</td>
<td>156</td>
</tr>
<tr>
<td>Working with Q-CPR Report Card reports</td>
<td>158</td>
</tr>
<tr>
<td>Information in the Q-CPR Report Card chart</td>
<td>159</td>
</tr>
<tr>
<td>Information in the Q-CPR Report Card details</td>
<td>163</td>
</tr>
<tr>
<td>Information in the Q-CPR Report Card compression strips</td>
<td>166</td>
</tr>
<tr>
<td>Working with Q-CPR Details reports</td>
<td>167</td>
</tr>
<tr>
<td>Q-CPR Details report data</td>
<td>169</td>
</tr>
<tr>
<td>Working with Q-CPR Response Time reports</td>
<td>173</td>
</tr>
<tr>
<td>Information in the Q-CPR Response Times overview</td>
<td>174</td>
</tr>
<tr>
<td>Information in the Q-CPR Response Times details</td>
<td>178</td>
</tr>
<tr>
<td>Working with zCPR Report Card reports</td>
<td>179</td>
</tr>
<tr>
<td>Information in the zCPR Report Card chart</td>
<td>180</td>
</tr>
<tr>
<td>Information in the zCPR Report Card compression strips</td>
<td>182</td>
</tr>
<tr>
<td>Working with Vital Trends reports</td>
<td>183</td>
</tr>
<tr>
<td>Working with Response Times reports</td>
<td>183</td>
</tr>
<tr>
<td>Working with Utstein reports</td>
<td>186</td>
</tr>
<tr>
<td>Working with Device Self-test History reports</td>
<td>187</td>
</tr>
</tbody>
</table>
## Table of contents

**Customer support**  
-----------------------------------  **189**  

**Working with defibrillators**  
-----------------------------------  **192**  

- Supported defibrillators .................................................. 192  
- Selecting accessories for data transfer .................................. 193  
- Reading FR3 series cards ................................................... 195  
- Retrieving FR3 data using Bluetooth transmission .................. 195  
- Reading HeartStart MRx cards ............................................. 196  
- Setting up Bluetooth transmissions for the HeartStart MRx .......... 197  
  - Bluetooth option prerequisites for the HeartStart MRx ........... 198  
  - Pairing and testing the HeartStart MRx Bluetooth option with the computer 198  
  - Sending the HeartStart MRx Bluetooth transmission ................ 199  
- Reading FR2 series cards ................................................... 200  
- Reading HeartStart XL cards .............................................. 201  
- Transferring HeartStart XL+ data ....................................... 201  
- Transferring Efficia DFM100 data ...................................... 202  
- Determining the HS1 and FRx case date and time .................... 202  
- Using infrared connections for the HS1 and FRx ..................... 203  
  - Setting up an infrared adapter ....................................... 204  
  - Setting up the infrared connection .................................... 204  
- Understanding voice and system messages ............................ 206  
- Emailing device history data ........................................... 207  
- Importing device self-test data using the Device Self-test Wizard .................................................. 209  

**Managing the database**  
-----------------------------------  **212**  

- Using the Event Review Pro database on a remote database server .... 213  
- Migrating cases from previous versions ................................ 214  

**CPC and OPC**  
-----------------------------------  **217**  

**Glasgow Coma score**  
-----------------------------------  **219**  

**Glossary**  
-----------------------------------  **221**  

**Index**  
-----------------------------------  **223**
HeartStart Event Review Pro 5.0 is a major upgrade for both Event Review Pro and Event Review, and requires a new license. You can install and run the new version for 60 days while you purchase a license. Event Review Pro stops working if you do not activate the software within 60 days of installation.

HeartStart Event Review Pro 5.0 installation removes any existing 4.x versions of Event Review Pro and Event Review from the computer.

If you have Event Review or Event Review Pro older than version 3.5, You must first upgrade and migrate the data to 3.5, then you can migrate the data to Event Review Pro 5.0.

- For information about migrating data from earlier versions, see Migrating cases from previous versions on page 214.
- For information about product compatibility, see Product compatibility on page 18.
- For full details about hardware and software requirements, see System requirements on page 9.
- For help with downloading, see Downloading the software on page 12.
- For help with installing, see The installation procedure on page 13.
- For help setting up a remote database for use with Event Review Pro, see Using the Event Review Pro database on a remote database server on page 213.
About the Event Review Pro software

Event Review Pro is available in two editions. Each offers viewing and editing features for cases acquired from defibrillators in specific situations:

- **EMS edition**: defibrillators used by first-responders, in resuscitations outside a hospital
- **Hospital edition**: defibrillators used for resuscitations within a hospital

When you install the software, the default option is the EMS edition; however, you will have the opportunity to select the Hospital edition instead.

Event Review Pro is available in different license types, determined at the time of purchase:

- Single-installation license, for use on only one computer
- Site license, for use on multiple computers

System requirements

Event Review Pro operates on a computer running the Microsoft Windows 7, Windows 8.1 or Windows 10 operating system. Make sure that any hardware you choose is certified as Microsoft - compatible.

Philips provides only the Event Review Pro software. The software and hardware listed in the following table are provided by the customer, unless noted.

This table has the following sections:

- Software requirements
- Hardware requirements
- Accessories
## Software requirements table

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Microsoft Windows 7, 32-bit or 64-bit, with SP1</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows 8.1, 32-bit or 64-bit</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows 10, 32-bit or 64-bit</td>
</tr>
<tr>
<td>Database</td>
<td>Note: Windows SQL 2014 Express is included and delivered with the product.</td>
</tr>
<tr>
<td></td>
<td>For a remote server running the shared database:</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows Server 2008 R2 with SP1, 2012, or 2012 R2</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows 7, 32-bit or 64-bit, with SP1</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows 8.1, 32-bit or 64-bit</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows 10, 32-bit or 64-bit</td>
</tr>
</tbody>
</table>

## Hardware requirements table

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor speed</td>
<td>Minimum: 1 GHZ x86 or x64 processor</td>
</tr>
<tr>
<td></td>
<td>Recommended: 2 GHZ core duo or higher</td>
</tr>
<tr>
<td>Display resolution</td>
<td>Minimum: 1024 x 768</td>
</tr>
<tr>
<td></td>
<td>Recommended: 1600 x 1200 or higher</td>
</tr>
<tr>
<td>Video memory</td>
<td>Minimum: 64 MB video memory</td>
</tr>
<tr>
<td></td>
<td>Recommended: 256 MB video memory</td>
</tr>
<tr>
<td>Memory</td>
<td>Minimum: 2 GB</td>
</tr>
<tr>
<td></td>
<td>Recommended: 4 GB or higher</td>
</tr>
</tbody>
</table>
## Component Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk space</td>
<td>Minimum: 25 GB of available disk space for database storage and backup&lt;br&gt;Hard-disk space requirements vary depending on usage and defibrillator type. Variables affecting disk-space requirements include the number of cases archived and the amount of audio information archived. For example, a 15-minute FR2 ECG with no audio is approximately 100 KB. The same ECG with audio can exceed 5 MB. An ECG and audio from a HeartStart MRx defibrillator can be as large as 256 MB.</td>
</tr>
<tr>
<td>Internet connection</td>
<td>Required to activate the application software, to use the Email feature, and to receive software updates.</td>
</tr>
</tbody>
</table>

### Accessories table

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer</td>
<td>To print reports&lt;br&gt;Preferred: Color printer</td>
</tr>
<tr>
<td>PDF Reader</td>
<td>To view <em>HeartStart Event Review Pro user guide</em>&lt;br&gt;Recommended: Adobe Reader, latest version. For more information, see the following Web site: <a href="https://get2.adobe.com/reader/">https://get2.adobe.com/reader/</a></td>
</tr>
<tr>
<td>Backup and restore tool</td>
<td>To help prevent data loss and corruption</td>
</tr>
<tr>
<td>Connection to a time server</td>
<td>To synchronize your computer date and time&lt;br&gt;Note: If you use a time server, do not alter your system clock manually.</td>
</tr>
<tr>
<td>Email application</td>
<td>To send cases using email or activate the software by email.</td>
</tr>
<tr>
<td>Spreadsheet application</td>
<td>To display Q-CPR data in charts; data is exported in .xlsx format only</td>
</tr>
<tr>
<td>Sound card and speaker</td>
<td>To play audio from the defibrillator</td>
</tr>
<tr>
<td>Component</td>
<td>Requirement</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Card reader</td>
<td>To read information from a defibrillator, see your Philips customer representative to purchase the appropriate card reader.</td>
</tr>
<tr>
<td></td>
<td>See <a href="#">Selecting accessories for data transfer on page 193</a> for a summary of the data card types.</td>
</tr>
<tr>
<td>IrDA support</td>
<td>Required to read information from an HS1 or FRx defibrillator</td>
</tr>
<tr>
<td></td>
<td>Your computer must support the following technology:</td>
</tr>
<tr>
<td></td>
<td>• IrDA functionality</td>
</tr>
<tr>
<td></td>
<td>• An infrared transceiver or an infrared adapter</td>
</tr>
<tr>
<td></td>
<td>The transceiver will appear as a small, dark red or black window on the computer and device.</td>
</tr>
<tr>
<td>Bluetooth</td>
<td>To transfer HeartStart MRx and HeartStart FR3 data to your computer</td>
</tr>
<tr>
<td>adapter</td>
<td></td>
</tr>
<tr>
<td>Bluetooth</td>
<td>To use Bluetooth to transfer MRx or FR3 data from the defibrillator to your computer</td>
</tr>
<tr>
<td>stack</td>
<td><em>Bluetooth</em> version: 2.0 or higher</td>
</tr>
</tbody>
</table>

You must have a supported adapter for Bluetooth transmission. Most Bluetooth adapters are suitable. You can order an adapter from your Philips representative.

**Downloading the software**

You can download and use Event Review Pro on a trial basis for 60 days before purchasing and activating the software.

Use the authorization that you receive from your sales representative to download the software from the Internet. Save the downloaded file to your computer. You can use the software on a trial basis and activate it later.

**To download the software**

1. Navigate to the URL provided on your Proof of Purchase Certificate or by your sales representative.
2. Click the download link.
3. Save the installation file to your computer.
For information on possible updates to the software, see Checking for software updates on page 13.

For instructions on installation, see The installation procedure on page 13.

Checking for software updates

You can check at any time to see if new updates have been released for Event Review Pro software.

Before you install any software updates on the computer, make sure that you have Windows Administrator privileges for the computer, and that the computer is connected to the Internet.

To check for software updates
1. On the Help menu, click Check for Updates.
   The software connects to the Web site.
2. Click Show Updates.
   The Web site displays a list of available updates. If a new update is available, follow the rest of this procedure to download and install it.
3. Click Get Update for the Application.
4. Click Download and follow the instructions to save the update.
5. Close the older version of the software.
6. Note the name and location of the saved, downloaded file and follow the instructions to install it.

The installation procedure

Once you have saved the installation file to your computer (see Downloading the software on page 12), follow these instructions.

To install Event Review Pro
1. In the folder where the installation file has been saved, right-click the file and click Run as Administrator.
   You may see a User Account Control box that asks you to authorize this program to make changes. Click Yes.
2. The Install Shield wizard checks for your database and for versions of the Microsoft .NET Framework. If it needs to install or upgrade either of these, it does so. Follow any instructions during this process (which can take some time); if the User Account Control box asks you to authorize this program to make changes, click Yes.

3. The Install Shield wizard dialog box is now ready to begin installation of Event Review Pro. Click Install.

4. On the Welcome screen, click Next.

5. On the next page, click I Accept the Terms.... and click Next.

6. The next page displays the current Read Me file, containing any late-breaking information. Read the text and then click Next.

7. On the next page, click the edition of Event Review Pro that you want to install, EMS or Hospital edition, and then click Next.

8. In the Custom Setup dialog box, you have the opportunity to save Event Review Pro in a different location from the default. If you need to check this new location for available space, click the Space button. If you want to choose a different location, click Change and navigate to the new location. When you are finished, or if you want to accept the default location, click Next.

9. Confirm that you want to continue install; click Install.

10. When the installation is finished, click Finish.

11. An entry for Event Review Pro now appears on the Start menu. See Starting the application on page 23.

Activating the software

After you install the software, activate the product.

You can use the Internet or email to activate the software at any time after you install the application. Until you complete the activation, you will see the Philips HeartStart Activation Wizard window when the application starts. At the end of 60 days, however, if you have not yet activated, you cannot run the application on this computer.

Once the software is activated, you can view the license number by clicking the Help menu and clicking About Event Review Pro. In addition, save the license number in a safe place that you can access in case you need to re-install the software.

Email activation support is available in English only at: activation.support@philips.com
Product support via email is available in English only at: eventreview.support@philips.com

For support telephone numbers and other information about customer support, see Customer support on page 189.

Activate over the Internet

You can activate the software by the Internet at any point when you first install the application, preferably within 60 days of installation.

At the end of the 60 days, however, if you have not yet activated, you cannot run the application on this computer.

The activation wizard uses an encrypted transfer to validate that the license number you enter has not already been used and to activate your software. If you are not connected to the Internet, the wizard alerts you that there is no connection.

For more information, see Customer support on page 189.

To activate the software by the Internet

1. Start the application.
   The application opens the HeartStart Activation Wizard.
2. Type the license number that you received.
3. Click I want to activate the software over the Internet.
4. Click Activate.
   The wizard validates your entry and displays a congratulations message.
5. Click OK.
   The wizard starts the application.

Activate by email

The email activation involves exchanging emails with Philips Customer Support.

An email application must be installed on this computer or you must have access to an email application.

For more information, see Customer support on page 189.

💡 Print this topic for future use.
**To activate the software by email**

1. Start the application.
   The application opens the HeartStart Activation Wizard.
2. Type the license number that you received.
3. Click **I want to activate the software by email**.
4. Click **Next**.
5. Click **Export Activation Request File**.
   The software saves a file named Philips HeartStart Event Review Pro 5.0 Activation Request File.bin to your desktop.
6. Create a new email message and, in the **To:** field, enter **activation.support@philips.com**.
7. In the email **Subject:** field, enter **Activation Request**.
8. Locate the file previously saved on your desktop: Philips HeartStart Event Review Pro 5.0 Activation Request File.bin, and attach that file to the email message.
9. Send the email and wait for a response from Customer Support.

   If you cannot send email from your computer, transfer the file saved on your desktop to a computer that can send email, and send the message from there.

**When you have received your activation code**

When you receive your activation code from Customer Support, you are ready to activate your software.

1. Start the application.
   The application opens the HeartStart Activation Wizard.
2. If the license number is not already pre-filled, enter the license number.
3. Click **I want to activate the software by email**.
4. Click **Next**.
5. Enter the activation code you received.
6. Click **Activate**.
   The wizard validates your entry and displays a congratulations message.
7. Click **OK**.
The wizard starts the application.

**Activate later**

If you do not want to activate your copy of the application when you first start it, you can activate the software at any time when you start the application. At the end of the 60 days, however, if you have not yet activated, you cannot run the application on this computer.

During the 60 days, you can use the application and save your work.

Until you activate the software, you will see the HeartStart Activation Wizard window each time that you start the application.

**To use the application without activating the software**

1. Start the application.
2. When HeartStart Activation Wizard opens, click **Skip**.  
   The wizard starts the application.

**Uninstalling the software**

If you have an active Internet connection at the time you remove the software, the removal process contacts the Philips activation server and releases your license number for installation on another computer. The removal process does not remove the database.

**To uninstall the software**

1. Navigate to the Windows Control Panel.
2. From Control Panel, click **All Control Panel Items**, and then click **Programs and Features**.
3. Right-click the application name, and then click **Uninstall**.

Your license must be released before you can install your software on another computer. In the event that the uninstall process is not able to automatically release the license, follow these instructions to request license number release from customer support.

---

*Note that if automatic license release is unable to complete, a Philips HeartStart Event Review Pro 5.0 License Release Request File.bin file is saved to the desktop.*
Sending a support request for license number release

1. Create a new email message and, in the To: field, enter activation.support@philips.com.
2. In the email Subject: field, enter License Release Request.
3. Locate the file previously saved on your desktop: Philips HeartStart Event Review Pro 5.0 License Release Request File.bin, and attach that file to the email message.
4. Send the email and wait for a response from Customer Support.
   Customer support will notify you by email when the license number is released.

If you cannot send email from your computer, transfer the file saved on your desktop to a computer that can send email, and send the message from there.

Product compatibility

HeartStart Event Review Pro 5.0 installation removes any existing 4.x versions of Event Review Pro and Event Review from the computer.

You can migrate the Event Review Pro 3.5 and Event Review Pro 4.x data to Event Review Pro 5.0 after installing Event Review Pro 5.0. For more information, see Migrating cases from previous versions on page 214.

If you have Event Review or Event Review Pro older than version 3.5, you must first upgrade and migrate the data to 3.5, then you can migrate the data to Event Review Pro 5.0. For more information, see Managing the database on page 212.
Getting started

In Event Review Pro, a "case" consists of all the information relating to a specific cardiac emergency. This includes information recorded by supported defibrillators as well as information entered by the device user. Event Review Pro creates a case by downloading ECG information, shock decisions, and any recorded audio from Philips defibrillators. You can add details to the case as well.

Intended use

HeartStart Event Review Pro captures, reports, and manages cardiac arrest information. Event Review Pro has tools for collecting and analyzing information, reviewing cases, identifying trends, and evaluating the emergency response. All information relating to a specific cardiac emergency is created in a case by downloading rhythm ECG information, 12-lead ECG information, shock decisions, patient vital sign data, and recorded audio from Philips automated external defibrillators (AED), and Philips advanced monitors/defibrillators. Event Review Pro allows users to annotate case details, including Basic Life Support (BLS) and Advanced Life Support (ALS) responder observations and interventions.

What’s new in this release

Event Review Pro 5.0 provides the following new features:

- Support for the Philips HeartStart FR3 defibrillator with Q-CPR.
- Improved Q-CPR reporting with AHA and ERC Guidelines-compliant report card.
- Customizable CPR Guidelines with ability to define depth and rate targets for CPR Report Cards.
- zCPR for retrospective review of CPR hands-on / hands-off times and compression rate using patient impedance.
• Improved ECG viewing, including overlay of multiple waveforms on screen and reports.
• Icons for incomplete release and compression events.
• Merging of case data allows for manual or automated integration of patient cases. This is based upon chosen criteria and supports up to 30 minutes of device time overlap. Compatible with any supported Philips defibrillators.
• Filtering of imported case data and timed purging of archived data. Automatic cleanup of incomplete MRx BLDT transmissions.
• Auto-completion of Quick Notes.
• Device self-test management, including a wizard which guides the user through downloading device self-test data.
• Migration of data from Event Review Pro 4.2/4.3 and Event Review 4.2/4.3.
• Supports AHA and ERC Guidelines 2015.

Any late-breaking news about features is in the Read Me document, available from the Help menu.

Getting assistance

Event Review Pro offers the following sources of help.

Application tooltips
When you hover the cursor over a toolbar button or event on the ECG waveform, text appears in a pop-up window. The text identifies the toolbar button and describes the event.

Wizards
A wizard is a software feature that guides you through common tasks. Several wizards are built into Event Review Pro.

Wizards are available on the Getting Started navigation pane to guide you when you download data, import cases, and open cases.

Other wizards are available to guide you when you transfer data from a device.

Online help
To get help with the current feature, press F1.
To read an overview of a topic, on the Help menu, click Help. Select a topic from Help Contents. You can use the browse buttons to move from topic to topic.

**User guide**

The printable user guide, which includes all the information in the online Help system, is in Portable Document Format (PDF). You can view it using a PDF reader such as Adobe Acrobat.

You can view the user guide online, print sections, or print the whole guide.

For customer support, see [Customer support](#) on page 189.

---

### Conventions used in this guide

This document uses the following conventions to help identify information.

<table>
<thead>
<tr>
<th>Conventions</th>
<th>Used for</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Menu options, buttons, field names, and list box names that you need to click.</td>
<td>On the File menu, click <strong>Import</strong>.</td>
</tr>
<tr>
<td><strong>Italic</strong></td>
<td>Manual names.</td>
<td><em>Instructions for administrator’s guide</em>.</td>
</tr>
<tr>
<td><strong>Screen message</strong></td>
<td>To distinguish defibrillator voice prompts and HeartStart FR3 screen messages from general text.</td>
<td>The defibrillator voice prompt announces Administration. Press the center soft key (soft key #2). The screen message reads Ready for Data Transfer.</td>
</tr>
<tr>
<td><strong>Italics with leading period</strong></td>
<td>File extension types.</td>
<td>The configuration is exported as an .xml file.</td>
</tr>
<tr>
<td><strong>Lower-case italics</strong></td>
<td>Specific file names.</td>
<td>Name the configuration file sample.xml.</td>
</tr>
<tr>
<td><strong>Italics</strong></td>
<td>Variables and placeholders</td>
<td>The default folder is located at C:\Document and Settings\user name\My Documents.</td>
</tr>
</tbody>
</table>
A yellow box with a triangular caution icon and exclamation mark identifies circumstances that can result in data corruption or information loss.

A blue box with a note icon contains information on how features are used.

A green box with a light bulb tip icon contains information to complete a task.

**Using online help**

Use the online help system to search for information using the full-text search feature, glossary, or an index.

You can access online help in these ways:

- Press F1 to open online help for the selected feature.
Starting the application

Event Review Pro does not place an icon on the desktop. To start Event Review Pro, use the shortcut on the Start menu or the All Programs menu.

To start Event Review Pro
1. In Windows, navigate to the programs menu.

To use Event Review Pro, click a navigation button on the left pane of the application window.

Understanding the Getting Started options

Use the Getting Started navigation pane to access wizards that help you perform a simple set of tasks with ECG information.

In the Welcome area, under What would you like to do today?, a set of links open wizards to help you perform common tasks.

You can complete the following tasks under What would you like to do today?:

- Download patient data from your defibrillator or its data card
- Import a patient case
- Open an Event Review Patient Case

Click one of the links to start a wizard for that task, and follow the steps in the wizard.
Using the navigation pane

The navigation pane on the left of the Event Review Pro display provides access to the application tasks.

To display a set of tasks, click a navigation button.

Following is a description of the navigation buttons and their workspaces.

- **Patient Cases** is the workspace you see by default when the software first opens. Work in this area when you are searching for cases. For details, see Working with cases on page 43.

- **Reports** includes a list of all available reports, plus a toolbar for printing, navigation, view changing, and export. For details, see Working with reports on page 147.

- **Devices** takes you to a work area where you can select a wizard to download AED self-test date, or view a table of self-test data that has been downloaded. For details, see Importing device self-test data using the Device Self-test Wizard on page 209.

- **Administration** helps the system administrator monitor and troubleshoot system activity. The Administration workspace also has settings for customizing reports. For details, see Using the Administration workspace on page 25.

- **Getting Started** helps you create a case quickly, import an existing patient case, and open a case already in your database. For details, see Understanding the Getting Started options on page 23.

You can hide the navigation pane to increase the size of the workspace in the right pane. You can display the navigation pane again when you need it. See the following instructions.

**To hide the navigation pane**

At the top of the navigation, click the **Auto Hide** icon.

The navigation pane disappears, and the Navigation Panel tab along the left edge of the pane appears.

**To display the navigation pane temporarily**

The following illustration shows the general arrangement of a navigation tab when a navigation pane is hidden. The arrangement is the same in all languages.
1. Point to the tab along the left edge of the pane. The navigation pane appears temporarily.
2. Point to or tap the right pane. The navigation pane disappears.
3. Point to the tab again to redisplay the navigation pane.

**To restore the navigation pane**

Click the tab, and then click the Stay Open icon.

---

**Using the Administration workspace**

The Administration workspace is intended for use by System Administrators and IT Specialists.

Click the Administration button in the navigation pane to open the Administration workspace.

Selections in the workspace include:

- **System Log** Open the System Log for viewing. For details, see [Working with the System Log on page 145](#).
- **Import Service** Configure the Import Service folder. For details, see [Using the Import Service on page 138](#).
- **Merge Rules** Configure rules for merging cases. For details, see [Merging related cases automatically on page 76](#).
- **Migration** Configure database migration. For details, see [Migrating cases from previous versions on page 214](#).
- **CPR Guidelines** Access settings for customizing CPR Guidelines, used in reporting. For details, see [Selecting CPR Guidelines for reporting on page 150](#).
Understanding the application window

In Event Review Pro, the work areas, the menu options, and the toolbar buttons change, based on the navigation button and navigation pane selections that you make.

- The menus list options to access the application features.
- The toolbar buttons provide quick access to frequently used menu options.

Beneath the menus and toolbar buttons, the navigation pane is on the left and the workspace is on the right.

- The navigation pane has navigation buttons and a pane above the buttons.
- A navigation button groups major application tasks by their function. You can hide or display navigation buttons.
- A navigation pane is above the navigation buttons. The pane lists navigation tasks.

The workspace on the right pane changes based on the navigation button and the task that you select. For more information about the navigation, see Using the navigation pane on page 24.

For example, if you click Patient Cases, and then click All Cases, all the cases stored in the database appear in the case selection table, as shown in the following illustration.

The case selection table

The following illustration shows the general arrangement of the case selection table. The general arrangement is the same in all languages. Refer the table after the illustration for definitions.
Key to illustration numbers for the previous illustration:

1. The title bar displays the product name and software version.
2. The toolbar provides quick access to frequently used actions that you can perform for the selected workspace, as represented by icons.
3. The menu bar displays the menus suitable for the work area. Use the menu bar to select the actions that you want to perform.
4. The navigation pane lists selections in the workspace. The pane content changes depending on which navigation button is clicked, and which workspace is active.
5. Use the navigation buttons in the navigation pane to move among the workspaces.
6. Case selection table, where you can double-click a row to open a case.

To search for a case, rather than viewing all cases, see Searching for cases on page 44.
Understanding the Case Editor

When a case opens, it opens on the ECG tab, by default. The ECG tab is the area where the waveforms are displayed.

If you navigate away from the ECG tab, you can return to it by clicking it.

The ECG tab is one of a group of tabs on the Case Editor. Each tab in the Case Editor provides a different work area.

The Case Editor tabs, in order, as they appear from left to right:

- Overview
- Scene
- Timeline
- Outcome (Event Review Pro EMS edition)
- Follow-up
- ECG
- Event Log
- Attachments
- Final Review

**The Case Editor default view**

The following illustration shows the general arrangement of the Case Editor workspaces in the default view. The general arrangement is the same in all languages. Refer to the table after the illustration for definitions.

For information on viewing 12-lead ECGs in the Case Editor, see [Working with 12-lead ECGs on page 119](#).
Key to illustration numbers for the previous illustration:

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Case Editor</td>
</tr>
<tr>
<td>2</td>
<td>The tabs of the Case Editor, used to open different work areas</td>
</tr>
<tr>
<td>3</td>
<td>The ECG tab of the Case Editor, the active tab when a case is opened</td>
</tr>
<tr>
<td>4</td>
<td>The ECG overview pane. NOTE: For details about waveform display, see The Case Editor Waveforms view on page 30.</td>
</tr>
<tr>
<td>5</td>
<td>The Events pane, used to view events in the case, ordered chronologically. See Events pane on page 31.</td>
</tr>
<tr>
<td>6</td>
<td>The Rhythm strip pane. Rhythm strip shows the waveforms used for rhythm identification, recorded by the device sequentially, in one strip.</td>
</tr>
<tr>
<td>7</td>
<td>The Transport pane, used to play, rewind, or fast-forward the waveform. If audio is present, use to play or mute audio. See Transport pane on page 32.</td>
</tr>
<tr>
<td>8</td>
<td>Label for a displayed waveform, in collapsed view.</td>
</tr>
<tr>
<td>9</td>
<td>The Patient Cases navigation pane.</td>
</tr>
<tr>
<td>10</td>
<td>The Waveforms button: click to open the Waveforms pane. See Waveforms pane on page 32.</td>
</tr>
</tbody>
</table>
Navigating between the work panes in the Case Editor

When a case is first opened, the default view of the Case Editor shows the ECG tab with the Rhythm strip pane (see item 6 in the previous table). In the same region of the Case Editor, you can instead choose to show the Waveforms pane, or the Vital Trends pane. Those work areas, when not displayed, appear as buttons along the bottom of the Case Editor. To expand one of these work areas, click the corresponding button.

The Case Editor Waveforms view

The following illustration shows the Case Editor, with the expanded Waveforms pane. The general arrangement is the same in all languages. Refer the table after the illustration for definitions.

Key to illustration numbers for the previous illustration:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Case Editor, ECG tab.</td>
</tr>
<tr>
<td>2</td>
<td>The expanded Waveforms pane.</td>
</tr>
<tr>
<td></td>
<td>The Waveforms pane drop-down menu: By default, all waveforms in the case are shown, stacked vertically. Use the menu checkboxes to hide/show waveforms by type. Changes from the default are remembered in future sessions and cases.</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>4</td>
<td>Arrow button, used to expand or collapse the waveform controls.</td>
</tr>
<tr>
<td>5</td>
<td>Vertical scroll bar, used to view waveforms above or below the visible area.</td>
</tr>
<tr>
<td>6</td>
<td>Time scale control, used to compress or expand the visible time range of the waveforms.</td>
</tr>
<tr>
<td>7</td>
<td>Horizontal scroll bar, used to scroll the visible waveform left or right.</td>
</tr>
<tr>
<td>8</td>
<td>Zoom control, used to scale the waveform as a percentage of the default 25mm/sec x 40mm.</td>
</tr>
<tr>
<td>9</td>
<td>The Waveforms Overview: By default, only the first waveform recorded in the case is shown in this view. See Overview pane on page 31.</td>
</tr>
<tr>
<td>10</td>
<td>The Waveforms Overview drop-down menu: You can choose to overlay multiple waveforms in this view. Check or uncheck boxes to show/hide waveforms by type. Changes from the default are remembered in future sessions and cases.</td>
</tr>
</tbody>
</table>

**Events pane**

All defibrillator events and notes appear in chronological order on the Events pane. You can expand events or notes in the Events pane to display additional details. For more information, see Using the Events pane on page 93.

Use the Events toolbar to search for specific events or notes. You can also add a note for an ECG. Use the event filter to control the display of events and notes on the waveform. The event filter displays all possible event types and categories. Check or uncheck them to control whether they appear.

**Overview pane**

The Overview pane displays the ECG waveform with flagged events and notes.

You can use the Overview toolbar to:

- Select the waveform displayed on the Overview pane.
- Select multiple waveforms to display them overlayed on one another.
- Select portions of the ECG for detailed view on the Waveforms pane.
• Change the time scale for the ECG.

Waveforms pane

The Waveforms pane can provide a more detailed view of each waveform. Event Review Pro can display multiple waveforms in this pane.

Use the Waveforms pane to do the following:
• Add, edit, or delete notes
• Control the display of waveforms
• Analyze the quality of the CPR administered

Transport pane

The Transport pane at the bottom of the ECG view displays the ECG lead information, the sweep bar time, and the cursor time relative to the sweep bar location on the ECG.

Use the Play button to play the entire ECG.

If an audio recording is associated with the ECG, you can use the audio controls to play the audio while viewing correlated events on the waveform on the Waveforms pane.

You can also use the controls on the Transport pane to find and select events on the waveform for review.

For more information, see Reviewing waveform information on page 106.

Using the application tables and logs

Throughout the application workspaces, information appears in tables and logs to help you manage your data. This topic introduces some important tables and logs, and helps you locate them.

You can interact with most tables and logs in the following ways:

• Working with columns on page 35
• Grouping and sorting entries on page 35
• Filtering entries on page 37
• Removing filters on page 39
• Printing table entries on page 39
• Exporting data to Excel on page 40
An example of an important table in the application is the case selection table. To view it, from Patient Cases, click All Cases. In the case selection table, each row represents one record in the database.

You can modify your view of the table information by grouping and sorting the rows. (See the links noted previously, about interacting with tables.)

For help identifying the regions of the application named in the following information, see an illustrated overview of the case selection table and the Case Editor in Understanding the application window on page 26.

**The case selection table**

In Event Review Pro 4.3 and newer, the Patient Cases workspace provides selection tools that allow you to narrow your case list to just the cases you want to see. See Searching for cases on page 44 for more information.

Alternatively, click All Cases to list all cases in the database. In Event Review Pro versions earlier than 4.3, All Cases was the default view.

In the case list, the cases show the reference ID, case ID, patient ID, case date and time, patient name, and other attributes.

In the case selection table, you can do the following tasks:

- Sort and group cases. See Sorting and grouping cases on page 62.
- Hide or display columns. Right-click on the column heading row to select the columns to display. Check or uncheck the list items to add or remove columns from your display. Once you customize your column list, the settings persist for future sessions.
  
In Event Review Pro 5.0, new column options are added: Includes STEMI, Pediatric, and Includes zCPR.

- Drag column headers to rearrange the left-to-right order of the columns displayed.
- Print the table information. See Printing table entries on page 39.
- Export the case selection table to Microsoft® Excel. See Exporting data to Excel on page 40.
- Open and delete cases. For more information, see Displaying case details on page 61 and Deleting cases on page 72.
- View and print reports. For more information, see Working with reports on page 147.

Once you open a case (by double-clicking a case row in the case selection table), the Case Editor appears.
Case Editor

The Case Editor has tabs across the top, allowing you to view and edit the case in separate work areas. The ECG tab is opened first, allowing you to view the ECG and other waveforms. You can click the tabs to go to the areas.

Click a tab to go to an area. On the tabs, you can view, modify, and delete the case information. You can use the case tabs in any order.

Event Log

Event Log is one of the tabs in the Case Editor. The log for a selected case lists all defibrillator events and notes written for that case.

Once you open a case and select the Event Log tab, you can see details for an event. You can sort, group, and filter the device events and notes that a responder or reviewer added to the case. You can also print the events for the open case. See Printing table entries on page 39.

You can export the Event Log to Microsoft® Excel. See Exporting data to Excel on page 40.

For more information, see Reviewing case events on page 133.

Attachments table

Attachments is one of the tabs in the Case Editor. The Attachments table lists each file that is attached to the case. It identifies each attachment by the file name, file type, and date that the file was attached. Use the Attachments tab to manage the files that you attach to the open case.

Once you open a case and click the Attachments tab, you can add and delete an attached file. You can also sort, group, and filter the list of attached files. You can print the list of attachments. See Printing table entries on page 39. You can export the Attachments table to Microsoft® Excel. See Exporting data to Excel on page 40.

For more information, see Attaching files to a case on page 135.

System Log

From Administration, click System Log to open the System Log workspace.

In the System Log workspace, the System Log table identifies all system activities based on the type, action, description, date and time, and the user name. You can print the system log. See Printing table entries on page 39. You can export the System Log table to Microsoft® Excel. See Exporting data to Excel on page 40.

For more information, see Working with the System Log on page 145.
All Devices table

From Devices, click All Devices to open the All Devices table. AED self-test data is available in this table. You can print the All Devices table. See Printing table entries on page 39. You can export the All Devices table to Microsoft® Excel. See Exporting data to Excel on page 40.

For information about self-test data, see Importing device self-test data using the Device Self-test Wizard on page 209.

Working with columns

You can customize the columns that appear on the table. You can resize the width of a column. You can also hide or display the columns on the table and the order in which they appear.

- To change a column width, use the mouse to click and hold the column border, and then drag the border to the size you prefer.
- To size a column to fit the width of its current content, use the mouse to click the column border, and then double-click.
- To change the order in which columns appear, use the mouse to click and hold the column header, and then drag the column to the left or right to a new location.

To hide or display the columns on the table

1. Right-click a column header name to display a shortcut menu.
2. Click Columns to display a list of column header names.
3. Click a check box for each column that you want to hide or display on the table.
   Column headers with a check mark display on the table.

Grouping and sorting entries

In any grid, such as the Event Log and the System Log, you can arrange entries for your convenience.

Displaying and hiding entries

Right-click any column to display a shortcut menu. The shortcut menu lists all columns available, with check marks next to those that currently display. Click the check boxes to display or hide any of the columns.
Sorting entries

You can click the column header to sort the list of values in ascending (1 to 9, or a to z) or descending (9 to 1, or z to a) order.

Grouping entries

You can group entries so as to sort them by multiple criteria. For example, you can select a primary (major) sort by Type and a secondary (minor) sort by Description, or a primary sort by Device and a secondary one by Event. Use the gray area above the entries to set up groups.

If you want to create further minor sorts, you can then drag more column headings into the gray area to create subgroups.

To group information

1. Click a column header and drag it to the grouping area labeled Drag a Column Header Here to Group by That Column.

   The column name moves to the grouping area, and the table displays the groups you create.

2. Repeat step 1 as necessary to create more groups. Each additional column name becomes a minor sort below the major sort that you created in step 1. To rearrange any of these column names in the grouping area, drag them to a new position. The table readjusts to the new order of sorts.

3. Click the column header to sort the order in which the grouped information appears.

To ungroup information

1. Click a column header (for example, Type or Event) in the grouping area and drag it below the table header.

   If it is the only column header in the grouping area, the table then reverts to its original organization.

   If other column headers are still in the grouping area, the table readjusts to sort according to the column headers that are still there.
**Filtering entries**

Use a filter to limit the number of entries that appear. A filter specifies selection criteria for the entries that appear. Each additional criterion that you specify for the entries further refines the subset of entries that appear. You can combine filtering with sorting and grouping.

Use the upper area above the entries to filter the list of entries. To set up a filter, select a column header and specify a value to use as a criterion. To further refine the list, set up additional criteria.

For example, you might first filter for entries within a certain date range. Then, you might filter these for an institution.

**To filter entries**

You can click the arrow to sort the entries in ascending (1 to 9, or a to z) or descending (9 to 1, or z to a) order.

1. Click **Click Here to Add Filter Criteria**. A row for the criteria condition appears.
2. Click **Choose Field** and click a column name. For example, if you are filtering by the Description column, click Description.
3. Click **Equal** (to open the menu of operators, where Equal is one of the possible modifiers you can choose), and then click an operator that qualifies the value for the column. You can specify a specific value or a range of values, depending on the operator you choose. For a description of each operator, see Comparison Operators, below.

   For example, to display only entries that exactly match a specified field value, click Equal.

4. In the next field, click the down arrow and select or type a value for the column that you selected.
5. (Optional) Click **Add Criteria** to add another criteria condition. The list of entries updates and displays another criterion row.
6. Click **And** and select a logical operator to evaluate the new criterion in relation to the previous criterion. For a description of each operator used to evaluate criteria, see Logical Operators, below.
7. Repeat steps 2 through 6 for each additional criterion you want to add to the filter.
Event Review Pro compares the entries that meet the last condition to the previous condition. Only the entries that meet the two conditions appear. The process repeats for each preceding criteria condition.

**Comparison operators table**

You can select a comparison operator to filter a number, a date, or text. For example, to see all entries created after June 1, 2001, click Greater Than and type 06/01/2001. You can enter a date using the MM/DD/YYYY format or click the down arrow to choose a date from the calendar. You can filter for specific dates or for a range of dates. You cannot filter for specific times. For the purpose of filtering, a time of 12:00 AM is used for all dates. To select a range of dates, use the Between operator.

Use the comparison operators in the following table with these columns: User Name, Type, Action, Description, and Date and Time:

<table>
<thead>
<tr>
<th>Comparison operator</th>
<th>Lists the entries whose values for the column ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal</td>
<td>...are the same as the selected value.</td>
</tr>
<tr>
<td>Not equal</td>
<td>...are not the same as the selected value.</td>
</tr>
<tr>
<td>Greater than</td>
<td>...follow or are larger than the selected value.</td>
</tr>
<tr>
<td>Less than</td>
<td>...are preceded or are smaller than the selected value.</td>
</tr>
<tr>
<td>Greater than or equal to</td>
<td>...are the same, follow, or are larger than the selected value.</td>
</tr>
<tr>
<td>Less than or equal to</td>
<td>...are the same, precede, or are smaller than the selected value.</td>
</tr>
<tr>
<td>Between</td>
<td>...are between the first and last selected values. Use to specify a range of dates, numbers, or text.</td>
</tr>
<tr>
<td>Not between</td>
<td>...are before the first selected value or after the last selected value.</td>
</tr>
<tr>
<td>Is null</td>
<td>do not exist.</td>
</tr>
<tr>
<td>Is not null</td>
<td>exist.</td>
</tr>
<tr>
<td>Is empty</td>
<td>do not appear.</td>
</tr>
<tr>
<td>Is not empty</td>
<td>appear.</td>
</tr>
<tr>
<td>Any of</td>
<td>include the selected items.</td>
</tr>
<tr>
<td>None of</td>
<td>do not include the selected items.</td>
</tr>
</tbody>
</table>
Logical operators table

Select the logical operator from the list of operators that you want to use to compare two criteria. Event Review Pro outlines the criteria and connects the conditions with a line.

<table>
<thead>
<tr>
<th>Logical operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>And</td>
<td>Displays the entry when the criteria in the first and the second conditions are both met.</td>
</tr>
<tr>
<td>And not</td>
<td>Displays the entry when the criteria in the first condition is met and the criteria in the second condition is not met.</td>
</tr>
<tr>
<td>Or</td>
<td>Displays the entry when either the criteria in the first condition or the criteria in the second condition are met.</td>
</tr>
<tr>
<td>Or not</td>
<td>Displays the entry when the criteria in the first condition is met or when the criteria in the second condition is not met.</td>
</tr>
</tbody>
</table>

Removing filters

If you filter the entries and then exit Event Review Pro before removing the filter, the filter settings persist; they appear the next time you use the feature.

You can return a single column to its unfiltered state or remove all the filters.

⚠️ If you remove a criterion, Event Review Pro removes it and each criterion that appears below it.

To return a single column to its unfiltered state, click Remove Criteria for that criteria condition.

To remove all filters, on the first criterion row, click Remove Criteria.

Printing table entries

You can print a table in portrait or landscape format.
To print table entries
1. On the File menu or toolbar, click Print.
2. Click Table.
3. In the Print window, in the Select Printer list, click the printer that you want to use.
4. (Optional) Click Preferences.
5. (Optional) In the Print Preferences window, in the Orientation area, click an orientation.

To print the entire width of the system log table, click Landscape.

6. Click OK to close the window.
7. (Optional) Complete the fields in the Page range area.
8. Click Print or OK.

Exporting data to Excel
Tables and logs in Event Review Pro can be exported to a Microsoft® Excel spreadsheet. Files are exported in the .xlsx format. Users with older versions of Excel, such as Excel 2003, can open the .xlsx files using the Microsoft Office Compatibility Pack. For more information, contact Microsoft.

To export table data to Excel
1. Right-click in the table.
   A menu opens.
2. In the menu, click Export table.
3. Use the settings in the resulting window to export the file.

Completing fields
Use a pointing device, such as a mouse or stylus, to select field values from a window and to change the way that information on tables and logs appears.

While working in the Case Editor, when you use the mouse to click or point to a field, a menu with options for that field might appear.
• If check boxes appear to the left of the options, you can select *multiple* options for the field.
• If check boxes do not appear to the left of the options, you can select *only one* option for the field.
• If an option is a text box, type or write the information using your keyboard or stylus.
• If you want to remove the selected option, click Clear.
• If a menu does not appear, type or write the information using the keyboard or stylus.

**Resizing panes and workspaces**

You can change the default layout of the application window. The revised layout persists the next time you use the navigation pane or workspace.

**To resize a pane or workspace**

1. Use the mouse to click and hold a border on the pane that you want to resize.
2. Drag the border in the appropriate direction to a new location.
   The size of the adjacent panes adjusts.

**Using a Tablet PC**

You can also work in Event Review Pro using a Tablet PC. Use the stylus in the same way as you would use a mouse or pointing device. You can also use the stylus with the Tablet PC Input Panel to enter text.

**To complete a text entry field in tablet mode**

1. Use the stylus to tap a field.
   The tablet displays a floating icon.
2. Tap the icon to display the Tablet PC Input Panel.
3. Click one of the following three modes to enter the information:
   • Writing pad
   • Character pad
   • On-screen keyboard
4. Type the information. For more information, click the Help icon on the input panel.
5. Click Insert or tap the Enter key on the input panel.

**Saving your work**

Philips recommends that you save your modified patient details periodically. To save your work, on the File menu or toolbar, click *Save*.

**Restoring confirmation messages**

A confirmation message does one of two things:

- Informs you that an action might result in a change to a configuration
- Warns you that an action may cause a permanent change

By default, confirmation messages are enabled.

If you have disabled confirmation messages (by checking the Do Not Show This Message Again box when such a message appears), you can re-enable them at any point.

**To restore confirmation messages**

- On the Tools menu, click *Options*, *Restore Defaults Confirmations*, and then *Confirmations*. 
Working with cases

The word "case" refers to all the information relating to a specific cardiac or monitoring event. This includes information recorded by supported defibrillators and information entered by a user. For information about supported defibrillators, see Supported defibrillators on page 192.

The first step in working with ECG information (ECG) is to create a case. You can do this in the following ways:

- Use the case wizard to download data from a defibrillator or its data card.
- Import a case with an ECG from a .mic, .hic, or .cod file created by another application, such as HeartStart Data Messenger.
  
  .Mic files are created by the export function of products such as HeartStart Data Messenger and Event Review Pro.
  
  .Hic files are created by third-party ePCR software using the Philips Software Development Kit (SDK), and optionally by HeartStart Data Messenger.
  
  .Cod files are created by the export function of older products such as Review Express Connect and Event Review Pro 3.5.
- Create a case that does not have ECG information in it yet and add it later.

Starting in Patient Cases

To create, review, and manage cases, click the Patient Cases navigation button.

Use the Case Selection options on the Patient Cases navigation area to control which cases are available for viewing. You can choose from different date ranges, or use other search options. For more information, see Searching for cases on page 44.
Searching for cases

You can use different methods to control which cases appear in the case selection table. This helps you when you need to quickly find a specific case for reviewing or reporting. Ways you can search for cases include:

- Case Selection options
- Select Cases
- Using a Query (see the Using queries on page 46)

**Case Selection options**

The Patient Cases navigation pane contains built-in date ranges. You can select from the following case dates:

- Today's Cases
- Yesterday's Cases
- Last 7 Days' Cases
- Last 30 Days' Cases
- All Cases

Click any of the above to view a list of matching cases. For a large database with more than 10,000 cases, clicking All Cases may require some time. For the fastest response, limit your selections to view fewer than 2,000 cases.

**Using Select Cases**

You can search cases by combining the case date range, case properties and device data. You can search by date ranges only or further define your search by adding properties for the case and device data.

**To search for a case**

1. Do one of the following:
   - Under **Select Cases**, click **From the last**, type any number of days up to 365, and click **Select**. The date is calculated from today’s date and is automatically saved.
   - Click **From** and then choose a date range using the pop-up calendar to select the dates. This setting is saved only for the current session.

2. Under the **With** portion of the screen, in the Case State field, click any of the following case states:
• Any
• Unopened
• Not yet reviewed
• Review complete

3. Under the **With** portion of the screen, type information in any of the following fields:
   • Reference ID
   • Institution Name
   • Case ID
   • Patient ID
   • Patient Last Name
   
   **Note:** Supported wild cards are _ (single-character match) and % (multiple-character matches). For example, Patient ID = 004_ will match any case in the date range with a Patient ID exactly four characters long starting with 004, but 004% will match all cases in the date range with a Patient ID starting with 004 regardless of its length.

4. Under the **And have** portion of the screen, click any of the following device data fields:
   • ECG
   • 12-Lead
   • Shocks
   • Q-CPR
   • Inadequate CPR
   • Audio
   • EtCO2
   • STEMI
   • Pediatric Pads
   • Device Type
   
   For Device Type, you select from a list of devices. You can select one or more device types for your search.
   
   **Note:** All selected Device data properties must exist in the case. Your selections are saved for future use.

5. Click **Select**.

   If your search criteria are met, then a list of cases appear.

   The height of the case list can be adjusted. Adjust it by placing the mouse over the divided lines, and then clicking and dragging. Once set, the height is saved for future sessions.

6. Double-click a case to view the case.

   Also see these topics about using the case list:
- Using the application tables and logs on page 32.
- Sorting and grouping cases on page 62.

Using queries

You can create and save custom queries to search for cases using the advanced case selection editor.

For other ways to search for cases, see Searching for cases on page 44.

To create a custom query

1. On the left side of the Patient Cases screen, under User Queries, click Create New Query.

2. In Advanced case selection, at the top of the work area, do one of the following:
   - Click From the last, type any number of days up to 365.
   - Click From and then choose a date range using the pop-up calendar to select the dates.

3. From the Choose field menu, click a parameter, such as Patient ID, or Case creation date and time.

4. To the right of the Choose field menu is the operator menu. Click an appropriate operator for the selected parameter. The default operator is Equal; however, it is not always the best option.

   When querying for Case creation date and time, consider using one of the following operators:
   - Between
   - Greater than
   - Greater than or equal to
   - Less than
   - Less than or equal to

   **NOTE:** When building queries against time fields (such as Recording length, Time to first shock, and Time to first 12-lead acquired) the time can be entered either in milliseconds (such as 60000 for 1 minute) or formatted as hh:mm:ss (such as 00:01:00 for 1 minute).

5. To add more criteria to a query, click Add Criteria, and add multiple criteria with AND/AND NOT/OR/OR NOT statements.

6. To remove an added criteria from a query, click Remove Criteria.
7. Click **Select** to display the case list.
   The case list appears below the query, in a separate pane. The height of the case list can be adjusted. Adjust it by placing the mouse over the divided lines, and then clicking and dragging. Once set, the height is saved for future sessions.

8. Click the **Save as** button when the query works as expected.

9. Type a name for the query and click **OK**.
   The named query will appear in the navigation pane for quick access.

**Note:** User queries are accessible only by the user who created them. Each user may create up to 15 queries.

**Note:** To delete a query, right-click the named query to expose the Delete menu. Clicking Delete will delete the named query and remove it from the navigation pane.

### Creating a case (including ECG) with wizards

There are several wizards available in the Getting Started workspace, in the Welcome area. Use them to guide you through the steps required to download patient data from a defibrillator or its data card, import a case, or open a case. For more information, see Understanding the **Getting Started** options on page 23.

On the Getting Started navigation pane, the Case wizard is available. Click **Case Wizard** to start the wizard. It guides you through the steps.

The Case wizard presents all its options in a sequence of screens. To bypass the options you do not want, simply un-check those checkboxes on the screens and click **Next**. Continue to the last action in the wizard, Complete the tasks, click **Proceed**, and then click **Exit**. It is then that the case is written to the database. The case opens in the Case Editor (unless you un-checked the Open case checkbox in the wizard).

**The Case wizard workflow**

The wizard steps are described here, for your reference:

**To start the Case wizard**

1. On the navigation pane, click the **Getting Started** navigation
button.
2. On the Getting Started navigation pane, click **Case Wizard**.
3. In the Welcome Page window, click **Next** to continue.
   The Attach ECG page appears.

**Attaching an ECG**

**To attach an ECG from a Philips defibrillator or its data card**

1. Use the table in [Attaching ECGs table on page 54](#) to identify the method used to add/download an ECG from your defibrillator.
2. Follow the instructions in [Attaching ECGs on page 51](#) to attach the ECG.
   You can also use the wizard to help you transfer data. Click an icon under Data source to start the instructions.
3. Click **Next**.
   The Case Summary page appears.

**Entering case summary information**

On the Case Summary page, you can handle case information three ways:

- Add new information
- Accept the information that the defibrillator provides
- Override the information from the defibrillator

Different defibrillators may capture different patient information as part of recorded ECG data. If you use data from the HeartStart MRx, the ECG information might include patient information such as name, age, and gender.

**To complete the Case Summary fields**

1. Event Review Pro completes the Case ID field. You can change the case ID here if you want to.
   For defibrillators that generate an incident ID, such as HeartStart MRx, the case ID corresponds to this incident ID. Each device has its own system for generating an ID.
2. Fill in the **Patient ID, Last Name**, and **First Name** fields.
3. In **Reference ID**, type a reference ID for the case that you can use to identify it later.

   For example, "ER Room 3" or "Engine #3, Station 27". This information may already appear, if the case was imported from an application or device that provided it.

4. In **Institution**, type an institution name for the case. For example, "Valley Hospital" or "District 5 Fire Department." This information may already appear, if the case was imported from an application or device that provided it.

5. Click **Next**.

   The Export Case page opens.

**Exporting a file**

The wizard guides you in exporting a case to a .mic file. The file is then available to a colleague who uses Event Review Pro.

1. To export a file containing the ECG and case information at the end of the wizard, check the Export to a File box, and verify the file name and folder where you want to save it.

   The exported file is then available to be imported into your colleague's Event Review Pro database.

2. If you want to password-protect the exported file, in the **Password** box, type the password.

   Passwords can have up to 16 characters. They are case-sensitive.

   Remember to provide this password to anyone who needs to open the exported file.

3. If you want to remove confidential patient identifiers such as name, patient ID, and age (if over 90) from the exported file (called "redaction"), check the **Remove Patient Identity** box.

4. Click **Next**.

   The Printing a report page opens.

**Printing a report**

The wizard guides you in printing a case report.

1. To print a report at the end of the wizard, check the **Print a Report** box.

2. Click **Next**.
The Email page opens.

**Emailing case data**

1. If you want to email case data as part of the Case wizard, check the **Email Case** box, type or click the appropriate address or addresses, change the subject if you want, and type a note to accompany the case if you want.

2. You can also password-protect the file or remove patient identity information.

3. Click **Next**.

   The Complete the task page opens.

**Opening the case**

The last pane of the wizard, Complete the tasks, has a checkbox for **Open case**.

By default, the case will open after all tasks are completed (the Open case box is checked), so that you can view the case, add information, and make annotations.

1. Check or un-check the **Open Case** box, depending on whether you want to open the case at the end of the wizard.

2. Click **Proceed**.

   The status of each task for the case being processed appears, sequentially.

3. When the processing is complete, click **Exit**.

   If you chose to send by email, and if your email system needs verification before it can send the email, a confirmation message appears. Click **Allow**, and the process continues.

**Creating a case**

You can create a case manually or automatically, with or without ECG information.

**To manually create a case that has ECG information**

1. Use one of the following methods:
To manually create a case that does not initially contain ECG information

1. On the File menu or toolbar, click New.
   The tabs for the case in the workspace appear.
2. Complete fields to briefly describe or identify the case. For example, add the site of collapse and location detail.
3. Click Save.
   At a later time, you can open the case, attach ECG information, and complete the tabs.

For information about those tasks, see:
- Attaching ECGs on page 51
- Working with ECGs on page 88
- Adding case details on page 78

**Attaching ECGs**

"Attaching" an ECG means reading ECG information from a defibrillator (downloading it), a defibrillator data card, or a file and adding it to a case.

You can attach an ECG to a case you are creating, or you can open an existing case and attach an ECG to it. You can add extra ECGs from other defibrillators as well. Depending on the defibrillator, you can attach continuous ECG information and 12-lead information from a data card or a file, or through a Bluetooth or an infrared transmission.

If you need help identifying the defibrillator or inserting a data card, see Working with defibrillators on page 192.
The defibrillator that you use determines the method that you can use to attach an ECG. The Attach ECG window lists the types of transfer methods that you can use to attach an ECG or 12-lead report on the left pane. The window lists data files in the right pane. The data files include those that were transmitted or are stored on a removable device.

**To display the Attach ECG window for an existing case**

1. Click the Patient Cases navigation button, and use Case Selection to display a list of cases. For more information on selecting a case, see Searching for cases on page 44.
2. On the list of cases, double-click a case to open it.
3. On the toolbar, click Attach ECG File.

Any time you have a case open for reviewing or editing, you can attach an ECG. On the ECG menu, click Attach, or on the toolbar, click Attach ECG File.

**To attach an ECG, or ECGs**

1. Make sure that the case is open. For more information, see Displaying case details on page 61.
2. Prepare to use the correct data transfer method for your device. For details, see Choosing the correct data transfer method for your device on page 53.
3. On the ECG menu, click Attach, or on the toolbar, click Attach ECG File.
4. On the right pane of the Attach ECG window, find the ECG file you want to attach.
   The medium for the data source appears in the Source column.
5. Use one of the following methods:
   - Click the file for the ECG you want to attach, and then click Open.
   - Double-click the file for the ECG you want to attach.
   The attached ECG appears on the ECG tab in the open case.

For information on viewing a case in the Case Editor, see Understanding the Case Editor on page 88.
Attaching additional ECGs

If the emergency response for a single patient involved multiple ECGs on supported defibrillators, you can attach all ECG files to the same case.

The process for attaching additional ECGs is the same as attaching the first ECG. The method varies depending on the device from which you are transferring the ECG. Follow the process in To attach an ECG, or ECGs on page 52.

Once the additional ECG is attached, you can view it on the ECG tab in the Case Editor. On the ECG tab, a sub-tab appears for each attached ECG. The tab text identifies the defibrillator, date, and time transmitted by the defibrillator. For example: HeartStart MRx 3/10/2007 3:10:44 PM. For information on viewing a case in the Case Editor, see Understanding the Case Editor on page 88.

Choosing the correct data transfer method for your device

Event Review Pro activates the following defibrillator data transfer methods automatically.

In the wizard, help is available to guide you. You can also click the following icons to attach ECG data:

- **Bluetooth**— opens a wizard with instructions for establishing either HeartStart MRx or FR3 connections.
  
  If you click MRx, a window opens, allowing you to point Event Review Pro to the Bluetooth Exchange Folder where the transmitted Bluetooth files will be saved. For more information, see Downloading an ECG using a HeartStart MRx Bluetooth transmission on page 57.

  If you click FR3, a wizard appears with instructions for how to put the FR3 into Administration mode and ready it for wireless data transfer. For more information, see Attaching an ECG using an FR3 Bluetooth transmission on page 56.

- **IrDA**— opens help on how to transmit data from HS1 and FRx defibrillators. For more information, see Downloading an ECG from an infrared connection on page 58.
- File System—displays the Open window that you can use to browse and attach ECG information from the file system on your computer.

## Attaching ECGs table

Use the following table to identify the method and instructions used to read and/or download an ECG from a defibrillator and attach it to a case.

<table>
<thead>
<tr>
<th>Defibrillator model</th>
<th>Method used to read data</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>HeartStart FR2 Series</td>
<td>Card reader</td>
<td>See <a href="#">Attaching an ECG from a data card on page 55</a>. See also <a href="#">Reading FR2 series cards on page 200</a>.</td>
</tr>
<tr>
<td>HeartStart FR3 Series</td>
<td>Card reader</td>
<td>See <a href="#">Attaching an ECG from a data card on page 55</a>.</td>
</tr>
<tr>
<td>HeartStart FR3 Series</td>
<td>Bluetooth connection</td>
<td>See <a href="#">Attaching an ECG using an FR3 Bluetooth transmission on page 56</a>.</td>
</tr>
<tr>
<td>HeartStart XL</td>
<td>Card reader</td>
<td>See <a href="#">Attaching an ECG from a data card on page 55</a>.</td>
</tr>
<tr>
<td>HeartStart XL+</td>
<td>USB data drive</td>
<td>See <a href="#">Attaching an ECG from a USB port on page 56</a>.</td>
</tr>
<tr>
<td>Efficia DFM100 defibrillator/monitor (where available)</td>
<td>USB data drive</td>
<td>See <a href="#">Attaching an ECG from a USB port on page 56</a>.</td>
</tr>
<tr>
<td>HeartStart MRx monitor/defibrillator</td>
<td>Card reader</td>
<td>See <a href="#">Attaching an ECG from a data card on page 55</a>.</td>
</tr>
<tr>
<td>HeartStart MRx monitor/defibrillator</td>
<td>HeartStart MRx, version 9.0 or later Bluetooth connection</td>
<td>See <a href="#">Downloading an ECG using a HeartStart MRx Bluetooth transmission on page 57</a>.</td>
</tr>
<tr>
<td>HeartStart MRx monitor/defibrillator</td>
<td>HeartStart MRx with BLDT</td>
<td>See <a href="#">Using the HTTP Import Service on page 143</a>. Also see the HeartStart MRx Monitor/Defibrillator Instructions for use, and the HeartStart Data Management Solutions Implementation Guide.</td>
</tr>
</tbody>
</table>
## Attaching an ECG from a data card

The FR2, FR3, XL, and HeartStart MRx defibrillators can use a data card to transfer the recorded ECG and other data from the defibrillator to Event Review Pro.

### To attach an ECG from a data card

1. Insert the data card into the card reader.
2. Use one of the following methods:
   - On the ECG menu, click **Attach**.
   - On the toolbar, click **Attach ECG File**.

   The Attach ECG window opens, listing ECG files grouped by the source of the file.
3. On the right pane of the Attach ECG window, find the file that is associated with the ECG information or 12-lead report. The medium for the data source appears under the Source column.

### Instructions

<table>
<thead>
<tr>
<th>Defibrillator model</th>
<th>Method used to read data</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>HeartStart FRx</td>
<td>Infrared connection</td>
<td>See <a href="#">Downloading an ECG from an infrared connection on page 58</a>.</td>
</tr>
<tr>
<td>HS1 family of defibrillators, including HeartStart Home and HeartStart OnSite defibrillators</td>
<td>Infrared connection</td>
<td>See <a href="#">Downloading an ECG from an infrared connection on page 58</a>.</td>
</tr>
<tr>
<td>Imported case file</td>
<td>File system</td>
<td>See <a href="#">Attaching an ECG from a file on page 60</a>.</td>
</tr>
</tbody>
</table>

Event Review Pro documentation uses the HS1 or HS1 family of defibrillators to refer to HeartStart Home, HeartStart OnSite, and HeartStart HS1 Defibrillators.

If you need help identifying the defibrillator or using a transfer method, see [Working with defibrillators on page 192](#).
4. (Optional for FR2 Series defibrillators) If the pediatric pads were used, click the FR2 Pediatric option. This allows Event Review Pro to properly calculate the pads impedance and the shock energy. If you have any doubt about which pads the responder used, contact the responder.

Click the ECG you want to attach. In the Device column, right-click the FR2 icon and click FR2 Series with infant/child pads. The pink teddy bear icon for FR2 infant/child pads appears.

5. Use one of the following methods:
   - Click the file for the ECG you want to attach, and then click Open.
   - Double-click the file for the ECG you want to attach.

Event Review Pro downloads the file and attaches the ECG to the case. It appears on the ECG tab.

## Attaching an ECG from a USB port

The HeartStart XL+ defibrillators and Efficia DFM100 defibrillator/monitors use a USB data drive to transfer the recorded ECG from the defibrillator to Event Review Pro.

**To import data from the USB data drive to Event Review Pro**

1. Insert the USB data drive into the USB data port on the computer running Event Review Pro.

2. Ensure that Windows recognizes the USB data drive as a connected device, and that Event Review Pro is running.
   
   Windows detects the USB data drive and begins transferring data. All data is transferred to Event Review Pro.

3. When data transfer is completed, follow Windows procedures to safely remove the USB data drive from your computer.

## Attaching an ECG using an FR3 Bluetooth transmission

You can transfer data from the FR3 to the computer using Bluetooth wireless transmission. Once the FR3 data is saved in Event Review Pro, it becomes a case.
Prepare the FR3 for *Bluetooth* data transfer as described in Retrieving FR3 data using Bluetooth transmission on page 195.

This task can also be performed with the help of a wizard. For that method, from Getting Started, in the Welcome area, click Download patient data from your defibrillator or its data card.

**To attach an ECG using a Bluetooth transmission**

1. In Event Review Pro, use one of the following methods:
   - From Getting Started (or from Patient Cases, from the menu), click **New** to initiate a new case, and then click **Attach ECG File**.
   - From Patient Cases, open an existing case, and then, from the menu, click **Attach ECG file**.

   The Attach ECG window opens.

2. If you need to be reminded of how to prepare the FR3 for wireless data transfer, in the Attach ECG file window, click the **Bluetooth** icon to open the Bluetooth Wizard, and review the steps.

3. Watch the Attach ECG window and the status line, as well as the FR3 screen, for feedback.

4. When data appears in the Attach ECG window, verify that the device type, serial number, date, and time match your device.

5. Use one of the following methods to attach the ECG to the case:
   - In the Attach ECG window, click the file for the ECG you want to attach, and then click **Open**.
   - Double-click the file for the ECG you want to attach.

   Event Review Pro attaches the ECG to the case, and the ECG tab appears with the attached ECG waveform(s).

6. Remember to save the case.

**Downloading an ECG using a HeartStart MRx Bluetooth transmission**

Depending on the version of your HeartStart MRx monitor /defibrillator, and its options, you can transfer files from the HeartStart MRx to the computer using *Bluetooth* transmission.
To attach an ECG using a Bluetooth transmission

1. Set up the Bluetooth software and adapter on the computer. For information, see your defibrillator documentation and Setting up Bluetooth transmissions for the HeartStart MRx on page 197.

2. Send the Bluetooth transmission. For information, see Sending the HeartStart MRx Bluetooth transmission on page 199.

3. Use one of the following methods:
   - On the ECG menu, click Attach.
   - On the toolbar, click Attach ECG File.

4. On the right pane of the Attach ECG window, find the file that is associated with the ECG or 12-lead.

   The medium for the data source appears under the Source column.

5. Use one of the following methods:
   - Click the file for the ECG you want to attach, and then click Open.
   - Double-click the file for the ECG you want to attach.

   Event Review Pro attaches the ECG to the case.

6. If the file does not appear in the right pane, click Bluetooth on the left pane of the Attach ECG window and use the Bluetooth Wizard to navigate to the Windows Bluetooth Exchange Folder.

   - On the Browse for Folder window, navigate to the Windows Bluetooth Exchange Folder for the user. The default folder for is located at C:\Users\user name\My Documents\Bluetooth Exchange Folder.
   - If you specified a different folder when setting up your Bluetooth stack or Neighborhood, navigate to that folder.
   - Event Review Pro scans the location you specify to find the ECG. It enables the Bluetooth icon to the right of the status bar while it reads the Bluetooth files.

   One or more ECG tabs appear with the attached ECG waveform(s).

Downloading an ECG from an infrared connection

The HeartStart HS1 family of defibrillators and the FRx defibrillator use an IrDA connection to attach an ECG to Event Review Pro.
To attach an ECG from an infrared connection

To retain the actual event times, do not remove the battery from HS1 or FRx defibrillators. If you remove the battery before you download the case information, the files created before you removed the battery might appear in the list without a date and time (though they will show elapsed time for events and ECG data when you open them). For information on HS1 and FRx defibrillators' case date and time, see Determining the HS1 and FRx case date and time on page 202.

1. Set up the infrared connection between the defibrillator and the computer. For more information, see Using infrared connections for the HS1 and FRx on page 203.

2. Use one of the following methods:
   - On the ECG menu, click Attach.
   - On the toolbar, click Attach ECG File.

3. Put the defibrillator in Administration mode. For more information, see Setting up the infrared connection on page 204.

4. (Optional) If you need help with setting up the IrDA handshake for HS1 or FRx defibrillators, use the IrDA Wizard.

   On the left pane of the Attach ECG window, click IrDA . On the IrDA Wizard window, follow the on-screen instructions. The IrDA icon to the right of the status bar appears enabled while it transfers the data.

5. When the defibrillator connects, the voice message says Sending (for the HS1) or Transferring data (for the FRx).

6. On the right pane of the Attach ECG window, find the file that contains the ECG. This process may take several minutes.

   The data source appears in the Source column.

7. Use one of the following methods:
   - Click the file for the ECG you want to attach, and then click Open.
   - Double-click the file for the ECG you want to attach.

   Event Review Pro downloads the file and attaches the ECG to the case.

8. A message appears requesting the case start time when the HS1 or FRx case does not have a start time. Event Review Pro requests the start time.
Attaching an ECG from a file

When you attach an ECG or 12-lead information from a file, the file can be on the hard drive, external media (a data card), or the network.

This might occur when a remote user downloads a case via another HeartStart application, like Data Messenger, and saves it to a file for your subsequent use.

To use a wizard to attach a file, from Getting Started, in the Welcome area, click **Download patient data from your defibrillator or its data card.**

To attach an ECG from a file

1. Use one of the following methods:
   - On the ECG menu, click **Attach ECG.**
   - On the toolbar, click **Attach ECG File.**

2. On the left pane of the Attach ECG window, click **File System**. The Open window lists file extensions in the Files of Type field.

3. In the **Files of Type** field, click the file type.

4. Click **Device Data** for files with the `.s01`, `.index`, `.cod`, `.xml`, or `.mic` extensions—that is, all files except those that include HeartStart MRx 12-lead reports.
   - Click **FR2 Series Peds** for files that were recorded using FR2 defibrillator pediatric pads.
   - Click **MRx 12-lead (XML)** for 12-lead report files that were recorded with the HeartStart MRx.

5. Navigate to the file you want and double-click it.
   
   Event Review Pro downloads the file and attaches the ECG to the case.

After you add an ECG

After you attach the ECG information to a case, use the tabs on the Case Editor to add details to the case.

The following table lists common tasks and related instructions.
Removing ECGs from a case

Use the Detach option, on the ECG menu and toolbar, to remove an ECG from the case.

The ECG menu is available when you open a case and work on the ECG tab.

To detach an ECG

1. On the case selection table, open a case. For more information, see Displaying case details on page 61.
   The Case Editor opens, to the ECG tab.
2. On Case Editor, click the ECG tab.
3. On the ECG tab, click the ECG ID tab for the ECG you want to detach.
4. Use one of the following methods:
   - On the ECG menu, click Detach.
   - On the toolbar, click Detach ECG.
   A confirmation message might appear. For more information, see Restoring confirmation messages on page 42.
5. Click Yes to remove the ECG from the case.

Displaying case details

The case selection table is opened from the Patient Cases, using the Case Selection menu. Cases in the database are listed in the case selection table. From there, you can open the cases for viewing.
In the case selection table, the following details can appear in columns for each case: the reference ID, case ID, patient ID, date and time, patient name, and institution.

You can customize how the case selection table information appears. For more information, see Sorting and grouping cases on page 62, Working with columns on page 35, and Grouping and sorting entries on page 35.

Once you open a case, it appears in the Case Editor. You click any tab to view and modify the detailed information.

To use a wizard to open a case, from Getting Started, in the Welcome area, click Open an Event Review Patient Case.

**To open a saved case**

1. Click the Patient Cases navigation button.
2. If you want, limit the display of cases by clicking one of the built-in date ranges (such as "Last 7 Day's Cases") from the navigation pane, or search for a particular group of cases. See Searching for cases on page 44 for information.
3. Use one of the following methods:
   - On the case selection table, double-click the case you want to open.
   - On the File menu or toolbar, click Open.

The case appears in the Case Editor.

**Sorting and grouping cases**

You can change the way information displays on the case selection table. You can sort cases and group them based on a shared parameter value.

You can filter or select cases that meet the criteria you select. You can also hide or display groups of cases.

For information on how to add columns to and delete columns from the display, see Working with columns on page 35.

Also see Using the application tables and logs on page 32.
For information on how to group and sort information in columns, see Grouping and sorting entries on page 35.

For information on working with grouped cases, see Hiding and displaying grouped cases on page 63.

For information on how to filter the information that appears in the list of cases, see Filtering entries on page 37.

Hiding and displaying grouped cases

You can hide or display cases that have been grouped in the case selection table. Grouping is described in Grouping and sorting entries on page 35.

When cases are grouped, you can expand and collapse all the groups. You can also hide or display cases at the level of a specific group. Doing this can help you manage viewing in a long list of cases.

To hide or display all cases

1. Click Patient Cases and then All Cases, to open the case selection table. For more information, see Displaying case details on page 61.

2. Right-click the case selection table.
   A menu of options opens.

3. Click your preferred option:
   - Expand all
   - Collapse all
   All the groups in the case selection table are affected.

To refresh, hide, or display specific groups of cases

- To refresh all the cases, on the View menu or shortcut menu, click Refresh.
- To hide the cases in a group (collapse that group), to the left of the group, click Collapse．
- To hide all the cases in groups (Collapse the cases in every group), on the View menu or shortcut menu, click Collapse All.
- To display a group (expand the cases in a group), to the left of the group, click Expand ±.
- To display all the groups (expand the cases in every group), on the View menu or shortcut menu, click Expand All.
Importing case files manually

You can import one or more case files that were exported by another HeartStart software application such as Data Messenger.

For each file you import, Event Review Pro creates a case in the Event Review Pro database, and adds the information from the file to the case. You can use the file in the same way as any other case you created. The case can then be viewed, modified, printed, exported or emailed.

You can import using the Import option (available on the File menu and toolbar) or using drag-and-drop methods.

When you import a case file, Event Review Pro imports all the details that were in the case, such as patient demographics, responder and reviewer notes, and physician notes. When you use the Attach ECG feature, Event Review Pro attaches only the ECG to the case.

To import files using drag and drop
1. On the navigation pane, click the Patient Cases navigation button.
2. Open the folder where your .mic, .hic, or .cod files are stored, and drag one or more files onto the open Event Review Pro application window.
3. Event Review Pro imports the cases, saves them to the database, and lists them on the case selection table.
   If any of the cases failed to import successfully (because they required a password, for example), look for the outcome for each in the System Log. See Working with the System Log on page 145.

To import files using the Import option
1. On the navigation pane, click the Patient Cases navigation button.
2. On the File menu or toolbar, click Import.
   The Import Case window opens.
3. Navigate to the folder that contains the files you want to import.
   The list of files includes only those with a .cod, .hic, and .mic extension.
A .hic file is a defibrillator device file that is forwarded by an electronic patient care record (ePCR) application or HeartStart Data Messenger.

4. If you want to import only one file, click it. If you want to import multiple files, press Ctrl and click each one. Click Open.

5. If any of the files were password-protected, type the file password in the Password field before you attempt to open the file. Passwords can have up to 16 characters and are case-sensitive. If some of the files are associated with a different password, they will not import, and you will need to import them separately with their own password.

6. Event Review Pro imports the cases, saves them to the database, and lists them on the case selection table.

   If you were working with an open case when you imported more than one case, the last case in the list that you imported opens. If you were working in the cases selection table, the same table is open after the import.

   If any of the cases failed to import successfully (because they had a different password from the others, for example), the outcome for each appears in the System Log. See Working with the System Log on page 145.

**Importing case files automatically**

Use the Import Service on the Administration navigation pane to set up inboxes to import cases automatically. When the Import Service is running, Event Review Pro monitors the inboxes for case files with .hic, .mic, and .cod extensions, as well as HeartStart MRx BLDT and Bluetooth files (with .tgz, .tsy, and .don extensions).

If an imported case contains a duplicate ECG, the case appears on the Duplicated ECGs table. See Reviewing cases with duplicate ECGs on page 73.

For more information, including configuration options, see Using the Import Service on page 138.
Saving cases

When you save a case, Event Review Pro adds it to the database. All the information is available for reports. Use the case selection table to manage the case.

To save an open case, on the File menu or toolbar, click Save. The case is now in the Event Review Pro database.

Adjusting the date and time of the defibrillator data

It is possible for the internal clock on your defibrillator to drift slightly over time. In addition, if someone removed the battery from an HS1 or FRx defibrillator before downloading the patient data, case and event clock time could be lost, leaving only event elapsed time. In these cases, you may want to adjust the times of the downloaded case and its individual events.

The date and time formats used in this software and in the reports is controlled by the Windows Region and Language control panel. Use that control panel to adjust the date and time format. For example, use it to choose 24 hour time.

Before you transfer information from a defibrillator, confirm that your computer clock is accurate. Also, confirm that the battery was not pulled from the HS1 or FRx defibrillator since the cardiac emergency. For information on HS1 and FRx defibrillators case date and time, see Determining the HS1 and FRx case date and time on page 202.

To adjust the defibrillator date and time based on the computer date and time

1. Open the case from the case selection table.
   The case opens on the ECG tab of the Case Editor. For more information, see Displaying case details on page 61.

2. On the Case Editor, click the Overview tab, and navigate to the Defibrillators area.
   Confirm that the date and time for the defibrillator are correct in the Defibrillators area.
If you transfer the case from a defibrillator through a Bluetooth transmission, Event Review Pro automatically adjusts the case event date on the received data based on the computer clock.

3. After you attach an ECG, you can change the date and time for the appropriate case in the Adjusted “On” Time column. The date and time automatically adjusts for each event in that case. The ECG tab displays the adjustment that you enter.

4. On the File menu or toolbar, click **Save**.

## Erasing the data source

After you attach an ECG and save the case to the database, consider erasing the data from the source. This ensures that the device has full capacity for the next use.

You can erase ECG information from the data cards used by the HeartStart MRx monitor/defibrillators, the FR2, FR3 series, and HeartStart XL defibrillators.

You can erase ECG information from the USB data drive used by HeartStart XL+ defibrillators and Efficia DFM100 monitor/defibrillators.

You can erase ECG information from an HS1 or FRx defibrillator.

You can erase files that were transmitted via Bluetooth from an HeartStart MRx monitor/defibrillator or from an FR3 defibrillator.

⚠️ Make sure that you transfer all the information to the database or an archive before erasing the information. Once the data is erased, it is lost and cannot be recovered.

### To erase a data card

1. Insert the data card into the card reader.
2. On the **Tools** menu, click **Erase Device or Data Card**. The Erase Device or Data Card window opens.
3. Click the card or device name.
4. Click **Erase**. A confirmation message might appear. For more information, see [Restoring confirmation messages on page 42](#).
5. If so, click **Yes** in the message box.
To erase data from an HS1 or FRx Defibrillator

1. Set up the defibrillator to communicate with Event Review Pro. For more information, see Using infrared connections for the HS1 and FRx on page 203.
2. Put the defibrillator in Data Transfer mode.
3. On the Tools menu, click Erase Device or Data Card.
   The Erase Device or Data Card window opens.
4. Click the device name.
5. Click Erase.
   A confirmation message might appear.
6. If so, click Yes in the message box.

To erase data from the Bluetooth Exchange folder (HeartStart MRx only)

1. On the Tools menu, click Erase Device or Data Card.
   The Erase Device or Data Card window opens.
2. If it is visible, click Bluetooth Exchange Folder.
3. Click Erase.
   A confirmation message might appear.
4. If so, click Yes.

To erase data from an FR3 defibrillator using Bluetooth

1. Once the unit is on and you have heard the voice prompt, place the FR3 in Administration mode, press the option button, and select Wireless Data Transfer.
2. In Event Review Pro, on the Tools menu, click Erase Device or Data Card.
   The Erase Device or Data Card window opens.
3. In the Bluetooth section, click the FR3 icon whose serial number matches the device that you want to erase.
4. Click Erase.
   A confirmation message might appear.
5. If so, click Yes.
The clock on the defibrillator is now synched with the clock on the computer. This synchronization occurs even if you have no data to erase.

**To erase data from a USB data drive for the HeartStart XL+ defibrillator**

1. Use the HeartStart XL+ defibrillator to erase data from the USB data drive. For more information, see the *HeartStart XL+ Instructions for Use*.

2. Use the Efficia DFM100 defibrillator/monitor to erase data from the USB data drive. For more information, see the *Efficia DFM100 Defibrillator/Monitor Instructions for Use*.

**Printing case information**

You can print case information about an open case and about a case that is stored in the database. For more information, see *Working with reports* on page 147.

You can also print the tables that appear on the Case Records table, Event Log tab, and Attachments tab. The information that prints is about the open case. For more information see *Printing table entries* on page 39.

**Exporting cases**

Use Export to create files outside the application (that is, not in the application database) so that you can share information with other Event Review Pro users. You can also use Export to back up information.

You can export a single case or multiple cases at a time. The Export option is available when the case selection table is open, from the File menu, the toolbar, or by right-clicking on a case row. In addition, if you want to export just one case, you can do this (from the File menu or the toolbar) when that case is open.

You can export files with or without a password. If you add a password, anyone attempting to open the file must have the password to open it.

---

Philips recommends that you record the password and save it in a secure location. If you forget the password, Customer Support cannot “unlock” the file.
To export one or more case files from the case selection table

1. In the case selection table, choose the case or cases to export:
   a. Click a single case.
   b. CTRL-click multiple cases.

2. On the File menu, click Export.
   The Export Selected Cases dialog box appears, showing the last folder you used to export a file. If you want a different location, click the Save in field at the top of the dialog box and navigate to that location. The list there shows .mic files (the only supported file format).

3. Decide how to name the exported file or files. The default name includes a placeholder for the case ID, expressed as {caseID}. You can accept the case ID as the file name, or you can use this placeholder to create more descriptive names; for example, if you type "my data {caseID} for Joe.mic" for the file name and export two cases, one with a case ID of "abc" and one with "xyz," then the two .mic files will have the names "my data abc for Joe.mic" and "my data xyz for Joe.mic." If you type something entirely different for the name that doesn’t include a case ID, the case ID will be appended to the file name by the software.

4. If you want to remove confidential patient identifiers such as name, patient ID, and age (if over 90) from the exported file (called "redaction"), check the Remove Patient Identity box.

5. Decide whether you want to protect the file or files with a password. If so, type it in the Password field (for security, it appears as ******). Remember to provide the password to the recipient in a separate communication.

6. Click Save.
   A progress bar appears as the export operation proceeds, and a confirmation message tells you that the export operation succeeded.

To export a single case file, when the case is open

1. Open a case, so that it appears on the ECG tab of the Case Editor.

2. On the File menu or toolbar, click Export.

3. Follow steps 3 through 6 in the procedure above.
Emailing a case

You can use the Email option or your email application to send an email to another Event Review Pro user. You have the option of attaching the case report, the case .MIC file, or both.

Before you use the Email option, complete the following prerequisites:

- Correctly configure Microsoft Outlook or a MAPI-compliant email client.
- Set up the email profile in Windows, if needed. Click Help on the email profile window for information on setting up your profile. After you complete the profile, the profile does not appear again.

To use the Email option

1. On the case selection table, open a case. For more information, see Displaying case details on page 61.
2. On the File menu or toolbar, click Email. The Email window opens.
3. Complete the To field. The contact list for your email application is not available for the Email tool.
   Email saves the address. The next time you send an email to that recipient, you can select the same address by clicking the arrow at the end of the To field.
4. Check Email case
5. Check Attach case archive MIC file, Attach case report PDF, or both. You must check at least one.
6. Decide whether you want to protect the file or files with a password. If so, type it in the Password field (for security, it appears as *****). Remember to provide the password to the recipient in a separate communication.
7. If you want to remove confidential patient identifiers such as name, patient ID, and age (if over 90) from the exported file (called "redaction"), check the Remove Patient Identity box.
8. If you want, add a message.
9. Click Send.

Philips recommends that you record the password and save it in a secure location. If you forget the password, Customer Support cannot “unlock” the file.
To use your email application

1. Export the file. For more information, see Exporting cases on page 69.
2. Note the location of the exported file. The file has a .mic extension.
3. Open your email application and create an email to the recipient of your choice.
4. Attach the files created by Export in Step 1 to the email form.
5. Send the email.

Deleting cases

You can delete a case or multiple cases from the database. The case or cases then disappear from the case selection table.

To delete a case or cases from the list of cases

1. Click the Patient Cases navigation button to open the case selection table.
2. Use any of the queries to find the specific case or cases you want to delete. For more information, see Searching for cases on page 44.
3. Click the case you want to delete, or press CTRL or SHIFT while clicking to select multiple cases.
4. On the File menu or toolbar, click Delete.
   A confirmation message might appear. For more information, see Restoring confirmation messages on page 42.
5. If so, click Yes.

To delete a case that is open

1. On the File menu or toolbar, click Delete.
   A confirmation message might appear. For more information, see Restoring confirmation messages on page 42.
2. If so, click Yes.
   The case selection table appears.
Reviewing cases with duplicate ECGs

The Duplicate ECGs table (in the Cases workspace) lists each case in the Event Review Pro database for which the ECG in the case is also the ECG in another case. The cases are listed based on the reference ID, case ID, patient ID, case date and time, patient name, and institution.

Cases can be inadvertently duplicated when you download them automatically. This table provides an easy way to identify these cases. For more information, see Using the Import Service on page 138,

Use the Duplicate ECGs table to complete the following tasks:

- Delete duplicate cases. For more information, see Deleting cases on page 72.
- Sort cases. See Sorting and grouping cases on page 62.
- Search for cases based on a variety of values. For more information, see Filtering entries on page 37.
- Hide or display columns. See Working with columns on page 35.
- Open cases. For more information, see Displaying case details on page 61. You can click the Cases tab to view, modify, and delete the information. You can use the case tabs in any order based on your tasks within your organization.
- View and print reports. For more information, see Generating reports on page 151.

Note: Deleting duplicate cases is not the same as merging two related cases. A true duplicate case is identical in all respects; in the case of merging cases, the cases (and their respective ECGs) were created at slightly different times and possibly different devices but refer to the same event. For information on merging related cases, see Merging related cases on page 74.
Merging related cases

If you have two cases with data from the same incident (for example, if one case were created by the EMTs on the scene and another by ambulance or hospital personnel using a different device), you might want to merge them into the same case. Event Review Pro can tell whether two cases have ECGs recorded very close in time, and it displays only those candidates for you to consider. In addition, you can set further limitations on the cases that are considered merge candidates.

This is not the same as deleting a duplicate case. A true duplicate case has an identical ECG; in the case of merging cases, the cases (and their respective ECGs) were created at slightly different times and possibly on different devices but refer to the same event. For information on deleting duplicate cases, see Reviewing cases with duplicate ECGs on page 73.

When merge candidates have been identified, you can merge the newer one into the older one. The newer one is then deleted. If the old case does not contain values for certain fields and the newer one does, these additional values are retained.

You can merge cases manually, changing the criteria for each, or you can set Event Review Pro to merge cases automatically upon import, based on criteria that you set. For instructions on how to merge cases automatically, see Merging related cases automatically on page 76.

To merge related cases manually:

1. Click the Patient Cases navigation button.
2. From the left panel, under Merging and Duplicates, click Merge Candidates.
   A screen appears where you can set conditions for potential merge candidates.
3. In the Merge Patient Cases Where area, you can decide how far apart in time the case ECGs must be. The default is 10 minutes from the end of one case to the start of the next; both cases must have ECGs recorded 120 minutes or less apart to be considered. ECGs may overlap by up to 30 minutes to be considered as merge candidates. Click the slider and move it to the right or left to change this time value.
4. In the **AND** section, you can specify (by checking or unchecking) whether certain details of the cases must be equal as well, such as Case IDs or last names. The default is that all of these items must be equal for the two cases to be considered merge candidates.

5. You can also limit merge candidates by time—that is, how recently the cases were created. On the **Were Created in the Last** line, use the up and down arrows to change the number of days.

6. You can change the maximum number of recordings that can be contained in the merged case. The default is 2 and the maximum is 4.

7. When you are satisfied with the limitations you have set, click **Select**.

   Merge candidates that fulfill all of these requirements appear in the case list below, grouped with the older case above and any potential newer cases below it. This process may take many minutes to complete.

   ![In a given group of potential merge candidates, you can merge up to four cases. Once a case has four attached ECGs, it is not eligible for further merging.]

8. If you want to examine each of the cases before you make the decision to merge, you must leave the Merge Candidates screen and open the cases manually. When you are confident that the two cases refer to the same event, click **Merge**.

   **Merging cases changes the database, and these changes are difficult to undo.**

**How to separate a merged case:**

1. Open the merged case and then, in the File menu, click **Export**. (For this example, we assume you have a merged case with ECG from a HeartStart FR3 and a HeartStart MRx.)

2. In the open case, in the Case Editor, click the ECG tab for the case you want to separate from the current case (for example, detach the HeartStart FR3 ECG), and then, on the ECG menu, click **Detach**.

3. Save the changes (for example, resulting in a case with only the HeartStart MRx ECG).

4. Import the merged case that you exported in step 1 above.
5. Select the ECG tab you saved in step 3 (for example, an MRx ECG), and then, on the ECG menu, click **Detach**.

6. Save the changes (for example, resulting in a case with only the HeartStart FR3 ECG).

The previous steps preserve the original ECG waveforms from each defibrillator in separate cases. Any patient data entered on other tabs, including the Case ID, will be identical in both cases. Consider changing the Case ID in one of the cases, in order to distinguish the cases.

---

### Merging related cases automatically

If you have two cases with data from the same incident (for example, if one case were created by the EMTs on the scene and another by ambulance or hospital personnel using a different device), you might want to merge them into the same case during import. You can set criteria for the cases that are considered merge candidates, and these criteria will apply to all potential cases. When the criteria are fulfilled, the two cases will be merged automatically when imported into Event Review Pro.

When merge candidates have been identified, the newer one is merged into the older one. The newer one is then deleted. If the old case does not contain values for certain fields and the newer one does, these additional values are retained.

If you want to merge cases manually, changing the criteria for each, see **Merging related cases** on page 74.

To make any changes to the merging rules, you must run Event Review Pro as an administrator.

---

### To set ER Pro to merge cases automatically

1. On the navigation pane, click the **Administration** button.

1. Under Importing, click **Merge Rules**. A screen appears on the right with the criteria for automatic merging.

2. By default, Event Review Pro can merge cases automatically only if they were created within 120 minutes of each other. You can set this time limitation lower; the default is 10 minutes. ECGs may overlap by up to 30 minutes to be considered as merge candidates.

   In the **Recordings are Separated by Less Than** area, click the slider and move it to the time you want.
3. By default, all criteria (such as equal case IDs and patient last names) in the **AND (At Least One)** area must be met as well for automatic merging to occur. You can uncheck any of these boxes if you do not want these criteria to be required. However, at least one of them must remain checked.

4. In the **AND** section below that, you can decide whether Institution Names and Reference IDs need to be equal as well for the case to be considered a merge candidate. Check these boxes as appropriate.

5. You can change the maximum number of recordings that can be contained in the merged case. The default is 2 and the maximum is 4.

6. When you are satisfied with the criteria you want for merging, check the **Enable Automatic Merging** box. Only cases imported after you enable automatic merging will be eligible for automatic merging.

---

How to separate a merged case:

It is possible to separate the ECGs in a merged case; however, any additional case data that you entered before the merge may not be restored to the pre-merged state after the separation.

1. Open the merged case and then, in the File menu, click **Export**. (For this example, we assume you have a merged case with ECG from a HeartStart FR3 and a HeartStart MRx.)

2. In the open case, in the Case Editor, click the ECG tab for the case you want to separate from the current case (for example, detach the HeartStart FR3 ECG), and then, on the ECG menu, click **Detach**.

3. Save the changes (for example, resulting in a case with only the HeartStart MRx ECG).

4. Import the merged case that you exported in step 1 above.

5. Select the ECG tab you saved in step 3 (for example, an MRx ECG), and then, on the ECG menu, click **Detach**.

6. Save the changes (for example, resulting in a case with only the HeartStart FR3 ECG).

---

The previous steps preserve the original ECG waveforms from each defibrillator in separate cases. Any patient data entered on other tabs, including the Case ID, will be identical in both cases. Consider changing the Case ID in one of the cases, in order to distinguish the cases.
Adding case details

Use the Patient Cases navigation button to access a case and enter case information that the defibrillator did not record. In Cases, you can do the following tasks:

- Document events
- Document patient outcomes
- Add responder actions and observations
- Add responder notes
- Add reviewer notes
- Document patient history
- Review ECG information
- Review events
- Attach files to a case

For more information, see Working with ECGs on page 88 and Reviewing case details on page 133. You can use the case tabs in any order based on your tasks within your organization.

To add and review case details

1. Click the Patient Cases navigation button.
2. On the case selection table, double-click a case.
3. Click a tab.
4. Add or change information on the tab.
5. Repeat steps 3 and 4 as necessary.
6. On the File menu or toolbar, click Save.

Event Review Pro displays case detail tabs based on your installation.
Identifying the case

Use the Overview tab to enter basic information about the patient and the response location. The only required information is the case ID, and the case date and time.

If you use the Case Wizard to create a case, Event Review Pro assigns a case ID, which you can change. It also generates the case ID from the current date and time if Case Wizard or the Import feature did not create the case.

Different defibrillators may capture different patient information as part of recorded ECG data. If you use data from the HeartStart MRx, the ECG information might include patient information (such as name, age, and gender) that was entered by the responder. When you import a case using Case Wizard, the Case Summary page displays the information provided by the HeartStart MRx, and the Case ID field displays the HeartStart MRx incident ID.

If you import a redacted case, in any report that includes that case, the redacted case appears with a series of asterisks in the patient name fields, and the patient ID is replaced by a series of letters and numbers, unique to each patient ID. If the redacted age of the patient is greater than 90, the Date of Birth field is blank and the Age field displays 90.

If the case includes audio, audio is removed from the case. If you then import the case, the redacted information (the information that was removed) does not appear.

After you attach the ECG, you can change any of the information except the information in the following fields, which the defibrillator may supply:

- Recorded “On” Time
- Defibrillator Type
- Serial Number
- Shocks

To complete the fields
1. On the Overview tab, click the field.
2. Click an option on the menu or type the information in the field.
If Other appears in the option list, you can type a value in the Other text box. If your entry is the same as an option in the list, your entry appears as shown in the option list. Click **Clear** to remove the information in the field or text box.

**Overview section fields table**

<table>
<thead>
<tr>
<th><strong>Group or field</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Case ID (Required)</td>
<td>When you attach an ECG, incident ID becomes the case ID. You can change the case ID.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Initially, displays the time zone for the computer clock. The time zone displays in the Coordinated Universal Time (UCT) or Greenwich Mean Time (GMT) format in a similar format to the Time Zone tab on the Windows Date and Time Properties window. For example: (+1:00) Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna. Click the time zone of the location where the incident occurred.</td>
</tr>
<tr>
<td>Case date and time (Required)</td>
<td>If you attach an ECG before you save the case, this field is set to the date and time when the device was turned on. To change the date and time, click the value you want to change, and then type a new value.</td>
</tr>
<tr>
<td>Site of collapse</td>
<td>The list includes typical kinds of locations such as Ambulatory or outpatient area, Hotel, Workplace, Adult intensive care unit (ICU), and Cardiac catheterization lab (cath lab).</td>
</tr>
<tr>
<td>Location Detail</td>
<td>You can use this field to be more specific about the site of collapse. For example, consider using this field to record map coordinates or the name of locations, such as the room number.</td>
</tr>
<tr>
<td>Reference ID</td>
<td>You can use this field to help identify the case. For example, Engine 3. Maximum of 40 characters.</td>
</tr>
<tr>
<td>Institution</td>
<td>You can use this field to identify the organization where the case originated. For example, Valley Fire Department. Maximum of 60 characters.</td>
</tr>
<tr>
<td>Code called (Hospital edition only)</td>
<td>The list is: Yes, No, and Unknown</td>
</tr>
<tr>
<td>Found by</td>
<td>The list is: Nurse, Physician, Therapist, Med technician, and</td>
</tr>
</tbody>
</table>
### Defibrillator section fields table

<table>
<thead>
<tr>
<th>Group or field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjusted &quot;On&quot; Time</td>
<td>You can use this field to synchronize the defibrillator-created date and time with the computer date and time. Event Review Pro automatically adjusts the date and time of each event on the ECG tab for the adjustment you enter. Note: Event Review Pro automatically adjusts the date and time based on the clock of the personal computer when it receives a Bluetooth transmission from a HeartStart MRx version 9.0 or later, or from an FR3. This adjustment records the Recorded &quot;On&quot; Time. You can still use this field to override the Recorded “On” Time.</td>
</tr>
<tr>
<td>Recorded “On” Time</td>
<td>When you attach an ECG, the field displays the date and time that the defibrillator was turned on.</td>
</tr>
<tr>
<td></td>
<td>HS1 and FRx only: If you removed the battery before the ECG was attached (downloaded), Event Review Pro displays a message requesting the case date and time. When you click OK, you see this screen:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Time Adjustment" /></td>
</tr>
<tr>
<td></td>
<td>Set the case date and time to the Recorded “On” Time of the ECG.</td>
</tr>
<tr>
<td></td>
<td>You can adjust the time in the Adjusted “On” Time field.</td>
</tr>
<tr>
<td>Defibrillator Type</td>
<td>When you attach an ECG, the field displays the defibrillator model name.</td>
</tr>
<tr>
<td></td>
<td>You cannot change it.</td>
</tr>
</tbody>
</table>
### Group or field

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Serial Number</strong></td>
<td>When you attach an ECG, the field displays the defibrillator serial number. You cannot change it.</td>
</tr>
<tr>
<td><strong>Shocks</strong></td>
<td>When you attach an ECG, the field displays the total number of shocks delivered to the patient by this defibrillator. You cannot change it.</td>
</tr>
</tbody>
</table>

### Patient section fields table

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th>Description</th>
</tr>
</thead>
</table>
| **Patient ID** | By default, the value in the Patient ID field is added based on the patient ID from the defibrillator (if the device supports entering such data). Otherwise, it is blank, and you can add an ID.  
The patient ID prints in report headers.  
A redacted case appears with the patient ID replaced by a series of letters and numbers, unique to each patient ID. |
| **First name** | The first name prints in report headers.  
If the ECG is from HeartStart MRx, this field can contain information entered on the HeartStart MRx. You can change it.  
A redacted case appears with a series of asterisks in the patient name fields. |
| **Middle name** | The middle name prints in report headers.  
A redacted case appears with a series of asterisks in the patient name fields. |
| **Last name**  | The last name prints in report headers.  
If the ECG is from HeartStart MRx, this field can contain information entered on the HeartStart MRx. You can change it.  
A redacted case appears with a series of asterisks in the patient name fields. |
<table>
<thead>
<tr>
<th><strong>Group or field</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Date of birth</td>
<td>Type the patient date of birth in the field. A redacted case displays a blank field.</td>
</tr>
<tr>
<td>Age</td>
<td>This is the age of the patient at the time of the response. Click the format used and type the age in the field. The units of measurements include years, months, or days. You can change the format at any time. Event Review Pro calculates the new value for you. If the ECG is attached from the HeartStart MRx, this field might contain information entered on the HeartStart MRx. You can change it. If you import a redacted case and the age of the redacted patient is greater than 90, the Age field displays 90. If the date of birth is entered, age is computed automatically, and you may not enter it.</td>
</tr>
<tr>
<td>Height</td>
<td>This is the height of the patient. Click the format used by the hospital and type the height in the field. The units of measurement include feet (ft), inches (in), centimeters (cm), or meters (m). You can change the format at any time.</td>
</tr>
<tr>
<td>Weight</td>
<td>This is the weight of the patient at the time of the response. Click the format used by your organization and type the weight in the field. The units of measurement include pounds (lb.), ounces (oz.), kilograms (kg), or grams (g). You can change the format at any time.</td>
</tr>
<tr>
<td>Gender</td>
<td>The list is: Female Male Unknown If the ECG is from the HeartStart MRx, this field might contain information entered on the defibrillator.</td>
</tr>
<tr>
<td>Group or field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Race</td>
<td>The list is:</td>
</tr>
<tr>
<td></td>
<td>American Indian or Alaska Native</td>
</tr>
<tr>
<td></td>
<td>Asian or Pacific Islander</td>
</tr>
<tr>
<td></td>
<td>Black, Hispanic</td>
</tr>
<tr>
<td></td>
<td>Black, Non-Hispanic</td>
</tr>
<tr>
<td></td>
<td>White, Hispanic</td>
</tr>
<tr>
<td></td>
<td>White, Non-Hispanic</td>
</tr>
<tr>
<td></td>
<td>Unknown</td>
</tr>
<tr>
<td></td>
<td>Other</td>
</tr>
</tbody>
</table>

### Describing the conditions at the scene

Use the Scene tab to enter the responder's initial impression of the patient and the scene. The information on this tab appears in the Case Report.

**To complete the fields**

1. On the Scene tab, click the field.
2. Click an option on the menu or type the information.

   If Other appears in the option list, you can type a value in the Other text box. If your entry is the same as an option in the list, your entry appears as shown in the option list. Click **Clear** to remove the information in the field or text box.

The following fields can accept more than one input:

- Existing medical treatments
- Past medical history
- Type of first responder
- Defibrillator types used
Documenting events

Use the Timeline tab to document the events that occurred during the case, the treatments that were administered, and the notes that were collected during the case. The Timeline tab also lists the notes that you add to the ECG on the ECG tab.

Event Review Pro sorts events for a new case in chronological order. You can sort events in ascending (1 to 9, a to z) or descending (9 to 1, z to a) order.


If Other appears in the option list, you can type a value in the Other text box. If your entry is the same as an option in the list, your entry appears as shown in the option list. Click Clear to remove the information in the field or text box.

Events that you add on the ECG tab appear on the Timeline tab as read-only. You can edit the Event Name parameters and the Comment fields, but not the Date and Time field.

 Adding, describing, and removing events

You can add, edit, and remove an event in an open case.

To add an event

1. On the Timeline tab, click the Event Name field.
   A menu showing types of events appears. You can click an event that is specific to the phase of events, an administered treatment, and a note added by a responder or reviewer.

2. Click an event from one of the menu columns.
   Event Review Pro adds the event to the table in chronological order.

   • If an event does not appear in the list of options in the Phase or Treatment columns, click the Custom option in the appropriate column to create one.
   • Click Responder Note to document notes from a responder.
   • Click Reviewer Note to document notes from a medical director, code team leader, or operations manager.
• If the event displays additional fields, complete the appropriate information for each field.

Event Review Pro displays a button to the left of the event. Click the button to collapse or expand the additional fields that document the event.

3. (Optional) Type text in the Comment field.
4. Repeat steps 1, 2, and 3 for each event, as necessary.

To edit an event
1. On the Timeline tab, click the appropriate event in the Event Name field.
2. Use one of the following methods:
   • On the menu, click the appropriate option.
   • Type the correction.

To remove one event
1. On the Timeline tab, click the Event Name field.
2. On the menu, click Remove this Event.
   The event disappears from the event table.

Sorting events
You can sort the information based on the column. Events in a new case are first sorted in chronological order.

Click the header to sort the list of values in ascending (1 to 9, or a to z) or descending (9 to 1, or z to a) order. A triangular symbol (arrow) appears to indicate the sort order.

Event Review Pro adds new events based on the sort order. The location of the event field for the new event changes depending on the sort order. For example, if you sort events in alphabetical order, Event Review Pro inserts the event alphabetically. The blank event field is at the top of the table. If you sort the event by date and time in descending order, Event Review Pro inserts the event at the top of the table. The blank event field is at the bottom of the table.
Changing the date and time of the event

You can change the date and time of an event that you entered on the Timeline tab.

To change the event date and time
1. Click the event.
2. Click Date and Time.
3. Click the value you want to change and type the correct date or time.

Documenting the patient's outcome

Use the Outcome tab (EMS edition only) and the Follow-up tab to enter information about the patient's outcome during and after hospitalization.

The intent for the Outcome tab is to enter information about the patient immediately following arrest and resuscitation. This information could be added while creating the case.

The intent for the Follow-up tab is to enter information about the patient in the future, for instance, on discharge from the hospital, or if the patient does not survive.

To complete the fields
1. Click the field.
2. Click an option on the menu or type the information in the field.

If Other appears in the option list, you can type a value in the Other text box. If your entry is the same as an option in the list, your entry displays as shown in the option list. Click Clear to remove the information in the field or text box.

Several fields use scores for Cerebral Performance Categories (CPC) and Overall Performance Categories (OPC). For more information, see CPC and OPC on page 217.

EMS Edition only: Utstein reports use the Any ROSC field.
Working with ECGs

Use the ECG tab in the Case Editor to add, review, and print ECG waveforms. You can also use the ECG tab to enter information and review events.

Displayed and printed waveforms do not meet the requirements of American National Standard ANSI/AAMI EC11:1991 (R)2007 for display of diagnostic electrocardiograms, and may not be suitable for diagnosis.

You can complete the following tasks on the ECG tab:

- View an attached ECG
- Add notes to an ECG
- Modify the display properties of an ECG

The ECG waveform includes recorded defibrillator events as well as reviewer and responder notes. For information on attaching an ECG, see Attaching ECGs on page 51.

For an explanation of the Case Editor workspaces on the ECG tab, see Understanding the Case Editor on page 88.

If the case includes 12-lead information, click the 12-lead tab within the ECG view to see a separate waveform and accompanying information. For details, see Working with 12-lead ECGs on page 119.

Understanding the Case Editor

When a case opens, it opens on the ECG tab, by default. The ECG tab is the area where the waveforms are displayed.

If you navigate away from the ECG tab, you can return to it by clicking it.

The ECG tab is one of a group of tabs on the Case Editor. Each tab in the Case Editor provides a different work area.

The Case Editor tabs, in order, as they appear from left to right:
The Case Editor default view

The following illustration shows the general arrangement of the Case Editor workspaces in the default view. The general arrangement is the same in all languages. Refer to the table after the illustration for definitions.

For information on viewing 12-lead ECGs in the Case Editor, see Working with 12-lead ECGs on page 119.

Key to illustration numbers for the previous illustration:
The Case Editor

The tabs of the Case Editor, used to open different work areas

The ECG tab of the Case Editor, the active tab when a case is opened

The ECG overview pane. NOTE: For details about waveform display, see The Case Editor Waveforms view on page 90.

The Events pane, used to view events in the case, ordered chronologically. See Events pane on page 92.

The Rhythm strip pane. Rhythm strip shows the waveforms used for rhythm identification, recorded by the device sequentially, in one strip.

The Transport pane, used to play, rewind, or fast-forward the waveform. If audio is present, use to play or mute audio. See Transport pane on page 93.

Label for a displayed waveform, in collapsed view.

The Patient Cases navigation pane.

The Waveforms button: click to open the Waveforms pane. See Waveforms pane on page 92.

The Vital Trends button: click to open the Vital Trends pane.

Navigating between the work panes in the Case Editor

When a case is first opened, the default view of the Case Editor shows the ECG tab with the Rhythm strip pane (see item 6 in the previous table). In the same region of the Case Editor, you can instead choose to show the Waveforms pane, or the Vital Trends pane. Those work areas, when not displayed, appear as buttons along the bottom of the Case Editor. To expand one of these work areas, click the corresponding button.

The Case Editor Waveforms view

The following illustration shows the Case Editor, with the expanded Waveforms pane. The general arrangement is the same in all languages. Refer the table after the illustration for definitions.
Key to illustration numbers for the previous illustration:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Case Editor, ECG tab.</td>
</tr>
<tr>
<td>2</td>
<td>The expanded Waveforms pane.</td>
</tr>
<tr>
<td>3</td>
<td>The Waveforms pane drop-down menu:</td>
</tr>
<tr>
<td></td>
<td>By default, all waveforms in the</td>
</tr>
<tr>
<td></td>
<td>case are shown, stacked vertically.</td>
</tr>
<tr>
<td></td>
<td>Use the menu checkboxes to</td>
</tr>
<tr>
<td></td>
<td>hide/show waveforms by type.</td>
</tr>
<tr>
<td></td>
<td>Changes from the default are</td>
</tr>
<tr>
<td></td>
<td>remembered in future sessions and</td>
</tr>
<tr>
<td></td>
<td>cases.</td>
</tr>
<tr>
<td>4</td>
<td>Arrow button, used to expand or</td>
</tr>
<tr>
<td></td>
<td>collapse the waveform controls.</td>
</tr>
<tr>
<td>5</td>
<td>Vertical scroll bar, used to view</td>
</tr>
<tr>
<td></td>
<td>waveforms above or below the visible</td>
</tr>
<tr>
<td></td>
<td>area.</td>
</tr>
<tr>
<td>6</td>
<td>Time scale control, used to</td>
</tr>
<tr>
<td></td>
<td>compress or expand the visible time</td>
</tr>
<tr>
<td></td>
<td>range of the waveforms.</td>
</tr>
<tr>
<td>7</td>
<td>Horizontal scroll bar, used to</td>
</tr>
<tr>
<td></td>
<td>scroll the visible waveform left or</td>
</tr>
<tr>
<td></td>
<td>right.</td>
</tr>
<tr>
<td>8</td>
<td>Zoom control, used to scale the</td>
</tr>
<tr>
<td></td>
<td>waveform as a percentage of the</td>
</tr>
<tr>
<td></td>
<td>default 25mm/sec x 40mm.</td>
</tr>
<tr>
<td>9</td>
<td>The Waveforms Overview: By default,</td>
</tr>
<tr>
<td></td>
<td>only the first waveform recorded in</td>
</tr>
<tr>
<td></td>
<td>the case is shown in this view. See</td>
</tr>
<tr>
<td></td>
<td>Overview pane on page 92.</td>
</tr>
</tbody>
</table>
The Waveforms Overview drop-down menu: You can choose to overlay multiple waveforms in this view. Check or uncheck boxes to show/hide waveforms by type. Changes from the default are remembered in future sessions and cases.

Events pane

All defibrillator events and notes appear in chronological order on the Events pane. You can expand events or notes in the Events pane to display additional details. For more information, see Using the Events pane on page 93.

Use the Events toolbar to search for specific events or notes. You can also add a note for an ECG. Use the event filter to control the display of events and notes on the waveform. The event filter displays all possible event types and categories. Check or uncheck them to control whether they appear.

Overview pane

The Overview pane displays the ECG waveform with flagged events and notes.

You can use the Overview toolbar to:

• Select the waveform displayed on the Overview pane.
• Select multiple waveforms to display them overlayed on one another.
• Select portions of the ECG for detailed view on the Waveforms pane.
• Change the time scale for the ECG.

Waveforms pane

The Waveforms pane can provide a more detailed view of each waveform. Event Review Pro can display multiple waveforms in this pane.

Use the Waveforms pane to do the following:

• Add, edit, or delete notes
• Control the display of waveforms
• Analyze the quality of the CPR administered
**Transport pane**

The Transport pane at the bottom of the ECG view displays the ECG lead information, the sweep bar time, and the cursor time relative to the sweep bar location on the ECG.

Use the Play button to play the entire ECG.

If an audio recording is associated with the ECG, you can use the audio controls to play the audio while viewing correlated events on the waveform on the Waveforms pane.

You can also use the controls on the Transport pane to find and select events on the waveform for review.

For more information, see [Reviewing waveform information](page.106) on page 106.

---

**Using the Events pane**

A list of defibrillator events and notes associated with an ECG appears in an expandable list on the Events pane. Defibrillator events can include items such as the following:

- Shocks
- Alarms
- Monitor settings
- Equipment status
- Q-CPR events

In the Events pane, you can identify types of events, view them, search for them, and display/hide them. You can also manage the notes that are attached to each case.

**Identifying types of events**

Event Review Pro displays the notes that were entered by the user and events recorded by the device. For more information, see [Documenting events](page.85) on page 85.

The following icons identify event entries:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>📝</td>
<td>Note: A user-input observation about the patient’s status or the</td>
</tr>
<tr>
<td>Symbol</td>
<td>Meaning</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
</tr>
<tr>
<td>responder's intervention made on the Timeline tab.</td>
<td></td>
</tr>
<tr>
<td>!</td>
<td>Note: A user-input observation about the patient’s status or the responder's intervention made on the ECG tab.</td>
</tr>
<tr>
<td>Warning</td>
<td>Shock: The delivery of therapy by the defibrillator.</td>
</tr>
<tr>
<td>Device On</td>
<td>Device On: The time the defibrillator was turned on or returned to use.</td>
</tr>
<tr>
<td>Device Off</td>
<td>Device Off: The time the defibrillator was turned off.</td>
</tr>
<tr>
<td>Bell</td>
<td>Defibrillator alarm: An alert provided by the defibrillator. The alarm calls attention to a patient vital sign that is beyond a preset threshold.</td>
</tr>
<tr>
<td>Error</td>
<td>Error condition: An error related to the ability of the defibrillator or part of the defibrillator to perform its intended monitoring function.</td>
</tr>
</tbody>
</table>

**Viewing events**

When you click an event in the Events pane, the sweep bar automatically moves to the location of the event on the ECG strip on the Overview and Waveforms panes. You can expand the event in the Events pane to view event details.

To view event details, in the Events pane, click Expand next to the event you want to view. Event details appear. You can also double-click the event label to view details.

**To expand an Events pane node**

1. Click an event or event node.
2. Click the PLUS SIGN (+).

**To collapse an Events pane node**

1. Click an event or event node.
2. Click the MINUS SIGN (-).

**To find and view an event using the scroll bar**

1. Click and drag the scroll bar down the Events pane to find an event.
2. Click the event.
   The sweep bar moves to the location of the event on the waveform.

3. Double-click the event.
   The event expands to display event details.

**Searching for events**

Use the Search button on the Events toolbar to search for events or notes.

**To search for an event**

1. Type or select the event name in the text box on the Events toolbar.
   The search text can be any portion (substring) of the event name as it appears in the event label. For example, to search for "patient age," you could type "patient age," "age," or even just "patient."

2. Click Search.
   If the search finds an event, it appears selected in the event pane, and the sweep bar moves to the location of the event on the waveform.

**Hiding or displaying events**

Use the Filter tab to display or hide events on the waveform on the Overview, Waveforms, and Events panes according to criteria that you choose.

You can display or hide events either by category or by type. If you filter by category (for example, if you filter by Q-CPR), then all event types in that category (CPR Pads Off, CPR Intubated, etc.) are hidden as well.

By default, all events appear except CPR compression events.

The caution icon appears on the Filter tab when there is at least one event type or category that was filtered. See the procedure below to display some or all of these events.

**To use the event filter**

1. On the Events pane, click the Filter tab.
   A list of event categories appears.
2. Click **Expand** next to an event category. The event types in the selected category appear.

3. Uncheck the box for any event type or event category that you want to remove from the display.

   The following results occur:
   - The event or events disappears from the Overview and Waveforms panes.
   - The event or events disappears from the Events pane.
   - The caution 🚸 icon on the Filter tab appears.

**Managing notes**

You can add, modify, and delete notes in the Events pane. You can also add, edit, and delete notes directly on the ECG on the Overview or Waveforms pane. For more information, see Managing notes on the waveform on page 114.

**To add a note in the Events pane**

1. Click the part of the Events pane where you want the note to appear.

2. On the toolbar, click **Add Note**.

   The Note window appears, with a table similar to the table on the Timeline tab.

3. Click in the **Event Name** field.

4. From the list of events in the pop-up window, click and complete an event the same as when you add events on the Timeline tab.

   For more information, see Documenting events on page 85.

5. Complete the fields, as appropriate.

   For example, for a Reviewer Note, type Reviewer name, Reviewer title, and Reviewer department.

   If you click **Custom event**, type the event name and unit, if appropriate.

6. Click **OK**.

   The note now appears on the event pane, the ECG waveform, and the Timeline tab.

**To modify a note in the Events pane**

1. Click the note you want to modify.
2. On the toolbar, click Edit Note.
3. In the Note window, modify the note.
4. Click OK.

To delete a note in the Events pane
1. Click the note you want to delete.
2. On the toolbar, click Delete Note. The note disappears from the Event pane, the ECG waveform, and the Timeline tab.

Viewing waveforms

You can see the entire ECG as a series of strips on the Overview pane. It includes markers and labels for recorded events and notes. You can point to event labels on the ECG on the Overview pane to view event details. In the Waveforms view, you can zoom in to see an ECG segment of interest.

On the Overview and Waveforms panes, a vertical sweep bar indicates the current ECG time. The sweep bar provides a visual cue to the current position on the waveform. Click the ECG on the Overview pane to move the sweep bar to the pointer location on the Waveforms pane. For more information, see Working with waveforms on page 97.

You can see a close-up view of a segment of the waveform on the Waveforms pane or the Rhythm strip pane.

To see the location of these panes in the Case Editor, see Understanding the Case Editor on page 88.

Working with waveforms

You can manage notes on the Overview and Waveforms panes.

The following illustration shows the general arrangement of the Overview pane. The general arrangement is the same in all languages. The dashed box (at the black arrow, below) identifies the extents of waveform that appears on the Waveforms pane (below the Overview pane).
By default, the primary defibrillator waveform appears on the Overview pane, and is checked in the Waveform drop-down menu (at the red arrow, below) on the Overview. Check other waveforms in the menu to display them. Menu changes will persist in future sessions and with future cases.

To add and manage notes on the waveform, see Managing notes on the waveform on page 114.

This ECG is intended only for basic rhythm identification. It is not intended for diagnostic and ST segment interpretation.

To select a waveform

1. On the Overview toolbar, click the Waveform drop-down menu.
2. From the menu of all recorded waveforms in the case, click the waveform or waveforms that you want to view on the Overview pane.

To view event details on the waveform, hover the mouse over the event marker on the ECG waveform. Event details appear in a pop-up window.

You can set multiple waveforms to display simultaneously. In the Waveform drop-down menu (shown on the previous illustration), click the check box next to each waveform that you want to display.

To remove a waveform from the overview, uncheck it in the menu. In the Overview pane, the multiple waveforms appear overlapped, and in different colors. Each waveform is labeled at its beginning.
Displaying and hiding waveforms

If the case has multiple waveforms, you can select which waveforms to display or hide on the Waveforms pane.

See the location of the Waveforms pane and Waveforms drop-down menu in the section “The Case Editor Waveforms view” in Understanding the Case Editor on page 88.

To open waveforms for viewing on the Waveforms pane, select the waveforms from the Waveforms drop-down menu at the top of the Waveforms pane (the inspector must first be opened). The selected waveform then appears. You can use the vertical scroll bar to see open waveforms. You can also drag the border to increase the size of the Waveforms pane.

To hide a waveform on the Waveforms pane, uncheck the waveform the Waveforms drop-down menu at the top of the Waveforms pane.

Waveforms in the Rhythm strip pane

The waveforms used for rhythm identification are shown in the Rhythm strip pane, arranged sequentially in a single strip, in the order recorded by the device. All the waveforms that make up the rhythm strip are included on the strip; therefore, there is no need for a Waveforms drop-down menu in this pane. To display the waveforms on the Rhythm strip pane, scroll horizontally through the timeline on the Rhythm strip pane. The same waveforms can also be viewed individually in the Waveforms pane.

For information on docking/undocking and pinning/unpinning areas of the ECG display, see Arranging sections of the ECG display on page 99.

Arranging sections of the ECG display

You can use the pinning function to maximize or minimize sections of the ECG display work area.

If you ever need to put the sections back to their default sizes and locations, on the Tools menu, click Options, then Restore Defaults, and then ECG Viewer and Reports. The settings will be restored when the application is restarted.

"Pinning" and "unpinning" refer to maximizing or minimizing a section of the work area.
The following illustrations show the general arrangement of the work area. The general arrangement is the same in all languages. A pinned section might look like the illustration, where the pin is visible in the upper right corner:

When you click the pin for the section, it becomes minimized; all that you see is a tab for it at the edge of the display, as in the figure below.

Click the tab, and then click the pin, to pin it open again.

**Magnifying waveforms**

Use the magnifier to get a detailed view of a section on the waveform.

**To use the magnifier tool**

1. Hold down SHIFT and press the mouse button as you point to the area on the waveform that you want to magnify.
   
   A magnified view of the waveform appears, with crosshairs at the location of the pointer.

2. Release the SHIFT button while continuing to press the mouse button, move the pointer to another location on the waveform for closer inspection.
   
   The elapsed time and waveform values appear for the magnified section, as well as the endpoints of each axis.

**Changing the display time**

At the top of the Waveforms pane, a ruler indicates the time scale of the waveform displayed in elapsed time or clock time. Use the waveforms ruler to change the time scale between Elapsed time and Clock time.

- Elapsed time is the time since the defibrillator was turned on.
- Clock time is the actual clock time based on the Adjusted Time.

The time scale appears with divisions for seconds and fractions of seconds.
The date and time formats used in this software and in the reports is controlled by the Windows Region and Language control panel. Use that control panel to adjust the date and time format. For example, use it to choose 24 hour time.

If an audio clip is associated with the waveform, the waveforms ruler displays a blue overlay where the audio is present, in relation to the waveforms.

**To change the display time**

1. Right-click the waveforms ruler.
2. On the shortcut menu that appears, click one of the following time formats:
   - Elapsed Time
   - Clock Time

   The display time changes according to your selection.

**Changing the time scale**

Use the time scale slider on the bottom left side of the Waveforms pane to select the time scale in mm/sec. The default time scale is 25.0 mm/sec. You can also use the mouse wheel to change the time scale if the Waveforms pane is currently in use.

The time-scale grid adjusts according to the time scale selected. At the default time-scale setting of 25.0 mm/sec, the grid marks indicate 1-second intervals. If you decrease the time scale, the grid marks indicate larger intervals. For example, if you decrease the time scale to 12.5 mm/sec, the grid marks indicate 5-second intervals.

To change the time scale using the time scale slider, click the time-scale slider and complete one of the following procedures:

- To increase the scale, drag the slider to the right.
- To decrease the scale, drag the slider to the left.

The adjusted scale appears in mm/sec., and the waveform display adjusts accordingly.
To change the time scale using the mouse wheel, use one of the following methods. Point to the waveform, hold the SHIFT key, and click the mouse wheel to complete one of the following actions:

- To increase the scale, hold the SHIFT key and roll the mouse wheel forward.
- To decrease the scale, hold the SHIFT key and roll the mouse wheel backward.

The adjusted scale appears in mm/sec., and the waveform display adjusts accordingly.

To reset the time scale to default, hold down CTRL and click the time-scale slider. The time scale resets to the default scale (25.0 mm/sec.).

**Scrolling through the waveform**

Use the waveform scroll bar at the bottom of the Waveforms pane to scroll through the waveform strip. You can also scroll through the strip using key command shortcuts. For more information, see [Using key command and mouse shortcuts](#) on page 129.

To scroll through the waveform, drag the waveform scroll bar to the desired location on the waveform.

**Customizing waveforms**

Event Review Pro provides a waveform properties tool for each waveform. This tool displays information about the waveform and provides features to modify the waveform display. You can choose to show or hide the tool. By default, the tool is closed; click the arrow key on the left (see below) to open the tool.

When the waveform properties area is closed, it looks like this:
When the area is open, it might look like this:

The waveform properties tool displays the following information about the current waveform:

- The waveform type or source
- The sample rate in Hz
- The current vertical offset and scale
- The scale in millivolts per millimeter (for ECG waveforms)

You can control the vertical offset and you can scale the waveforms. You can also control the color of the waveforms.

If the ECG has multiple waveforms, you can change the display order.

- To show the waveform properties tool, click Expand. To hide the tool, click Collapse.
- To move a waveform up on the Waveforms pane, click Move Up.
- To move a waveform down on the Waveforms pane, click Move Down.
To change the color of a waveform

1. Click the color selector to the right of the waveform ID strip.
2. In the Color window, click the desired color and click OK.
   The waveform appears using the selected color.

Changing the waveform offset

The Baseline field, available in the ECG waveform when you expand the Waveforms area with the arrow, controls the vertical offset for the waveform. The Baseline field displays the current vertical offset in the relevant waveform units, for example, mV for an ECG. Use the Center button to center the waveform segment displayed in a waveform. The waveform appears with the offset determined by the average of the waveform values in the segment currently displayed in the waveform.

The following table provides numbers and feature names corresponding to the images that follow.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Waveforms area</td>
</tr>
<tr>
<td>2</td>
<td>Arrow</td>
</tr>
<tr>
<td>3</td>
<td>Baseline field</td>
</tr>
<tr>
<td>4</td>
<td>Center button</td>
</tr>
<tr>
<td>5</td>
<td>Waveform</td>
</tr>
</tbody>
</table>

The following illustration shows the general arrangement of the Waveforms area before it is expanded. The general arrangement is the same in all languages.
The following illustration shows the general arrangement of the expanded Waveforms area, with a waveform display before centering. The general arrangement is the same in all languages.

![Waveform display before centering](image)

The following illustration shows the general arrangement of the waveform display after centering. The general arrangement is the same in all languages.

![Waveform display after centering](image)

You can adjust multidigit scale values based on the digit selected. For example, if the value in the Range field is 100 mV and the third digit is increased by 1, the scale increases to 101; if the second digit is increased by 1, the scale increases to 110.

To change the waveform vertical offset gradually, single-click the specific digit you want to change in the Baseline field (for instance, if you want to change 125.63 to 125.69), click the 3 so that it is highlighted, and do one of the following:

- To increase the vertical offset, while holding the left mouse button, move the mouse so that the cursor moves upward on the screen.
- To decrease the vertical offset, while holding the left mouse button, move the mouse so that the cursor moves downward on the screen.

The adjusted vertical offset value appears in the Baseline field, and modifies the vertical offset of the waveform displayed in the Waveforms area accordingly.
To specify the waveform vertical offset, double-click the **Baseline** field and type the offset value. The waveform in the Waveforms area appears with the specified offset.

To restore the default waveform offset (the offset from the device), hold down **CTRL**, and click in the **Baseline** field.

### Changing the waveform scale

The Range field, available in the ECG waveform when you expand the Properties area with the ➡️ arrow, controls the scale of the waveform.

You can adjust multidigit scale values based on the digit selected. For example, if the value in the Range field is 100 mV and the third digit is increased by 1, the scale increases to 101; if the second digit is increased by 1, the scale increases to 110.

To change the waveform scale gradually, single-click the specific digit that you want to change in the **Range** field (for instance, if you want to change 125.63 to 125.69), click the 3 so that it is highlighted, and do one of the following:

- To increase the waveform scale, turn the mouse scroll wheel forward, or move the mouse so that the cursor moves upward on the screen.
- To decrease the waveform scale, turn the mouse scroll wheel backward, or move the mouse so that the cursor moves downward on the screen.

The adjusted scale value appears in the Range field, and modifies the scale of the waveform displayed in the Waveform s pane accordingly.

To specify the waveform scale, double-click the **Range** field and type the scale value in **mV**. The waveform appears in the Waveform s pane according to the specified scale.

To restore the default waveform scale, hold down **CTRL**, and click in the **Range** field.

### Reviewing waveform information

Use the controls on the Transport pane (shown below) to navigate through events on an ECG waveform, play the waveform, and play an associated audio clip, if present, while reviewing the waveform.
You can also review information about the current sweep bar and pointer locations in the Transport pane at the bottom of the ECG view.

Navigating ECG events on the waveform

- If you click **Next** 🔄, the sweep bar moves to the location of the next event on the ECG waveform and displays the event time on the information pane.

- If you click **Previous** ⬅️, the sweep bar moves to the location of the previous event on the ECG waveform and displays the event time on the information pane.

- If you click **Play** 🎧, the waveform moves at the speed of real time.

Playing the ECG audio

If an audio clip was recorded with the ECG, you can play the audio and move along (traverse) the waveform on the Waveforms pane. The sweep bar indicates the location on the waveform corresponding to the current audio. You can also play and pause the audio by pressing the spacebar if the Waveforms pane is currently in use. For more information, see Using key command and mouse shortcuts on page 129.

- To play the ECG audio, click **Play** 🎧. The audio clip plays, and the sweep bar moves through the waveform on the Waveforms pane and indicates the real time on the information pane. If a section of the ECG has no audio, you will see a flashing indicator that displays "No audio."

- To pause the ECG audio, click **Pause** 🎧. The audio pauses, and the sweep bar stops at the current location on the ECG waveform.

- To change the volume of the ECG audio, drag the **Volume** slider to the level you want. This adjustment is relative to the volume that you set in the Windows audio control. If your Windows audio is muted or the volume is very low, the Event Review Pro volume setting cannot override it.

- To reset the ECG audio volume to the default level, hold down **CTRL** and click the **Volume** slider.
**Viewing ECG information**

The date of the ECG, and the Clock time and Elapsed time for the sweep bar location, appear in an information pane at the bottom of the ECG view.

The waveform type and value for the current pointer location also appears, as well as the cursor delta time. The cursor delta time is the difference in milliseconds between the current pointer location on the waveform and the sweep bar location.

To measure the cursor delta time, click a location on the waveform, to place the sweep bar, then move the cursor to the left or right of the sweep bar.

The difference between the pointer location and the sweep bar appears in the Cursor time field on the information pane.

To measure the waveform value, move the cursor over a location on the waveform. Event Review Pro dynamically assigns a name to the waveform type field, according to the waveform type or source, and displays the waveform value in the waveform value field.

The waveform value is displayed in units appropriate to the waveform type, as in the following examples:

- \( mV \) for leads
- \( mmHg \) for blood pressure and CO2
- \( mm \) for compression
- \( mOhms \) for ventilation

**Defining and viewing ECG selections**

ECG selections are portions of the ECG that you need to reference for future examination—like bookmarks. You can mark any part of an ECG as a selection and give it a name; you can also assign it a distinctive color to set it off. With selection templates, you can set up a process to create selections automatically when a specific event in the ECG occurs. Once you have more than one selection, you can sort them for quick reference.

You can also print a strip report of the ECG selections from the File menu or the application toolbar. For more information, see Generating reports on page 151 and Working with ECG reports on page 155.

Shortcut menu commands on the Waveforms pane assist in these tasks.
Creating ECG selections

If you want to isolate a section of ECG data for separate attention (such as focused analysis during debriefing, or printing it by itself and inserting it in slide presentations, documents, or emails), you can create a "selection." You can do this three different ways:

- To create an ECG selection manually, click where you want the clip to begin on the waveform, and press and hold the mouse button as you move the pointer to where you would like the clip to end. An overlay highlights the selection.
- If you want to create a single selection of a predetermined length in the part of the ECG that is on the screen at the moment, use the Auto-selection feature, You can set the length in seconds before you create the selection.
- If you want to set a template to create a selection automatically every time a certain event occurs (like an alarm, a shock event, or a ventilation), see Using selection templates on page 112.

To automatically create ECG selections

1. In the Auto-selection (secs) text box, type the ECG automatic selection length in seconds.
2. Hold down CTRL and click the ECG where you want to create an automatic selection.

A selection appears that is centered on the pointer location. A colored overlay highlights the selection.

Managing ECG selections

Use the ECG menu or shortcut menu on the Overview or Waveforms pane to manage ECG selections. To display the shortcut menu, right-click the ECG.

In addition to printing and copying ECG selections, you can do the following tasks:

To create an ECG selection using the shortcut menu

1. Move the sweep bar to the point in the waveform where you want the selection to begin.
2. On the ECG or shortcut menu, click **Selections**, and then click **Set Selection Start**.

3. Move the sweep bar by clicking the point in the waveform where you want the selection to end.

4. On the ECG or shortcut menu, click **Selections**, and then click **Set Selection End**.

**To change the color of the ECG selection**

1. Click the selection on the waveform.

2. On the ECG waveform, right-click, and then, from the menu, click **Selections** and then click **Selection Color**.

3. In the Color window, click a color and click **OK**.

4. On the **File** menu or toolbar, click **Save**.

   You can now export and import the case with the current ECG view. Event Review Pro also saves the color for future selections.

**To convert an ECG selection to a Q-CPR exclusion**

1. Click the selection on the waveform.

2. On the ECG menu, or the shortcut menu, click **Selections**, and then click **Convert to Q-CPR Exclusion**.

   The selection is now a Q-CPR exclusion. For more information on Q-CPR reports, see [Working with Q-CPR Report Card reports on page 158](#). For more information on Q-CPR exclusions from reports, see [Removing CPR exclusions on page 126](#).

**To clear an ECG selection**

1. Click the selection on the waveform that you want to remove.

2. Use one of the following methods:
   - On the ECG menu, or the shortcut menu, click **Selections**.
   - Right-click the selection to display the shortcut menu and click **Selections**.

3. From the list of selection commands, click **Remove Selection**.

   The selection disappears.

**To clear all ECG selections**

1. Use one of the following methods:
   - On the ECG menu, or the shortcut menu, click **Selections**.
• Right-click the selection to display the shortcut menu and click **Selections**.

2. From the list of selection commands, click **Remove All Selections**.

All selections disappear.

---

**Naming, finding, and sorting ECG selections**

All ECG selections appear in tabular form on the Selections tab. Use the Selections tab to sort, assign names to, and search for selections.

---

💡 You can use selection names as bookmarks. The selection name appears at the bottom of a named selection in the Waveforms pane.

---

**To name ECG selections**

1. Click the **Selections** tab.

   All selections appear, sorted according to time of creation.

2. Click the name field for a selection to highlight the number assigned at creation.

3. Type a name or unique ID for the selection.

4. Repeat steps 2 and 3 for each selection.

---

**To search for a selection**

1. On the Overview toolbar, type search criteria in the **Search Selections** field.

   Event Review Pro searches for selections based on the name field. The search text must match the selection name in the same order as it appears on the Selections tab and cannot include a "wildcard" (that is, a placeholder for an unknown part of the search string). For example, to search for Shock 1 delivered, you can type "shock" or "Shock 1". Case does not matter. However, if you type only "Shock delivered," you will not get results. If you want to search for Shock 2 delivered, you must specify "Shock 2" to find the subsequent selection.

2. Click **Search**.

   The waveform selection matching the search text is now highlighted in the Waveforms pane.
To change the sort order
1. Click the Selections tab.
   All selections appear, sorted according to time of creation.
2. Click the heading of the field you want to sort by.
   The selections sort themselves by the field that you chose.
3. Click the field heading again to toggle between ascending or descending order.

While viewing ECG in the overview or Waveforms pane you can quickly move from one waveform selection to the next, use the UP ARROW and DOWN ARROW keys.

Using selection templates

Use selection templates to create event-based ECG selections automatically. For instance, you can create a template that will mark all shocks delivered, showing you 2 seconds before and after the event, and make the selection blue.

Selection templates are saved and are available to be run every time you import a case.

To create a selection template
1. Click the Selection Templates tab.
   The headings for a selection templates table appear.
2. Click New.
   A new row appears in the selection templates table.
3. From the Event Category drop-down list, click an event category.
4. Click in the Event Type field for the new selection template.
5. From the Event Type drop-down list, click an event type.
6. In the Pre-seconds field, type the number of seconds you want to precede the event in the selection.
7. In the Post-seconds field, type the number of seconds you want to follow the event in the selection.
8. In the Color field, click the color you want to highlight the selection.
9. Click Create.
   ECG selections appear according to your criteria.
To delete a selection template
1. Click the Selection Templates tab.
   The headings for a selection templates table appear.
2. Click a template and click Delete.

Copying ECGs to the Clipboard

You can copy ECG strips and ECG selections to the Clipboard. You can then paste the strips and selections into documents created by a word processing or graphic application. Copy the ECG strips and selections from the ECG view.

To copy an ECG strip to the Clipboard
1. Right-click the strip in the Overview or Waveforms pane.
2. On the menu that appears, click Copy to Clipboard.
3. Paste the contents of the clipboard into a document.

To copy an ECG selection to the Clipboard
1. Left-click the selection you want to copy, to highlight it, and then right-click to open the menu.
2. On the menu, click Selections.
3. Click Copy Selection to Clipboard.
4. Paste the contents of the clipboard into a document.

Exporting waveform data

To export a case in the Waveform Database format (.wfdb format), which is used for data analysis, use the Export option on the File menu or toolbar. For more information on this format, see http://www.physionet.org.

Event Review Pro cannot import .wfdb files. For more information, see Importing case files automatically on page 65.

To export only ECG data
1. Open a case. For more information, see Displaying case details on
1. Click the ECG tab.
2. Click the ECG View tab.
3. On the ECG menu, click Export to WFDB.
   The Save As window opens.
4. In the Save in box, navigate to the location where you want to save the exported ECG data.
5. In the File Name box, type a name for the data files.
6. Click Save.
   Event Review Pro exports the files to the folder that you name.

Managing notes on the waveform

You can add, edit, and delete notes on the ECG waveform or on the timeline tab.

To add a note
1. Click the waveform where you want the note to appear.
   The sweep bar moves to the pointer location.
2. Use one of the following methods:
   • On the ECG menu, click Add Note.
   • On the Events pane toolbar, click Add Note.
   • Right-click the waveform to display the shortcut menu, and click Add Note.
   The Note window opens.
3. Click the Event Name field.
4. On the list of events, click and complete an event from the list the same as when you add events on the Timeline tab.
   For more information, see Documenting events on page 85.
5. Complete the fields, as appropriate.
6. Click OK.
   The note now appears on the waveform, the event list, and the Timeline tab.
NOTE: See the notes at the end of this topic, which explain fixed versus relative times and waveform notes.

To modify a note
1. On the event list, click the note that you want to modify.
2. Use one of the following methods:
   • On the Events pane toolbar, click Edit Note.
   • Right-click the annotation on the waveform to display the shortcut menu, and click Edit Note.
3. In the Note window, make your modifications to the note.
4. Click OK.

To add a quick note
1. Click the waveform where you want the note to appear.
   The sweep bar moves to the pointer location.
2. Right-click the waveform to display the shortcut menu, and click Add a quick note. (You can use the keyboard shortcut CTRL + N to do the same thing.)
   The Note field opens on the waveform.
3. Type your note in the field, and press ENTER.
   The note appears on the waveform.

   The most recent 100 entries are saved and become available to auto-complete a quick note. The selections appear as you type the note.

To delete a note
1. Click the note that you want to delete.
2. Use one of the following methods:
   • On the Events pane toolbar, click Delete Note.
   • Right-click the annotation on the waveform to display the shortcut menu, and click Delete Note.
   The note disappears from the waveform.
If you want to add a note with a "fixed" wall-clock time to the ECG waveform—that is, its time and date do not change when the device on-time is adjusted—add the note from the Timeline tab. The date and time field remains manually editable for notes created on the Timeline tab.

If you want to add a note with a time relative to the device on-time, add the note on the ECG tab. The note’s time will adjust when the device on-time is adjusted, or when the note is dragged to a new location on the waveform. The notes added on the ECG tab also appear in the list on the Timeline tab; however, they appear grayed, and are not editable there.

### Zooming in and out of the waveform

Use the ECG menu or shortcut menu to zoom in and out of the waveform.

**To zoom in or zoom out**

1. Click the waveform.
2. Use one of the following methods:
   - On the Case Editor, use the Zoom control to zoom in or out on a waveform. For help locating the Zoom control, see "The Case Editor Waveforms view" in Understanding the Case Editor on page 88.
   - Right-click the waveform to display the shortcut menu, and click **Zoom In** or **Zoom Out**.
   - On the numeric keypad, press **PLUS (+)** to zoom in or **MINUS (-)** to zoom out.

**To zoom in or zoom out fully**

1. Click the waveform.
2. Press **SHIFT** and, on the numeric keypad, press **PLUS (+)** to zoom in fully or **MINUS (-)** to zoom out fully.
Customizing the ECG display

You can configure the display of the waveforms in the Waveforms pane according to your preferences. You can control the display of device events, notes, and labels. You can also configure the display of the grid and the gradient background in the waveforms.

To remove ECG information from the display
1. Click the Waveforms pane.
2. Use one of the following methods:
   • Click the ECG menu.
   • Right-click the ECG.
3. Click Display Items.
   The display items menu opens.
4. Click the item that you want removed from display.
   The item disappears from the ECG. For additional information, see Reviewing case events on page 133.

To restore ECG information to the display
1. Click the Waveforms pane.
2. Use one of the following methods:
   • Click the ECG menu.
   • Right-click the ECG.
3. Click Display Items.
   The display items menu opens.
4. Click the item that you want restored.
   The item reappears in the ECG.

Reviewing vital trends data

On monitor/defibrillators like the HeartStart MRx, vital trends data is associated with the ECG. You can view this data in Event Review Pro in a table or on a chart.

The following illustration shows the general arrangement of the Table view. The general arrangement is the same in all languages.
In Table view, you can select the time interval for the vital trends information.

<table>
<thead>
<tr>
<th></th>
<th>08:40</th>
<th>08:45</th>
<th>08:50</th>
<th>08:55</th>
<th>09:00</th>
<th>09:05</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR (bpm)</td>
<td>0°</td>
<td>73°</td>
<td>73°</td>
<td>73°</td>
<td>73°</td>
<td>--</td>
</tr>
<tr>
<td>Temp (°F)</td>
<td>78.9°</td>
<td>79.1°</td>
<td>79.1°</td>
<td>79.1°</td>
<td>79°</td>
<td>--</td>
</tr>
<tr>
<td>AwFR (rpm)</td>
<td>0°</td>
<td>0°</td>
<td>0°</td>
<td>0°</td>
<td>20°</td>
<td>--</td>
</tr>
<tr>
<td>ABP mean (mmHg)</td>
<td>57°</td>
<td>96°</td>
<td>96°</td>
<td>96°</td>
<td>96°</td>
<td>--</td>
</tr>
<tr>
<td>ABP systolic (mmHg)</td>
<td>120</td>
<td>120°</td>
<td>120°</td>
<td>120°</td>
<td>120°</td>
<td>--</td>
</tr>
</tbody>
</table>

On the Vital Trends toolbar, click the Interval: drop-down menu and click 5, 10, 15, 30, or 60 minutes from the list that appears.

The following illustration shows the general arrangement of the Chart view. The general arrangement is the same in all languages.

In Chart view, you can select the duration of the vital trends data.

On the Vital Trends toolbar, click the Length: drop-down menu and click 10, 30, or 60 from the list that appears.

You can also choose the color and point style for each trend displayed.

**To change the point style in Chart view**

1. If you are not already in Chart view, click the **Chart** tab.
2. On the configuration pane to the left of the vital trends chart, click the style button to the right of the trend you want changed.

   The following illustration shows the general arrangement of the Point Style area. The general arrangement is the same in all languages.

3. On the shortcut menu that appears, click **Point Style**.
4. Click a point style from the list.

**To change the trend color in Chart view**

1. If you are not already in Chart view, click the Chart tab.
2. On the configuration pane to the left of the vital trends chart, click the style button to the right of the trend you want changed.
3. On the shortcut menu that appears, click Color.
4. In the Color dialog box, click a color from the Basic Colors list.
5. Click OK.

The following illustration shows the general arrangement of the Chart view. The general arrangement is the same in all languages.

To remove trends from display in Chart view, on the vital trends configuration pane, click the box to the left of the trends (arrow, below).

![Chart View Configuration Pane](image)

---

**Working with 12-lead ECGs**

The 12-lead data acquired during use of a defibrillator is automatically attached to the case along with continuous ECG. You can also attach 12-lead data that was transmitted through the Bluetooth transmission.

The 12-lead ECG and associated data appear on the 12 Lead tab, located on the ECG tab in the Case Editor. See the 12 Lead tab location in the illustration that follows.

![12 Lead Tab](image)

---

Only cases with a 12-lead ECGs attached display the 12 Lead tab.

You can also double-click a 12-lead acquisition event in the event pane to display the data on the 12 Lead tab.
The Case Editor 12 Lead tab

The following illustration shows the general arrangement of the Case Editor 12 Lead tab. The general arrangement is the same in all languages. Refer the table after the illustration for definitions.

Key to illustration numbers for the previous illustration:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The Case Editor</td>
</tr>
<tr>
<td>2</td>
<td>The 12 Lead tab</td>
</tr>
<tr>
<td>3</td>
<td>The 12-lead details, from the device recording</td>
</tr>
<tr>
<td>4</td>
<td>The 12-lead waveform</td>
</tr>
</tbody>
</table>

The 12-lead ECG appears in the middle section of the 12-Lead view. A summary section at the top of the 12-Lead view shows the following 12-lead data:

- Patient demographic information
- Global measurements (Rate, PR, QRSd, QT, QTc)
- Axes (P, QRS, T)
- ECG summary interpretations
• You can use the configuration section at the bottom of the 12 Lead tab to control the display of the 12-lead ECG and display additional 12-lead ECGs attached to the case.

You can do the following tasks on the 12 Lead tab:

• Configuring the 12-lead view on page 121
• Reviewing the 12-lead ECG on page 122

You can print 12-lead reports from the File menu or application toolbar. For more information, see Generating reports on page 151 and Working with 12-lead reports on page 156.

Configuring the 12-lead view

Use the configuration section of the 12-Lead view to control the display of the 12-lead ECG. For information on opening the 12-Lead view, see Working with 12-lead ECGs on page 119.

To select another 12-lead ECG, click the 12-lead drop-down list and click a different ECG. The selected 12-lead ECG and its associate summary information appear.

To change the time format

1. Click the Timing drop-down list to change the time format.

   The following time formats appear:

   • Simultaneous (European standard)
   • Time Sequential (United States standard)

2. Click the time format that you want.

   The 12-lead ECG appears in the selected time format.

To scale the report display

You can scale the 12-lead report from 1x, with the Scale control in the far left position, to 3x, with the Scale control in the far right position. You can also use the magnifying tool in the 12-Lead view, when the Scale control is in the 1x position. For more information, see Magnifying 12-lead ECGs on page 122.

• Complete one of the following procedures:

   • To increase the scale of the 12-lead ECG displayed, drag the Scale control to the right.
To decrease the scale of the 12-lead ECG displayed, drag the Scale control to the left.

**Reviewing the 12-lead ECG**

Use the scroll bar to move through the 12-lead ECG.

If the scale has been increased so that sections of the 12-lead ECG are outside of the current view area, drag the ECG to view the obscured sections. A location key indicates when you have reached the limit of the 12-lead ECG in any direction.

To scroll through the 12-lead ECG, drag the scroll bar to the desired location on the 12-lead ECG.

**To use the location key**

1. Click a position on the 12-lead display and hold down the mouse button.
   
   A four-arrow location key appears.

2. Drag the 12-lead ECG display up, down, or to the right or left to display any obscured sections of the 12-lead ECG.
   
   The location key indicates when you have reached the limit of the 12-lead ECG in any direction by dimming the corresponding arrow.

3. Release the mouse button.

**Magnifying 12-lead ECGs**

You can use the magnifier tool for a detailed view of the 12-lead ECG waveform.

**To use the magnifier tool**

1. Hold down **SHIFT** key and click the area on the waveform that you want to magnify.
   
   A magnified view of the waveform appears.

2. Release the **SHIFT** key and while continuing to hold the mouse button, move the pointer to another location on the waveform for closer inspection.

3. Release the mouse button.
Working with CPR data

CPR data acquired during use of a defibrillator is automatically attached to the case. The type of CPR data saved varies depending on the model of defibrillator and the accessories used during the rescue.

Q-CPR data is generated by HeartStart MRx or Heartstart FR3 defibrillators used with a HeartStart CPR meter.

zCPR data (impedance-derived CPR data) is generated by Event Review Pro for cases recorded on HeartStart HS1 and Heartstart FRx defibrillators, as well as for Heartstart FR3 defibrillators for cases where a Heartstart CPR meter was not used. zCPR data does not include compression depth or compression release information.

When a case containing CPR data is opened in Event Review Pro, the menu at the top of the software window includes the CPR sub-menu, to the right of the ECG sub-menu.

You can customize and report on both Q-CPR data and zCPR data.

For detailed information, see these topics:

- Customizing CPR episodes on page 123.
- Creating CPR exclusions on page 125.
- Removing CPR exclusions on page 126.
- Adding CPR annotations on page 127.
- Adding CPR responder annotations on page 128.

Customizing CPR episodes

You can customize the Q-CPR or zCPR reports that you create. For example, you can use commands on the shortcut menu or the CPR menu to define an episode for CPR reporting and to mark sections of the waveform to exclude from Q-CPR or zCPR reports.

Q-CPR or zCPR events appear on the Compression waveform.
For information on excluding sections of the waveform from CPR reports, see Creating CPR exclusions on page 125.

**To customize the CPR episode**

1. If necessary, click the **ECG** tab and display the ECG view.
2. Click the waveform at the point where you want the episode to begin.
3. Use one of the following methods:
   - On the **CPR** menu, click **Set Episode Start**.
   - Right-click the waveform to display the shortcut menu, click **CPR**, and click **Set Episode Start**.
     A vertical bar marks the start of the episode.
4. Click the waveform at the point where you want the episode to end.
5. Use one of the following methods:
   - On the **CPR** menu, click **Set Episode End**.
   - Right-click the waveform to display the shortcut menu, click **CPR**, and click **Set Episode End**.
     A vertical bar marks the end of the episode.

---

By default, the Q-CPR episode starts 1 second before the first compression, and ends 1 second after the last compression.

---

By default, the zCPR episode starts at the first pads on event and ends at the last pads off event.

---

For information on generating and printing Q-CPR reports, see these topics:

- [Working with Q-CPR Report Card reports](page 158).
- [Working with Q-CPR Details reports](page 167).
- [Working with Q-CPR Response Time reports](page 173).

For information on generating and printing zCPR Report Card reports, see [Working with zCPR Report Card reports](page 179).
Creating CPR exclusions

A CPR exclusion identifies the areas of the waveform that you do not want to analyze. Any data inside the exclusion area is excluded from the analysis. Use the CPR menu, the shortcut menu on the ECG tab, or shortcut keys to create CPR exclusions.

You can also convert an ECG selection to a CPR exclusion.

To create a CPR exclusion from the CPR menu or shortcut menu

1. If necessary, click the ECG tab and display the ECG view.
2. Click the waveform at the point where you want the exclusion to begin.
3. Use one of the following methods:
   • On the CPR menu, click Set Exclusion Start.
   • Right-click the waveform to display the shortcut menu, click CPR, and click Set Exclusion Start.
4. Click the waveform at the point where you want the exclusion to end.
5. Use one of the following methods:
   • On the CPR menu, click Set Exclusion End.
   • Right-click the waveform to display the shortcut menu, click CPR, and click Set Exclusion End.

A red overlay highlights the exclusion.

To create a CPR exclusion using shortcut keys

1. If necessary, click the ECG tab and display the ECG view.
2. Click the waveform where you want the exclusion to begin.
3. Hold down ALT and press the mouse button.
4. Drag the mouse to where you want the exclusion to end.
5. Release the key and mouse.

To create a CPR exclusion from an ECG selection, see Managing ECG selections on page 109.

For information on generating and printing Q-CPR reports, see these topics:
   • Working with Q-CPR Report Card reports on page 158.
Removing CPR exclusions

You can remove a single exclusion or all exclusions.

The Remove Exclusion option

To remove a CPR exclusion
1. If necessary, click the ECG tab and display the ECG view.
2. Click the exclusion to highlight it.
3. Use one of the following methods:
   - On the CPR menu, click Remove Exclusion.
   - Right-click the waveform to display the shortcut menu, click CPR, and click Remove Exclusion.

   The highlighted exclusion disappears.

To remove all CPR exclusions
1. If necessary, click the ECG tab and display the ECG view.
2. Click the waveform.
3. Use one of the following methods:
   - On the CPR menu, click Remove All Exclusions.
   - Right-click the waveform to display the shortcut menu, click CPR, and click Remove Exclusions.

   All CPR exclusions disappear.

The Discard Changes option

The CPR menu also has a Discard Changes option.

Applying this option will reset the episode to the default values and remove all exclusions.

In the case of zCPR, it will also reset the compression annotations to the default state.
For information on generating and printing Q-CPR reports, see these topics:

- Working with Q-CPR Report Card reports on page 158.
- Working with Q-CPR Details reports on page 167.
- Working with Q-CPR Response Time reports on page 173.

For information on generating and printing zCPR Report Card reports, see Working with zCPR Report Card reports on page 179.

## Adding CPR annotations

The following notes affect the calculations that appear in the Q-CPR Report Card report.

### To add CPR notes to a waveform

1. If necessary, click the ECG tab and display the ECG view.
2. Right-click the mouse to display the shortcut menu.
3. Click CPR, and then Annotations.
4. Click one of the following options to add a note, both of which appear at the sweep-bar location:
   - **Ventilation** (ventilation waveform only)
   - **PR** (Perfusing Rhythm)
   - **VF**
   - **VT**
   - **PEA**
   - **Asystole**
   - **Compression annotation** (zCPR only)

   VF, VT, PEA and Asystole are for non-perfusing rhythms

### To add notes using keyboard shortcuts

1. If necessary, click the ECG tab and display the ECG view.
2. On the Waveforms pane, expand the ventilation waveform.
3. Click the ventilation waveform at the point that you want to add the note.
4. Press the following key combination:
• Press ALT+V to add a Ventilation note. (ventilation waveform only)
• Press ALT+R to add a PR (perfusing rhythm) note.
• Press ALT+C to add a compression annotation (zCPR only).

To move a note to another location on the waveform, click the note on the waveform and drag it to another location using the mouse.

For information on generating and printing Q-CPR reports, see these topics:
• Working with Q-CPR Report Card reports on page 158.
• Working with Q-CPR Details reports on page 167.
• Working with Q-CPR Response Time reports on page 173.

For information on generating and printing zCPR Report Card reports, see Working with zCPR Report Card reports on page 179.

Adding CPR responder annotations

In order to support filtering of data by CPR responder in Q-CPR reports, you can add annotations to the compression waveform, noting responders by type and name.

The reports that allow filtering by CPR responder information:

• Q-CPR Report Card report, see Working with Q-CPR Report Card reports on page 158.
• zCPR Report Card report, see Working with zCPR Report Card reports on page 179.

In the Q-CPR Report Card report or the zCPR Report Card report, you can filter by named responder by selecting the named responder the Responder field of the report customization menu.

• Q-CPR Details report, see Working with Q-CPR Details reports on page 167.

In the Q-CPR Details report, when Split by responder is selected, the Q-CPR details will appear split by named responder, in timeline sequence.
To add annotations for CPR responders

1. If necessary, click the ECG tab and display the ECG view.
2. On the Waveforms pane, expand the Compression waveform.
3. Click the Compression waveform at the point where the a CPR responder began delivering CPR.
4. Right-click, and then click Add Note. The Note window opens.
5. In the Note window, click once in Event Name to activate the field, then click again to open the selection menu.
6. In the selection menu, under Response, click BLS EMS CPR or ALS EMS CPR. The selection appears in the Event Name field.
7. In the Name field, type a name for the responder.
8. Save the case.
9. For each additional responder, advance the timeline on the Compression waveform to the point where the next CPR responder began delivering CPR, and repeat the above process.

Using key command and mouse shortcuts

You can use the shortcuts in the table below to complete many of the operations on the ECG tab:

**Key command shortcuts**

**Audio**

**Play/Pause audio**

Click the ECG waveform, and then press SPACEBAR

**Reset audio volume to default level**

Hold down CTRL and click the Volume slider
Event list

**Expand selected event list nodes**

SHIFT + PLUS SIGN

**Collapse selected event list nodes**

SHIFT + MINUS SIGN

Q-CPR

Annotate ventilation waveform with ventilation event

ALT + V

Annotate ventilation waveform with Perfusing Rhythm

ALT + R

Annotate zComp waveform with compression annotations

ALT + C

Selections

Create an automatic selection centered on the pointer location

CTRL and click waveform

Sweep bar

Move sweep bar one minute backward

PAGE UP

Move sweep bar one minute forward

PAGE DOWN

Move sweep bar one strip backward in the WAVEFORMS pane

SHIFT + PAGE UP

Move sweep bar one strip forward in the WAVEFORMS pane

SHIFT + PAGE DOWN

Move sweep bar to beginning of recording

HOME

Move sweep bar to end of recording

END

Move sweep bar one second backward

LEFT ARROW

Move sweep bar one second forward

RIGHT ARROW
Move sweep bar to previous selection
   UP ARROW

Move sweep bar to next selection
   DOWN ARROW

Make a notation at the sweep bar, using quick note
   CTRL + N

Time scale

Time scale expand
   CTRL + PLUS SIGN (+)

Time scale compress
   CTRL + MINUS SIGN (-)

Zoom

Zoom in
   PLUS SIGN (+)

Zoom out
   MINUS SIGN (-)

Zoom in fully
   SHIFT + PLUS SIGN (+)

Zoom out fully
   SHIFT + MINUS SIGN (-)

Mouse shortcuts

Magnification

Display magnified view of waveform
   Click the waveform; then hold down SHIFT and press the mouse button.

Q-CPR exclusion

Create Q-CPR Exclusion
   Hold down ALT and drag mouse over waveform.
Time scale

Expand time scale
Press the SHIFT key and move the mouse wheel backward.

Compress time scale
Press the SHIFT key and move the mouse wheel forward.

Vertical offset

Increase vertical offset
Click the BASELINE field and move the mouse cursor up.

Decrease vertical offset
Click the BASELINE field and move the mouse cursor down.

Waveform scale

Increase vertical waveform scale
Click the RANGE field and move the mouse cursor up.

Decrease vertical waveform scale
Click the RANGE field and move the mouse cursor down.
The following topics present information about reviewing cases.

**Reviewing case events**

Use the Event Log tab to view all the defibrillator events and user notes that are associated with the ECG. The events that appear on the Timeline and ECG tabs are in the Event Log.

In the Event Log, you can do the following:

- View details for an event.
- Sort and group the defibrillator events and notes that a responder or reviewer added to the case.
- Filter events and notes to display only those that fit your selection criteria.
- Print the events for the open case. See Printing table entries on page 39.

**To display the event log**

1. On the case selection table, click a case to open it. For more information, see Displaying case details on page 61.
2. Click the Event Log tab.
   
   The table that appears is a log of events for the case in the Event Review Pro database.

**Viewing event details**

To view event details, double-click an event. The details appear on the ECG tab.
The sweep bar identifies the event. For more information, see Working with waveforms on page 97.

**Hiding and displaying events**

You can hide or display the list of events for the open case from the shortcut menu.

**To use the shortcut menu**

1. Open a case. For more information, see Displaying case details on page 61.
2. To display a list of options, use the View menu or, on the Event Log tab, right-click a row in the table.
3. Click Refresh, Expand All, or Collapse All.

**To refresh, hide, and display events**

- To refresh the list of events, on the View menu or shortcut menu, click Refresh.
- To hide event details, click Collapse - to the left of the event.
- To hide all event details, on the View menu or shortcut menu, click Collapse All.
- To display event details, click Expand + to the left of the event.
- To display all event details, on the View menu or shortcut menu, click Expand All.

**Sorting, grouping, and filtering events**

You can change the way information displays in the list of events. You can sort and group the list of events, and you can filter them so that only the events that meet the criteria you select appear.

For more information, see Working with columns on page 35, Grouping and sorting entries on page 35, Filtering entries on page 37, and Removing filters on page 39.

**Printing case events**

You can print the events for any case saved in the database.
To print a list of events for a case saved in the database

1. Click the **Reports** navigation button.
2. On the Reports navigation pane, click the Case Events report from the list of reports in the Cases group. For more information, see Working with case reports on page 155 and Working with ECG reports on page 155.

Attaching files to a case

Use the Attachments tab to attach files to the open case. For example, you can manage a text document, a .pdf file, or a graphics file.

Use the Attachments menu to attach files, open the attachments, and remove attached files from the case.

No attachment file can be larger than 10 Mb.

---

To view an attachment, you must have the associated application on your computer. For example, to open a picture, you must have an application that can open graphic files.

Displaying the Attachments tab

Use the following procedure to display the Attachments tab.

**To display the Attachments tab**

1. Open a case. For more information, see Displaying case details on page 61.
   
The Case Editor opens, to the ECG tab.
2. On the Case Editor, click the **Attachments** tab.
   
   A table of the files that are attached to the case appears. The table is blank when there are no attachments in the Event Review Pro database that are associated with the case.

Adding and removing attachments

Use the following procedures to manage the attachments that are associated with the open case.
To attach a file
1. On the Attachments menu, click Attach.
2. In the Attach File window, navigate to the file location.
3. Click Open.
   Depending on the size of the file, it can take a few seconds for the file to show in the Attachments list.

To remove an attached file
1. On the Attachments tab, click the file description in the Attachments table.
2. On the Attachments menu, click Detach.

Viewing file contents

To display the contents of an attached file
Use one of the following methods:
- On the Attachments menu or toolbar, click Open.
- Double-click the row in the Attachments table.
  The attachment opens in the associated application.

Printing the attachments in an open case

You can print the contents of the files attached to an open case when you have the associated application installed on your computer. Open the attachment in this associated application and print using its features.

⚠️ You might not be able to print all attachments, such as a video clip.

You can also print the list of attachments as they appear on the Attachments tab.

To print the list of attached files
1. On the File menu or toolbar, click Print.
2. On the Print menu, click Table.
3. In the Print window, click the printer, page range, and number of copies.
4. Click Print or OK.

**Completing a final case review**

After the case is reviewed, you can add reviewer notes under the Final Review tab. However, at any time during the case, you can update this information, or add more.

This screen can contain up to two pages' worth of information. You can also copy and paste information from other applications and retain the character formatting (such as bold or italic).

**To perform a final review**

1. Click the Final Review tab.
2. Place the cursor in the Reviewer Notes pane.
3. Do any of the following:
   - Type your information.
   - Copy from another application such as a Microsoft Word document and paste the information into the Review pane.
4. In the Reviewer Name field, type your name.
5. In the Review Date field, type the date.
6. Check the Case Reviewed box.
7. Do either of the following:
   - On the toolbar, click Save.
   - Exit the Review Notes pane. When the application asks if you want to save the information, click OK.

For cases with the Case Reviewed box selected, the Reviewed column in the Patient Cases table displays a Yes. Sorting the Patient Cases table by the Reviewed column is a method to quickly see which cases have been reviewed. For information about sorting cases, see Sorting and grouping cases on page 62.
Using the Import Service

Use the Import Service on the Administration navigation pane to import cases into the Event Review Pro database automatically. The case data can come from several sources:

- Case files exported by other users of Event Review/Event Review Pro or Data Messenger
- Cases exported by third-party ePCR software
- From the MRx via batch LAN data transfer (BLDT)
- Via HTTP, using Data Messenger

See Configuring the Import Service on page 141 for information on your configuration options.

When the Import Service detects that there is a case file with the correct extension, it automatically creates a case using the patient demographic information and the ECG from the case file.

Event Review Pro saves the case to the database and lists it on the case selection table. The Import Service moves the file to the archive folder in the inbox folder.

To make any changes to the Import Service, you must run Event Review Pro as an administrator.

To manage inbox folders, see Managing Import Service inboxes on page 139.

To manage the working folder for HTTP transfer, see Using the HTTP Import Service on page 143.

To filter the device data, so that the only data imported is of certain case types, see Managing Import Service inboxes on page 139.

To specify how long to keep the content in archive folders before it is purged, see Managing Import Service inboxes on page 139.
If the imported case contains a duplicate ECG, the case appears on the Duplicated ECGs table. For more information, see Reviewing cases with duplicate ECGs on page 73.

For information on how to monitor system usage, see Working with the System Log on page 145.

If you want to configure and run an Import Service on another machine that does not have Event Review Pro installed on it, see the Server Pack documentation in the Implementation guide.

Case files that are password-protected cannot be imported with the Import Service.

### Managing Import Service inboxes

Use the Import Service workspace to add (up to 100), view, and remove inboxes.

If the Import Service is running when you add or delete inboxes, it detects the change and updates the folders that are monitored. You do not need to restart the Event Review Pro 5.0 Import Service.

If Import Service is not running when you add or delete inboxes, the changes become effective the next time that Import Service runs.

To make any changes to the Import Service, you must run Event Review Pro as an administrator.

You can also filter the device data that is imported so that it includes only certain case types (the default is to import all data).

By default, the content in archive folders is retained for 7 days. However, you can decide how long to keep this data and purge the folders after a designated number of days. For more information, see Managing Import Service archives on page 142.

#### To view the Import Service inboxes

1. On the navigation pane, click the Administration navigation button.
2. On the Administration navigation pane, click Import Service.

#### To add an inbox

1. Display the Import Service workspace.
2. In the area below the Inbox folder box, click **Add**.
   The Browse for Folder window opens.

3. Use one of the following methods:
   - Navigate to an existing folder.
     **Note:** Not all networked folders can be found by browsing. In this case, type in the full path name of the folder.
   - Navigate to the location for the new folder, click **Make New Folder**, and type a name for the folder.
     Make sure that the Import Service has read/write permission for this folder.

4. Click **OK**.
   The path to the folder in the Inbox folder area now appears.

5. Click **Save**.
   The action is complete.

HeartStart MRx monitors that use batch LAN data transfer use the directory that is configured by the FTP service. This directory must be designated as an inbox folder for it to import automatically to Event Review Pro.

---

**To remove inbox folders**

1. Display the Import Service workspace.
2. In the list of inbox folders, click the one you want to remove and click **Remove**.
   The folder no longer appears in the list.

**To filter the device data that is imported**

1. Display the Import Service workspace.
2. In the Import Service Filters area, click the **Import Device Data that Includes Any of the Following** button, and then check as many of the boxes below as you want.
   Device data that does not include any of the checked items will be excluded from import.
Configuring the Import Service

The default installation does not set up the Import Service to start automatically. If you need to import cases automatically, you must set up the Import Service from Windows.

To set up the Import Service from Windows
1. Complete the typical Event Review Pro installation.
2. Navigate to the Windows Control Panel.
3. Click Administrative Tools.
5. Scroll to the Event Review Pro 5.0 Import Service and double-click it to open it.
   The Event Review Pro 5.0 Import Service Properties window appears.
6. If you want the Import Service to run automatically when the computer starts, under the General tab, change the notation in the Startup Type column to Automatic and click Apply.
7. If you are using HTTP: Click the Log On tab and, under Log On As, click This Account. Type a named administrator and password in the appropriate boxes, and click Apply.
8. Click the General tab, click Start, and click OK.

To start the Import Service manually
1. Navigate to the Windows Control Panel.
2. Click Administrative Tools.
4. Right-click Event Review Pro 5.0 Import Service.
5. Click Start.

The System Log lists any Import Service activity. For more information, see Working with the System Log on page 145.

If the Import Service can't connect, it will write the error(s) to the Event Viewer (under Windows Logs / Applications).
The Import Service pauses for three minutes at the time of startup. After processing all inboxes, the Import Service then pauses for one minute before checking for new files. Processed files are moved to archive files, which are stored in one of four possible directories:

- Cases successfully imported: Archive/YYYYMMDD/Imported
- Cases partially transmitted: Archive/YYYYMMDD/Incomplete Transmission
- Cases not imported because of filters: Archive/YYYYMMDD/Not Imported
- Cases not supported, or corrupted: Archive/YYYYMMDD/Error

All four types are deleted when the purge days have been exceeded (if the purge limit is set).

## Managing Import Service archives

After a file is imported successfully to the database, Import Service moves the file to archive files, which are stored in one of four possible directories:

- Case types successfully imported: Archive/YYYYMMDD/Imported
- Case types partially transmitted: Archive/YYYYMMDD/Incomplete Transmission
- Case types not imported because of filters: Archive/YYYYMMDD/Not Imported
- Case types not supported, or corrupted: Archive/YYYYMMDD/Error

To make any changes to the Import Service, you must run Event Review Pro as an administrator.

You can purge these folders automatically after a designated number of days—between 1 and 31 days. All four types are deleted when the purge days have been exceeded (if the purge limit is set).

### To purge archive folders

1. Display the Import Service workspace.

2. Below the Inbox Folders area, check the Purge Archive Folders After box and type the number of days in the box following. You can choose any number between 1 and 31.
All archive folders will be purged that number of days after the contents are created.

**Using the HTTP Import Service**

The Import Service, working in conjunction with HeartStart Data Messenger, supports the import of case data using HTTP. After you set up HTTP, you can transfer case data from Data Messenger.

For more information, see the *HeartStart Data Management implementation guide*.

---

To make any changes to the Import Service, you must run Event Review Pro as an administrator.

When you use HTTP, you must set a special type of inbox folder, called a working folder; you can have only one working folder. Use the Import Service workspace to set, change, or clear the working folder.

For the Import Service to work properly with HTTP, you must run it under a named administrator (not the default local service). See *Configuring the Import Service* on page 141.

---

If you are importing from Data Messenger, you must open a TCP port in the Windows firewall on the computer that is running Import Service, and this port must correspond to the port used by Data Messenger. By default, this is port 7080.

---

**To enable the HTTP import service and set the working folder**

1. Display the Import Service workspace. For more information, see *Managing Import Service inboxes* on page 139.

2. In the HTTP Import Working Folder area, click Set.
   
The Browse for Folder window opens. In the Browse for Folder window, navigate to a folder. Make sure that the Import Service has read/write permission for this folder.

3. Click OK.
   
The path to the folder in the HTTP Import Service area appears.

4. Click Save.
   
The action is complete.
To change the working folder

1. Display the Import Service workspace. For more information, see Managing Import Service inboxes on page 139.
2. In the HTTP Import Working Folder area, click Set.
3. Use one of the following methods to change the working folder:
   - Navigate to a different existing working folder.
   - Navigate to the location for the new folder, click Make New Folder, and type a name for the folder.
     Make sure that the Import Service has read/write permission for this folder.
4. Click OK.
   The path to the folder in the HTTP Import Service area appears.
5. Click Save.
   The action is complete.

If you change the working folder while files are still waiting in the previous working folder to be imported, those files will not be imported.

To disable the HTTP Import Service and clear the working folder

1. Display the Import Service workspace. For more information, see Managing Import Service inboxes on page 139.
2. In the HTTP Import Working Folder area, click Clear.
   The path to the folder in the HTTP Import Service area disappears.
3. Click Save.
   The action is complete.

If you disable the import service while files are still in the working folder waiting to be imported, those files will not be imported.
Working with the System Log

You can view the System Log to see the status of all Event Review Pro activity. You can sort, group, and filter the list of entries. A filter shows only those entries that meet the criteria you select.

This section provides an overview of how to use the system log.

You can change the default layout of the System Log. This change persists the next time you use the navigation pane or workspace. For more information, see Resizing panes and workspaces on page 41.

To display the system log

1. On the navigation pane, click the Administration navigation button.
2. On the Administration navigation pane, click System Log.

The system log appears.

The System Log lists Event Review Pro activity. For each action, the following information is included:

- The type of activity, for example, Information or Error
- A description of the action
- The date and time when the action occurred
- The user logon name

If a customer support representative asks you to send the System Log, on the Help menu, click Email with System Log, and send the email message that appears. The System Log is attached to it by default.

The software retains the last 10,000 system log entries.

For information about working with the log entries, see:

- Working with columns on page 35
- Grouping and sorting entries on page 35
- Filtering entries on page 37
• Removing filters on page 39
• Printing table entries on page 39
Working with reports

Use reports to evaluate the timeliness of, effectiveness of, and trends in your emergency system response. You can generate a report for an open case or directly from the database.

Event Review Pro generates reports from case information.

If you import a redacted case, in any report that includes that case, the redacted case appears with a series of asterisks in the patient name fields, and the patient ID is replaced by a series of letters and numbers, unique to each patient ID. If the redacted age of the patient is greater than 90, the Date of Birth field is blank and the Age field displays 90.

Report type availability is based on your installation. The following categories of report types are available (though not all cases include data for all reports):

<table>
<thead>
<tr>
<th>Report category</th>
<th>Based on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case</td>
<td>Information that appear on various tabs in the Case Editor</td>
</tr>
<tr>
<td>ECG</td>
<td>ECG and other waveforms that appear on the ECG tab in the Case Editor</td>
</tr>
<tr>
<td>12-lead</td>
<td>12-lead waveforms that appear on the 12 Lead tab in the Case Editor</td>
</tr>
<tr>
<td>CPR</td>
<td>Quality of CPR information</td>
</tr>
<tr>
<td>Report category</td>
<td>Based on</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>page 167.</td>
</tr>
<tr>
<td></td>
<td>See Working with Q-CPR Report Card reports on page 158.</td>
</tr>
<tr>
<td></td>
<td>See Working with Q-CPR Response Time reports on page 173.</td>
</tr>
<tr>
<td></td>
<td>See Working with zCPR Report Card reports on page 179.</td>
</tr>
<tr>
<td></td>
<td>Selecting CPR Guidelines for reporting on page 150.</td>
</tr>
<tr>
<td>Vital Trends</td>
<td>Vital trends information that appears on the ECG tab in the Case Editor</td>
</tr>
<tr>
<td></td>
<td>See Working with Vital Trends reports on page 183.</td>
</tr>
<tr>
<td>(EMS Edition only)</td>
<td>Emergency response times</td>
</tr>
<tr>
<td>(EMS Edition only)</td>
<td>See Working with Response Times reports on page 183.</td>
</tr>
<tr>
<td>Utstein</td>
<td>Utstein guidelines for reporting on aggregated out-of-hospital cardiac arrests</td>
</tr>
<tr>
<td></td>
<td>See Working with Utstein reports on page 186.</td>
</tr>
<tr>
<td>Self-Test</td>
<td>Device self-test history</td>
</tr>
<tr>
<td></td>
<td>See Working with Device Self-test History reports on page 187.</td>
</tr>
</tbody>
</table>

**Selecting cases for reports**

The Reports workspace provides a list of available report types, and the Select Cases area, where you can filter the cases you want to report on by date and by content.

The Select Cases area appears when you select a report type. The logical options for the chosen report type are preselected. For example, if the 12-Lead report type is chosen, then, in Select Case, the ECG and 12-Lead options are preselected.
Filter your case selection by defining the date range for the reports you want to include. Date selections are at the top of Select Cases.

Date refers to the case date, usually the device-on date, not the date a case was imported.

Two methods are available for specifying dates:

- **From the last (1-365) days**
  This date is calculated from today's date, and saved across sessions, for the specific report type.

- **From (dd/mm/yyyy) To (dd/mm/yyyy)**
  Enter the earlier date in the From field.
  This date range is saved for the current session, for the specific report type.

More filtering options are grouped under **With** and **And Have**. Use them to further define the list of cases to include in your report.

Use the selection menus, text fields, or check boxes adjacent to each item to select the filters you want to add.

Some of the Device Data properties are preselected based on the report type selected from the Reports navigation pane. For example, if 12-Lead is selected in the Reports navigation pane, the checkbox "12-Lead" is preselected, and cannot be edited.

**To start the search and display matching cases**

1. When the selection criteria are set, click **Select** to retrieve the cases.

   Cases matching the selection criteria appear in the table at the bottom of the work area.

   **Note:** You can print the table by right-clicking in the table and clicking **Print Table**.

   You can also export the table with all columns by right-clicking the table and then clicking **Export to Excel**. This creates a Microsoft Excel file in XLSX format.

For information about generating reports once the cases are selected, see [Generating a report using the Reports workspace on page 152](#).
Selecting CPR Guidelines for reporting

By default, the CPR guidelines used for reporting are the CPR guidelines that were used by the defibrillator during an incident.

The Q-CPR and zCPR reports include a selection menu for Guidelines. The menu default is Device Guidelines. You may select different guidelines. The guidelines you select will be used to calculate the results displayed in the report.

Guideline options include:

- Device Guidelines
- AHA 2005
- AHA 2010
- AHA 2015
- ERC 2005
- ERC 2010
- ERC 2015

There are options available for custom guidelines. If custom guidelines are configured, they appear at the bottom of the Guidelines menu.

Custom CPR Guidelines

You can use the Administration workspace to create custom CPR guidelines and save them for selection from the Guidelines menu of the Q-CPR or zCPR reports.

In order to create custom CPR guidelines, you must be a member of the Administrators group, or, when starting Event Review Pro, right-click Run as administrator.

Configure custom CPR Guidelines in the Administration workspace. See Using the Administration workspace on page 25.

To configure a custom CPR Guideline
1. From the Navigation pane, click Administration to open the Administration workspace.
2. In the Administration workspace menu, under User CPR Guidelines, click Create New Guidelines.

   A CPR Guidelines setup space opens on the right.

3. In the Title field, enter a name for your custom CPR Guideline.

4. In the Description field, enter your description.

5. Under Depth, adjust the slider to set an upper and lower limit for CPR depth.

6. Under Rate, adjust the slider to set an upper and lower limit for CPR rate.

7. Click Save to save your custom CPR Guideline.

   Your guideline is saved by name at the bottom of the User CPR Guidelines list on the Administration workspace menu.

To delete a custom CPR Guideline

1. From the Navigation pane, click Administration to open the Administration workspace.

2. In the Administration workspace menu, under User CPR Guidelines, right-click the name of the custom CPR Guideline you want to delete.

3. Click Delete from the pop-up menu.

   The custom CPR Guideline is deleted.

**Generating reports**

There are two approaches to generating a report; selecting a case and then choosing a report type, or selecting a report type and then choosing a case. The procedure is different for each approach.

- To select a case and then choose a report type, see Generating a report for an open case on page 151.

- To select a report type and then choose a case, see Generating a report using the Reports workspace on page 152.

**Generating a report for an open case**

You can generate a report for an open case.
To generate a report for an open case

1. Open a case. For more information, see Displaying case details on page 61.

2. On the File menu or toolbar, click Print, and then click Report, and select a report type.
   
   The report opens in the Report Preview window.

Use the tools in Report Preview to customize the report settings, and to view, print, or export the report. See Working in Report Preview on page 153.

Generating a report using the Reports workspace

Use the Reports workspace to choose a report type, search the database for available cases, and then generate a report.

To open the Reports workspace, click the Reports navigation button. A selection list of the available report types appears on the Reports navigation pane.

To generate a report from the database

1. From the Reports navigation pane, select a report type.
   
   Follow the instructions for selecting a case or cases in Selecting cases for reports on page 148.

2. After setting up your case selection search in the Select Cases area, click Select.
   
   The application locates the required case or cases.

   - For single-case report types, a list of matching cases in the database opens at the bottom of the Reports workspace.
     
     When this happens, double-click the case row to open the report in the Report Preview window.

   - For aggregate report types, when you click Select, the report opens in the Report Preview window.

Use the tools in Report Preview to customize the report settings, and to view, print, or export the report. See Working in Report Preview on page 153.
Working in Report Preview

The Report Preview window opens when a report is generated.

User-configurable settings, specific to each report type, are located on the customization tab of the Report Preview window. For reports with user-configurable options, in the customization tab area, choose the parameters to customize the report. The report regenerates with the settings.

Customized settings persist for a report type. For example, when you open an ECG pre- and post-shock report, you can choose to display a grid, or hide it. Your custom settings are re-applied the next time you open an ECG pre- and post-shock report. At that time, you can keep the settings, or change them.

All the tools for viewing, printing or exporting a report are available on the toolbar of the Report Preview window.

To view a report that has multiple pages, click the first/previous/next/last page icons in the Navigation section.

To find specific text in the report, click **Find**, type a string to search for, specify any search options, and click **Find Next**.

Click one of the print options to print the report being previewed:

- Click **Print** to select a printer, number of copies, and other printing options. When you have made these specifications, click **Print**.
- Click **Quick Print** to send the report directly to the default printer without making changes.

Click **Export to** to export a report to a file. A window appears allowing you to specify details.

The following table explains the function of each toolbar icon:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Click <strong>Print</strong> or press <code>CTRL+P</code> to select a printer, number of copies, or other printing options before printing.</td>
</tr>
<tr>
<td><img src="image" alt="Quick Print" /></td>
<td>Click <strong>Quick Print</strong> to send the document directly to the default printer without making changes.</td>
</tr>
<tr>
<td><img src="image" alt="First Page" /></td>
<td>Click <strong>First Page</strong> or press <code>CTRL+HOME</code> to navigate to the first page of the document.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Previous Page" /></td>
<td>Click <strong>Previous Page</strong> or press PAGEUP to navigate to the previous page of the document.</td>
</tr>
<tr>
<td><img src="image" alt="Next Page" /></td>
<td>Click <strong>Next Page</strong> or press PAGEDOWN to navigate to the next page of the document.</td>
</tr>
<tr>
<td><img src="image" alt="Last Page" /></td>
<td>Click <strong>Last Page</strong> or press CTRL+END to navigate to the last page of the document.</td>
</tr>
<tr>
<td><img src="image" alt="Many Pages" /></td>
<td>Click <strong>Many Pages</strong> to select the page layout and to arrange the document pages in preview.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Out" /></td>
<td>Click <strong>Zoom Out</strong> to see more of the page at a reduced size.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom" /></td>
<td>Click <strong>Zoom</strong> to change the zoom level of the document preview.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom In" /></td>
<td>Click <strong>Zoom In</strong> to get a close-up view of the document.</td>
</tr>
<tr>
<td><img src="image" alt="Export To" /></td>
<td>Click <strong>Export To</strong> to export the document in PDF format, and save it to a file on a disk. A window to specify parameter settings for the export file appears.</td>
</tr>
</tbody>
</table>

**Printing reports**

Use Print or Quick Print on the Report Preview toolbar to print a report.

See [Working in Report Preview](#) on page 153.

**Exporting reports**

If you frequently review a report or want to track your system’s performance, generate the report, and then use the Export tool to save the report as a file.

On the Report Preview toolbar, use **Export to PDF** to export a report to a file.

See [Working in Report Preview](#) on page 153.
Working with case reports

Case reports include detailed case information based on the information collected on the tabs in the Case Editor.

You can generate the reports in the Cases category when a case is open. For information on how to generate a report, see Generating reports on page 151.

The Case report

The Case report, also called the Case details report, shows information from tabs in the Case Editor. You can choose to append all the available report types for that case into one report, rather than printing each one separately. To do so, in Report Preview, on the Case Customization tab, check all the report types that you want to include. Then, on the tab for each of these report types, select the parameter settings you want to include in the Case report.

The Case events report

The Case events report lists events from the Event log in the Case Editor. In Report Preview, on the Case Customization tab, you can choose to hide or show event parameters.

For more information, see the following topics:

- Working in Report Preview on page 153
- Printing reports on page 154
- Exporting reports on page 154

Working with ECG reports

ECG reports are based on the ECG strip on the ECG tab in Cases.

For information on how to generate a report, see Working with reports on page 147.

You can choose which waveforms are visible. The Rhythm strip is shown with a red grid. Other waveforms are shown with a blue grid.

ECG Full Disclosure

The ECG Full Disclosure report includes the entire ECG.
The report uses the following parameter settings:

- Change the scale of the waveform
- Display grid
- Events
- Notes
- Beat labels
- Selected waveforms
- Overlay waveforms
- Scale
- Elapsed time/Clock time
- Orientation (Portrait or Landscape)

Dashes in the report indicate periods during the report when there is no waveform data.

**Pre- and Post-shock**

The Pre- and Post-shock report documents the ECG segments surrounding each shock event.

The report uses the following parameter settings:

- Change the scale of the waveform
- Grid
- Events
- Notes
- Beat labels
- Selected waveforms
- Presenting seconds
- Closing seconds
- Preshock seconds
- Postshock seconds

**Working with 12-lead reports**

12-lead reports are based on 12-lead ECG recordings in a case, if present.
View 12-leads on the 12 Lead tab in the Case Editor. For information on viewing 12-leads, see Working with 12-lead ECGs on page 119.

You can print 12-lead reports from the File menu or application toolbar. For more information, see Generating reports on page 151. When the print preview of the report is open, the parameter settings appear at the top of the preview.

In the 12-lead report you can choose from the following parameter settings:

**Demographics**

Select one of the following:

- **Original** The default selection, the report shows the patient information recorded by the device.

- **Override report with case information** Patient information entered on the Overview tab in the Case Editor is shown in the report, in place of patient information recorded by the device. This setting could be helpful in correcting a patient name, for example. The change appears only in the report. The information recorded by the device is not altered.

- **Redact patient information** Patient information recorded by the device is not shown in the report. Reference ID, if entered, is not redacted. The change appears only in the report. The information recorded by the device is not altered.

**Timing**

Select one of the following ECG display methods:

- **Simultaneous** The default selection

- **Time Sequential**

**Display Grid**

Check this box to add a grid behind the ECG waveforms. The grid is visible in the on-screen preview and when printed.
Working with Q-CPR Report Card reports

The Q-CPR Report Card report is based on the quality of the CPR that a patient received during the episode.

Customizing the Q-CPR Report Card report

Once selected, the following settings, except Responder, persist when the application is reopened.

- **Guidelines** In the Guidelines menu you can select the CPR Guidelines used to generate the report. The default is Device Guidelines, the CPR guidelines that were used by the defibrillator during the incident.

  Other available guideline options are AHA 2005, 2010, or 2015, ERC 2005, 2010, or 2015, or Custom (if configured). Up to 15 custom guidelines can be saved. Custom CPR Guidelines are set in the Administration workspace. For details, see Selecting CPR Guidelines for reporting on page 150.

- **Depth** You can select the compression depth units, inches or millimeters. You can toggle between inches and millimeters. The default setting is inches.

- **Responder** You can filter results by responder (limit the results to CPR performed by a specific responder) by selecting a CPR responder from this menu. The default is All, and the report displays statistics for the entire episode, including all responders. You can filter by responder if responders are annotated.

  In order to filter by responder, you need to annotate the compression waveform with responder type, and enter the responder name in the name field. For details, see Adding CPR responder annotations on page 128.

- **Ignore episode markers** Check this option if you want to ignore the episode markers and report on the entire recording from device on to device off.

  When this option is unchecked, the episode start and end times are set to one second prior to the first compression event, and one second after the last compression event. The user can manually adjust the episode start and end times from the ECG viewer.
By default, this option is unchecked (do not ignore).

- **Split by intubation** You can choose whether to split the intervals by intubation events. By default this is checked (split).
- **Display/Hide report sections** You can choose whether to show parts of the report.
  - Toggle to show or hide Q-CPR tabular details. By default this is checked (show).
  - Toggle to show or hide ventilation data. By default this is checked (show).
  - Toggle to show or hide compression strips. By default this is checked (show).

### Information in the report

The report contains information about the quality (rate and depth) of CPR in the episode.

The report information is presented in these pages:

- [Information in the Q-CPR Report Card chart on page 159.](#)
- [Information in the Q-CPR Report Card details on page 163.](#)
- [Information in the Q-CPR Report Card compression strips on page 166](#)

### Information in the Q-CPR Report Card chart

The following illustration shows the general arrangement of the Q-CPR Report Card chart page. The general arrangement is the same in all languages. Refer to the table after the illustration for definitions.
Key to illustration numbers for the previous illustration:

1. **CPR guideline parameters**  This field shows the CPR guideline depth and rate targets used to calculate the CPR quality shown in the report. When no upper target is specified, only the lower target is shown.

   **Note that when Guidelines other than Device are selected, this field appears highlighted in yellow.**

2. **30-Second Interval Statistics**  All the statistics in this box are calculated based on 30-second intervals.

3. **Compression Quality**  The charts in this box show the overall compression quality for all intervals in the episode. For the overall compression quality chart, the compression depth quality chart, and the compression rate quality chart, the labels in each slice show the percentage of intervals in each category. The color legend below the charts shows the actual number of intervals in each category.
4  **Compression Depth Quality gauge**  This gauge shows the average compression depth over the entire episode. The segment colors correspond to the colors of the chart below. The marker beneath the gauge is green if the average depth is in the target zone, red if below the target zone, and yellow if above the target zone. The label shows the actual average depth value, as well as the lower and upper (if applicable) targets.

5  **Compression Depth Quality chart**  This chart shows the compression depth quality for all intervals in the episode. Intervals with an average compression depth greater than or equal to the lower target and less than or equal to the upper target (if applicable) are depicted in the green slice. Intervals with an average compression depth less than the lower target are depicted in the red slice. Intervals with an average compression depth greater than the upper target (if applicable) are depicted in the yellow slice.

6  **Compression Rate Quality gauge**  This gauge shows the average compression rate over the entire episode. The segment colors correspond to the colors of the chart below. The marker beneath the gauge is green if the average rate is within the target zone, red if below the target zone, and yellow if above the target zone. The label shows the actual average rate value, as well as the lower and upper (if applicable) targets.

7  **Compression Rate Quality chart**  This chart shows the compression rate quality for all intervals in the episode. Intervals with a compression rate greater than or equal to the lower target and less than or equal to the upper target (if applicable) are depicted in the green slice. Intervals with a compression rate less than the lower target are depicted in the red slice. Intervals with a compression rate greater than the upper target (if applicable) are depicted in the yellow slice.

8  **Compression Release Quality chart**  This chart shows the percentage of compressions with complete release versus incomplete release (leaning) for the episode. The legend shows the actual number of compressions with complete and incomplete releases.

9  **Hands-On/Hands-Off Time chart**  This chart shows the amount of hands-on versus hands-off time for the episode. Green represents hands-on time, and red represents hands-off time. The slice labels show hands-on and hands-off time as percentages of the entire episode time. The legend shows the actual amount of hands-on and hands-off time in hours, minutes and seconds.

10  **Q-CPR Episode Summary**  This section contains a summary of the episode. This information is duplicated on the details page.
| 11 | **Responder**  This field shows the CPR responder by name. The selection is made in the Responder menu on the Q-CPR Customization area in the report. When All is selected in the Responder menu (the default selection), an empty string appears in this field. |
Information in the Q-CPR Report Card details

The following illustration shows the general arrangement of the Q-CPR Report Card details page. The general arrangement is the same in all languages. Refer to the table after the illustration for definitions.

Key to illustration numbers for the previous illustration:

1. **Q-CPR Episode Summary**
   - **Episode start time**: The episode start time defaults to 1 second prior to the first compression event. The user can adjust the episode start time from the ECG tab in the Event Review Pro Case Editor.
   
   - **Total length of episode**: Total time from episode start to episode end. The episode end time defaults to 1 second after the last compression event. The user can adjust the end time from the ECG tab in the Event Review Pro Case Editor. In addition, the user can ignore the episode markers and make the episode correspond to the entire recording from device on to device off.
   
   - **Episode shocks/total shocks**: Shows both the total number of shocks that lie between episode start and episode end and the total number of shocks in the recording.
   
   - **Time device on**: Device-on time as recorded by the device.
   
   - **Time device off**: Device-off time as recorded by the device.
   
   - **Total time excluded from statistical calculations**: Total time of all exclusion periods. The user can add and adjust exclusion periods using the ECG tab in the Event Review Pro Case Editor.
<table>
<thead>
<tr>
<th>2</th>
<th><strong>Compression Data</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Total number of compressions</strong>: Total number of compressions in the entire episode.</td>
<td></td>
</tr>
<tr>
<td><strong>Total compressions with in-target depth</strong>: Total number of compressions in the entire episode, where the depth was greater than or equal to the lower target and less than or equal to the upper target.</td>
<td></td>
</tr>
<tr>
<td><strong>Total compressions with insufficient depth</strong>: Total number of compressions in the entire episode, where the depth was less than the lower target.</td>
<td></td>
</tr>
<tr>
<td><strong>Total compressions with incomplete release</strong>: Total number of compressions in the entire episode, where there was an incomplete release (leaning).</td>
<td></td>
</tr>
<tr>
<td><strong>Compressions with complete release [percentage]</strong>: Percentage of compressions with complete release in the entire episode.</td>
<td></td>
</tr>
<tr>
<td><strong>Average compression rate [/min] [xx-yy]</strong>: Average compression rate of the entire episode, where xx is the lower rate target and yy is the upper rate target.</td>
<td></td>
</tr>
<tr>
<td><strong>Average depth [xx u to yy u] or [at least xx u]</strong>: Average compression depth over the entire episode, where xx is the lower target, u is the units (inches or mm), and yy is the upper target.</td>
<td></td>
</tr>
<tr>
<td><strong>In-target depth [percentage]</strong>: Percentage of compressions over the entire episode, where the depth was greater than or equal to the lower target and less than or equal to the upper target.</td>
<td></td>
</tr>
<tr>
<td><strong>Average compression counts [/min]</strong>: Average number of compression events per minute over the entire episode.</td>
<td></td>
</tr>
</tbody>
</table>
### Flow/Hands On Time

- **Flow time [percentage]**: Flow time as percentage of the entire episode. Flow time represents blood-flow time which includes the hands-on time, and the perfusion time during hands-off time as annotated by the user.

  NOTE: Flow time is calculated from the time a PR annotation is made to the time any non-perfusion annotation is made.

- **Hands-on time [percentage]**: Hands-on time as percentage of the entire episode. Hands on time is the time with active chest compression.

- **Average no-flow time before shock[s]**: Average no-flow time before each shock in the episode.

- **Average no-flow time after shock[s]**: Average no-flow time after each shock in the episode.

- **No-flow time**: No-flow time in hours, minutes, and seconds over the entire episode. No-flow time is time between compressions where no perfusion is recorded. The user can identify perfusion by annotating the ECG with PR (perfusing rhythm) annotations.

- **Hands-off time**: Hands-off time in hours, minutes, and seconds over the entire episode.

### Ventilation Data

- **Total number of ventilations**: Total number of ventilations in the entire episode.

- **Total time before intubation**: Total time in hours, minutes, seconds before intubation.

- **Total time after intubation**: Total time in hours, minutes, seconds after intubation.

- **Average ventilation rate before intubation [/min]**: Average ventilations per minute before intubation.

- **Average ventilation rate after intubation [/min]**: Average ventilations per minute after intubation.
Defibrillation data

- **Time from power-on to first shock**: Time in hours, minutes, and seconds from device power-on to the first shock.

- **Total analysis and shock-delivery time**: Total time in hours, minutes, and seconds, where the device is either in analysis mode or delivering a shock (AED devices only).

- **Average analysis and shock delivery time**: Average analysis and shock delivery time in hours, minutes, and seconds for all episode shocks (AED devices only).

Information in the Q-CPR Report Card compression strips

The following illustration shows the general arrangement of the Q-CPR Report Card Compression strips page. The general arrangement is the same in all languages. Refer to the table after the illustration for definitions.

Key to illustration numbers for the previous illustration:
Rate Quality Band: This band contains rate markers that show the average rate for each 30 second segment. The target rate is shown with a shaded strip: green = in-target, red = below target, yellow = above target. The band range is between 30 and 150 cpm so that the target range can be distinguished. Rates below 30 cpm are not visible (but will be shaded red).

CPR Quality Band: The CPR quality band shows the overall quality for each 30 second segment. The segments are color coded: red = depth and rate out of target, green = depth and rate in target, yellow = depth in target, depth out of target, orange = depth in target, rate out of target.

Depth Quality Band: This band contains the compression waveform. The target depth is shown with a shaded strip: green = in-target, red = below target, yellow = above target.

Rate Bar: The height of each line connected to the marker represents the rate. Ideally the end of the line should be within the shaded area.

30 Second Interval: The bands are comprised of 30 second intervals. Each interval is marked with a white vertical line.

Incomplete Release Marker: Compressions with incomplete release are marked by a red down-arrow with a bar across the top.

Responder Switch Annotation: Each responder CPR annotation is marked with an icon with the name of the responder.

Key to symbols and color codes

Working with Q-CPR Details reports

You can see details about Q-CPR data for a single episode in the Q-CPR Details report. To see what data is included in this report, see Q-CPR Details report data on page 169.

If you want to export the Q-CPR Details report data to a spreadsheet, select the Q-CPR Details Tabular Export report. You can compile details for multiple cases and display them with the results.

In Report Preview, use the settings at the top of the preview to customize the way the data is presented in the report. See Working in Report Preview on page 153.

Customizing the Q-CPR Details report

Once selected, the following settings persist when the application is reopened.
• **Guidelines** In the Guidelines menu you can select the CPR guidelines used to generate the report. By default, the report uses the CPR guidelines that were used by the defibrillator during the incident, Device Guidelines.

The available options are AHA 2005, 2010, or 2015, ERC 2005, 2010, or 2015, or Custom (if configured). Up to 15 custom guidelines can be saved. Custom CPR Guidelines are set in the Administration workspace. For details, see Selecting CPR Guidelines for reporting on page 150.

• **Depth** You can select the compression depth units, inches or millimeters. The default setting is inches. You can toggle from inches to millimeters.

• **Split by responder** By default, the option is unchecked: the report will display statistics on the entire episode for all CPR responders in a single block. You can choose to split the results by responder.

  Before you can split by responder, you need to annotate the compression waveform (right-click the waveform and then click **Add Note**), and add a name in the responder name field. For details, see Adding CPR responder annotations on page 128.

• **Ignore episode markers** By default, this is unchecked. Check this option if you want to ignore the episode markers and report on the entire recording from device on to device off (default is unchecked). The episode start and end times default to one second prior to the first compression event and one second after the last compression event respectively. The user can manually adjust the episode start and end times from the ECG viewer.

• **Split by intubation** You can choose whether to split the intervals by intubation events. By default this is checked.

• **Intervals** You can select the interval used to calculate statistics. Click either **No intervals**, **30 second intervals**, or **60-second intervals**.

**Information in the report**

The report contains detailed information about CPR in tabular form.

See Q-CPR Details report data on page 169.
Q-CPR Details report data

This section provides a description of the Q-CPR data that appear in the Q-CPR Details report.

You can create a Q-CPR Details Tabular Export report that includes data from multiple cases, with the results separated by case. This data can be exported to a Microsoft® Excel spreadsheet.

Q-CPR statistics section

<table>
<thead>
<tr>
<th>Statistic label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The time period for the data: Episode, Period, or Interval.</td>
</tr>
<tr>
<td>Start</td>
<td>The start time of the statistics coverage, in milliseconds from the start of the first compression event.</td>
</tr>
<tr>
<td>Length</td>
<td>The length of the statistics covered time (up to one second after the last compression event), in milliseconds.</td>
</tr>
<tr>
<td>NFT</td>
<td>The no-flow time (NFT), in milliseconds.</td>
</tr>
<tr>
<td>NFT %</td>
<td>The no-flow time ratio. NFT divided by length, expressed in percent.</td>
</tr>
<tr>
<td>FT</td>
<td>The flow time (FT), in milliseconds. It is defined as the length of the statistic minus the NFT, in milliseconds.</td>
</tr>
<tr>
<td>FT %</td>
<td>The flow time ratio. Flow time divided by the length, expressed in percent.</td>
</tr>
</tbody>
</table>

Compression section

<table>
<thead>
<tr>
<th>Statistic label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comp</td>
<td>The total number of compressions.</td>
</tr>
<tr>
<td>Correct</td>
<td>The total number of compressions that are in-target and are not leaning.</td>
</tr>
<tr>
<td>Deep</td>
<td>The number of compressions that are too deep.</td>
</tr>
<tr>
<td>Shallow</td>
<td>The number of compressions that are too shallow.</td>
</tr>
<tr>
<td>Depth</td>
<td>The average depth of compression, in millimeters.</td>
</tr>
<tr>
<td>Statistic label</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Leaning</td>
<td>The number of compressions with incomplete release.</td>
</tr>
<tr>
<td>Rate</td>
<td>The average compression rate, per minute. The rate is computed over the active compression time. The time without compression activities is excluded.</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>The compression duty cycle.</td>
</tr>
<tr>
<td>In Target %</td>
<td>The ratio of adequate count to total count.</td>
</tr>
</tbody>
</table>

### Ventilation section

<table>
<thead>
<tr>
<th>Statistic label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vent</td>
<td>The total number of ventilations.</td>
</tr>
<tr>
<td>Vent Rate</td>
<td>The average ventilation rate, per minute. If the statistics are divided into pre- and post intubation periods, the ventilation rate is for the specific pre-intubation and post-intubation period. If not, the ventilation rate is for the entire episode.</td>
</tr>
<tr>
<td>dt</td>
<td>The average inflation time, in milliseconds.</td>
</tr>
<tr>
<td>dz</td>
<td>The average inflation level, in mOhms.</td>
</tr>
<tr>
<td>Too Fast</td>
<td>The total number of ventilations that are too fast (too short in duration).</td>
</tr>
</tbody>
</table>

### No Sign of Circulation (NSC) section

<table>
<thead>
<tr>
<th>Statistic label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NSC</td>
<td>The total No Sign of Circulation (NSC) time, in milliseconds.</td>
</tr>
<tr>
<td>Comp</td>
<td>The average compression rate during the NSC time.</td>
</tr>
<tr>
<td>NFT/NSC</td>
<td>The ratio of No Flow Time (NFT) to No Sign of Circulation (NSC).</td>
</tr>
</tbody>
</table>

### Summary section

<table>
<thead>
<tr>
<th>Statistic label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shock count</td>
<td>The total number of shocks in the episode.</td>
</tr>
<tr>
<td>Shocks included</td>
<td>Number of shocks included in this shock summary statistics.</td>
</tr>
<tr>
<td>Statistic label</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Power on to 1st shock</td>
<td>Time from power-on to first shock, in milliseconds.</td>
</tr>
<tr>
<td>Analysis + Delivery time total</td>
<td>Total analysis and shock delivery time, in milliseconds.</td>
</tr>
<tr>
<td>Analysis + Delivery time avg</td>
<td>Average time from start of analysis to shock delivery, in milliseconds.</td>
</tr>
<tr>
<td>Avg pre HOT</td>
<td>Average hands off time before shock delivery, in milliseconds.</td>
</tr>
<tr>
<td>Avg post HOT</td>
<td>Average hands off time after shock delivery, in milliseconds.</td>
</tr>
<tr>
<td>Total count</td>
<td>Total number of analyses in the episode.</td>
</tr>
<tr>
<td>Total included</td>
<td>Number of analyses included in this analysis summary statistics.</td>
</tr>
<tr>
<td>Auto total</td>
<td>Number of auto-initiated analysis included in this analysis summary statistics.</td>
</tr>
<tr>
<td>Manual total</td>
<td>Number of manually initiated analysis included in this analysis summary statistics.</td>
</tr>
<tr>
<td>Result incomplete</td>
<td>Number of analyses indicated no shock decision was made.</td>
</tr>
<tr>
<td>Result shock ind</td>
<td>Number of analyses indicated shock was advised.</td>
</tr>
<tr>
<td>Result no shock ind</td>
<td>Number of analyses indicated no shock was advised.</td>
</tr>
<tr>
<td>Total time</td>
<td>Total analysis time, in ms (does not include those with incomplete results)</td>
</tr>
<tr>
<td>Avg time</td>
<td>Average time for the analyses to make the shock or no shock decision, in ms (does not include those with incomplete results).</td>
</tr>
<tr>
<td>Pre HOT total</td>
<td>Total pre shock hands on time in milliseconds.</td>
</tr>
<tr>
<td>Pre HOT avg</td>
<td>Total hands off time before start of analysis, in milliseconds.</td>
</tr>
<tr>
<td>Post HOT total</td>
<td>Total hands off time after start of analysis, in milliseconds.</td>
</tr>
<tr>
<td>Post HOT avg</td>
<td>Average hands off time after the start of analysis, in milliseconds.</td>
</tr>
</tbody>
</table>
### Shock statistics section

<table>
<thead>
<tr>
<th>Statistic label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>Shock index within the whole incident case.</td>
</tr>
<tr>
<td>Start</td>
<td>Shock start time in milliseconds.</td>
</tr>
<tr>
<td>Analysis time</td>
<td>Time from the start of analysis event to the shock delivery event, in milliseconds.</td>
</tr>
<tr>
<td>Pre HOT</td>
<td>Hands off time (HOT) before the shock delivery, in milliseconds.</td>
</tr>
<tr>
<td>Post HOT</td>
<td>Hands off time (HOT) after the shock delivery, in milliseconds.</td>
</tr>
</tbody>
</table>

### Analysis statistics section

<table>
<thead>
<tr>
<th>Statistic label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Time the analysis started, in milliseconds, from the start time.</td>
</tr>
<tr>
<td>Analysis time</td>
<td>Length of time, in milliseconds, of the analysis.</td>
</tr>
<tr>
<td>Type</td>
<td>Analysis initiated manually, or automatically (in AED mode.)</td>
</tr>
<tr>
<td>Result</td>
<td>The analysis result.</td>
</tr>
<tr>
<td>Pre HOT</td>
<td>Hands off time (HOT) before the analysis started, in milliseconds.</td>
</tr>
</tbody>
</table>

This is defined as the shortest time of:
- Time from last compression to start of analysis.
- Time from start of the period to start of the analysis.
- Time from last shock to the start of analysis.
- Time from the ending of last analysis to the start of this analysis.
- Time from the start of last analysis to the start of this analysis.
<table>
<thead>
<tr>
<th>Statistic label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post HOT</td>
<td>Hands off time (HOT) before the analysis started, in milliseconds. The time is measured from when the analysis started, not from when the analysis was completed. This is defined as the shortest time of:</td>
</tr>
</tbody>
</table>

- Time from start of analysis to next compression.
- Time from start of analysis to end of the period.
- Time from start of analysis to next shock.
- Time from start of analysis to start of next analysis, in this case, the analysis time is used instead.

**Working with Q-CPR Response Time reports**

The Q-CPR Response Times report shows overall CPR performance for all cases in a given time range (up to a maximum of 24 months) as well as trends over the same period.

⚠️ Depending on the number of cases included in the time range, this report may take hours to generate.

**Customizing the Q-CPR Response Times report**

Once selected, the following settings persist when the application is reopened.

- **Start Date** You can specify the start date for the time range. The report includes cases from this date. The default setting is today's date minus two years.
- **End Date** You can specify the end date for the time range. The report includes cases up to and including this date. The default setting is today’s date.
- **Compression Count Threshold** You can select the compression count threshold. The report will include only cases that have more than this number of compressions. The default setting is 1 compression.
• **Depth**  You can select the compression depth units, inches or millimeters. The default setting is inches. You can toggle from inches to millimeters.

• **Institution**  Only cases that match this Institution value will be included in the report. This information comes from the Institution field, on the Overview tab.

• **Reference ID**  Only cases that match this Reference ID value will be included in the report. This information comes from the Reference ID field, on the Overview tab.

**Graphical information in the Q-CPR Response Times report**

The report contains an overview page and a details page, each presenting information in a graphical format.

• [Information in the Q-CPR Response Times overview](#) on page 174

• [Information in the Q-CPR Response Times details](#) on page 178.

**Information in the Q-CPR Response Times overview**

The following illustration shows the general arrangement of the overview. The general arrangement is the same in all languages. Refer to the table after the illustration for definitions.
Key to illustration numbers for the previous illustration:

1. **Start date**: The start of the date range. The report includes cases with a case date greater than or equal to this date.

2. **End date**: The end of the date range. The report includes cases with a case date less than or equal to this date.

3. **Total cases**: The total number of cases included in the report results.

4. **Cases with 12-leads**: The total number of cases with 12-leads in the report results.

5. **Average shocks per case**: Average shock events per case for the cases included in the report results.

6. **Cases with shocks**: The total number of cases included in the report results which include shocks.

7. **Cases with Q-CPR**: The total number of cases included in the report results which include Q-CPR data.
<table>
<thead>
<tr>
<th><strong>#</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
</table>
| 8     | **Compression threshold/cases excluded**: This field shows 2 values.  
The first shows a compression event count threshold. Cases with a total number of compressions below this threshold are excluded from Q-CPR calculations, but are not excluded from the other statistics included in the report.  
The second value shows the total number of cases that were excluded from Q-CPR calculations. |
| 9     | **Overall CPR quality chart**: This chart shows the overall compression quality for all intervals in the date range.  
Intervals with both compression depth and rate in target are depicted in green.  
Intervals with both compression depth and rate out of target are depicted in red.  
Intervals with compression depth in target and rate out of target are depicted in orange.  
Intervals with compression rate in target and depth out of target are depicted in yellow. |
| 10    | **Compression depth quality chart**: This chart shows the compression depth quality for all intervals in the date range.  
Intervals with an average compression depth greater than or equal to the lower target and less than or equal to the upper target (if applicable) are depicted in the green slice.  
Intervals with an average compression depth less than the lower target are depicted in the red slice.  
Intervals with an average compression depth greater than the upper target (if applicable) are depicted in the yellow slice.  
The average compression depth is shown above the pie chart.  
Note that, unlike in the Q-CPR report card, the depth targets are not shown. This is because the data may contain input from multiple devices using different CPR guidelines. |
| 11    | **Hands on/off time chart**: This chart shows the amount of hands on/off time for the date range. Green represents hands-on time and red represents hands-off time. |
12 **Compression rate quality chart**: This chart shows the compression rate quality for all intervals in the date range.

Intervals with a compression rate greater than or equal to the lower target and less than or equal to the upper target (if applicable) are depicted in the green slice.

Intervals with a compression rate less than the lower target are depicted in the red slice.

Intervals with a compression rate greater than the upper target (if applicable) are depicted in the yellow slice.

The average compression rate is shown above the pie chart.

Note that, unlike in the Q-CPR report card, the rate targets are not shown. This is because the data may contain input from multiple devices using different CPR guidelines.

13 **Average time to first 12-lead**: Average time to first 12-lead for each month, for cases with 12-lead data. No point is drawn if there are no cases with 12-leads in a given month.

14 **Average time to first shock**: Average time to first shock for each month, for cases which include shock events. No point is drawn if there are no cases with shock events in a given month.
Information in the Q-CPR Response Times details

The following illustration shows the general arrangement of the CPR Details. The general arrangement is the same in all languages. Refer to the table after the illustration for definitions.

Key to illustration numbers for the previous illustration:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td><strong>Below target</strong>: (Red) This chart section shows the percentage of cases in the period with average CPR <em>depth and rate</em> below target.</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td><strong>Rate in target</strong>: (Yellow) This chart section shows the percentage of cases in the period with average CPR <em>rate</em> but <em>not depth</em> in target.</td>
</tr>
<tr>
<td><strong>3</strong></td>
<td><strong>Depth in target</strong>: (Orange) This chart section shows the percentage of cases in the period with average CPR <em>depth</em> but <em>not rate</em> in target.</td>
</tr>
<tr>
<td><strong>4</strong></td>
<td><strong>In target</strong>: (Green) This chart section shows the percentage of cases in the period with average CPR <em>depth and rate</em> in target.</td>
</tr>
</tbody>
</table>
Working with zCPR Report Card reports

The zCPR Report Card report is based on the impedance data recorded by the defibrillator during the episode. It is used to view CPR rate data and hands-on/hands-off time for cases where the HeartStart Q-CPR meter was not used.

zCPR should not be used for determining chest compression depth or chest compression release.

Customizing the zCPR Report Card report

Once selected, the following settings persist when the application is reopened.

- **Guidelines** In the Guidelines menu you can select the CPR Guidelines used to generate the report. The default setting is AHA 2010, and only the CPR rate guidelines apply, because impedance data does not capture CPR depth information.

  Other available guideline options are AHA 2005 or 2015, ERC 2005, 2010, or 2015, or Custom (if configured). Custom CPR Guidelines are set in the Administration workspace. For details, see Selecting CPR Guidelines for reporting on page 150.

- **Responder** You can filter results by responder (limit the results to CPR performed by a specific responder) by selecting a CPR responder from this menu. The default is All, and the report displays statistics for the entire episode, including all responders. You can filter by responder if responders are annotated.
In order to filter by responder, you need to annotate the compression waveform with responder type, and enter the responder name in the name field. For details, see Adding CPR responder annotations on page 128.

- **Interval** In seconds. Choose 10, 15 or 30 (default).
- **Ignore episode markers** Check this option if you want to ignore the episode markers and report on the entire recording from device on to device off. When this option is unchecked, the episode start and end times are set to one second prior to the first compression event, and one second after the last compression event. The user can manually adjust the episode start and end times from the ECG viewer. By default, this option is unchecked (do not ignore).
- **Display compression strips** You can choose whether to show or hide compression strips in the report. By default this is checked (show).

**Information in the report**

The report contains information about the rate of CPR in the episode.

- Information in the zCPR Report Card chart on page 180.
- Information in the zCPR Report Card compression strips on page 182.

**Information in the zCPR Report Card chart**

The following illustration shows the general arrangement of the zCPR Report Card chart page. The general arrangement is the same in all languages. Refer to the table after the illustration for definitions.
Key to illustration numbers for the previous illustration:

1. **CPR guideline parameters** This field shows the CPR guideline rate targets used to calculate the CPR quality shown in the report. When no upper target is specified, only the lower target is shown.

2. **Compression Rate Quality gauge** This gauge shows the average compression rate over the entire episode. The segment colors correspond to the colors of the chart below. The marker beneath the gauge is green if the average rate is within the target zone, red if below the target zone, and yellow if above the target zone. The label shows the actual average rate value, as well as the lower and upper (if applicable) targets.

3. **Compression Rate Quality chart** This chart shows the compression rate quality for all intervals in the episode. Intervals with a compression rate greater than or equal to the lower target and less than or equal to the upper target (if applicable) are depicted in the green slice. Intervals with a compression rate less than the lower target are depicted in the red slice. Intervals with a compression rate greater than the upper target (if applicable) are depicted in the yellow slice.

4. **Hands-On/Hands-Off Time chart** This chart shows the amount of hands-on versus hands-off time for the episode. Green represents hands-on time, and red represents hands-off time. The slice labels show hands-on and hands-off time as percentages of the entire episode time. The legend shows the actual amount of hands-on and hands-off time in hours, minutes, and seconds.
CPR Episode Summary
This section contains a summary of the CPR episode.

Compression Data
This section contains a summary of the compression events.

Responder
This field shows the CPR responder by name. The selection is made in the Responder menu on the Q-CPR Customization area in the report. When All is selected in the Responder menu (the default selection), an empty string appears in this field.

Hands-On/Hands-Off Time table
This section contains a summary of the hands on time periods.

Defibrillation Data
This section contains a summary of the episode shocks.

Information in the zCPR Report Card compression strips
The following illustration shows the general arrangement of the zCPR Report Card compression strips page. The general arrangement is the same in all languages. Refer to the table after the illustration for definitions.

Key to illustration numbers for the previous illustration:
Working with Vital Trends reports

The Vital Trends report provides case information based on the vital trends information that appears on the ECG tab. The information appears in a table format.

The report displays the following information:

- Case ID, device, and patient information
- Vital trends in a table format

The report uses the interval parameter setting. An interval can be 1, 5, 10, 15, 30, or 60 minutes in duration.

Working with Response Times reports

The EMS edition provides Response Times reports.

You can generate Response Times reports to assess your system’s overall response performance and compare performance with service-level commitments.

The type of report determines the parameter settings you can specify. For information on how to generate a report, see Generating reports on page 151.

Event Review Pro saves the parameter settings and displays them the next time you select the report. You can select or clear any of these fields.
The following fields are used and incorporated in Response Times reports:

- Call Receipt
- Bystander CPR
- Dispatcher Began AED or CPR Instruction
- BLS Unit Notified
- BLS Vehicle Mobile
- BLS Arrival at Scene
- BLS EMS CPR
- ALS Unit Notified
- ALS Vehicle Mobile
- ALS Arrival at Scene
- ALS arrival at Patient
- ALS EMS CPR

Certain database fields must contain data in order to generate the Response Time reports. Ensure that you have entered the following Timeline events for each case you want to report on:

- Call Receipt
- ALS/BLS Unit notified
- ALS/BLS Vehicle mobile
- ALS/BLS Arrival at scene
- ALS/BLS Arrival at patient
- ALS/BLS EMS CPR

Time to first shock is calculated from the device data.

**Average Response Times – Total System**

This report summarizes the average response times for key milestones in your system’s response protocols. You can specify the date range and site of collapse to limit the cases you want to summarize in the reports.

The report uses the following parameter settings:

- Start date
- End date
- Site of collapse


**Percentile Response Times – Total System**

This report summarizes response times achieved in a specific percentage of responses. You can specify the date range and site of collapse to limit the cases you want to summarize in the report. You must specify the percentile.

The report uses the following parameter settings:

- Start date
- End date
- Site of collapse
- Percentile (required, median is 50%)

**Average Response Times**

This report summarizes, for a specific unit, the average response times for key milestones in your response protocols. You can specify the date range and site of collapse to limit the cases you want to summarize in the reports.

The report uses the following parameter settings:

- Start date
- End date
- Site of collapse
- Unit name

**Percentile Response Times**

This report summarizes, for a specific unit, the response times achieved in at least a specific percentage of responses. You can specify the date range and site of collapse to limit the cases you want to summarize in the report. You must specify the percentile.

The report uses the following parameter settings:

- Start date
- End date
- Site of collapse
- Unit
- Percentile (required, median is 50%).
Working with Utstein reports

The EMS edition provides Utstein reports.

These reports follow the Utstein guidelines for reporting information on out-of-hospital cardiac arrests. They use the recommended terms and follow the Utstein template approach.

The type of report determines the parameter settings that you can specify. For information on how to generate a report, see Generating reports on page 151.

Event Review Pro saves the parameter settings and displays them the next time you select the report.

Certain database fields must contain data in order to generate the Utstein reports. Ensure that you have entered the following Scene details for each case you want to report on:

- Resuscitation attempted
- Initial rhythm
- Witnessed by
- Cardiac etiology
- Confirmed cardiac arrest
- Bystander CPR

Ensure that you have entered the following Outcome details for each case you want to report on:

- Any ROSC
- Admitted to ICU/ward
- Discharged
- Alive at one year
- Patient death

Unwitnessed with Bystander CPR

The Unwitnessed with Bystander CPR report summarizes the unwitnessed cardiac arrests that are in your system.

The report uses the following parameter settings:

- Start date
- End date
- Location
- Population served by EMS system

**Witnessed with Bystander CPR**

The Witnessed with Bystander CPR report summarizes witnessed cardiac arrest in which a bystander administered CPR.

The report uses the following parameter settings:

- Start date
- End date
- Location
- Population served by EMS system

**Witnessed without Bystander CPR**

The Witnessed without Bystander CPR report summarizes witnessed cardiac arrests in which no bystander administered CPR.

The report uses the following parameter settings:

- Start date
- End date
- Location
- Population served by EMS system

**Working with Device Self-test History reports**

Event Review Pro generates a Device Self-test History report for self-test data imported from a specific AED device. For information about importing device self-test data, see [Importing device self-test data using the Device Self-test Wizard](#) on page 209.

Device self-test data can be imported from HeartStart AED devices. However, the importation of device self-test data from HeartStart monitor/defibrillators, such as the HeartStart MRx, is not supported.
To generate a Device Self-test History report from the Reports navigation area
1. From the Reports navigation area, click **Device Self-Test History**. The All Devices table opens, showing a list of devices with imported self-test data.
2. Select the table row for the device you want to report on.
3. From the File menu or the toolbar, click **Print** and then click **Report**. Report Preview opens, displaying the Device Self-test History report. See Working in Report Preview on page 153.

To generate a Device Self-test History report from the Devices navigation area
1. From the Devices navigation area, click **All Devices** to open the All Devices table, showing a list of devices with imported self-test data.
2. Select the table row for the device you want to report on.
3. From the File menu or the toolbar, click **Print** and then click **Report**. Report Preview opens, displaying the Device Self-test History report. See Working in Report Preview on page 153.

The Device Self-test History report includes the following columns of self-test information:
- Sequence Number
- Date
- Time
- Relative Time
- Description
- Status
Customer support

Philips strives to provide you with excellent customer service and technical support. Software updates for the integrated applications are available from the application Help menu. From the Help menu, click Check for Updates.

Customer support is available through email, Internet, and telephone.

Email product support is available in English only at: eventreview.support@philips.com. In addition, if a customer support representative asks you to send the System Log, on the Help menu, click Email with System Log and send the email message that appears. The System log is attached to it by default.

Internet product support is available at the following address:

http://www.philips.com/DataManagementSupport

For telephone assistance outside the United States, please call your sales representative or local response center. You can also navigate to technical support telephone numbers for data management products at this address:

http://www.healthcare.philips.com/main/services/response_center

For telephone support in English only, you can call the following numbers:

• 800-722-9377 (option 3), inside the United States
• +1 770-510-1130

See the following table for contact information:

<table>
<thead>
<tr>
<th>Region</th>
<th>Address</th>
<th>Telephone number</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
<td>Philips Healthcare 3000 Minuteman Road</td>
<td>800-722-9377 (option 3)</td>
</tr>
<tr>
<td></td>
<td>Andover, Massachusetts 01810-1099</td>
<td>+1 770-510-1130</td>
</tr>
<tr>
<td>Region</td>
<td>Address</td>
<td>Telephone number</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td>------------------</td>
</tr>
<tr>
<td>Canada</td>
<td>Philips Healthcare, a Division of Philips Electronics Ltd. 281 Hillmount Road Markham, Ontario, Canada L6C 2S3</td>
<td>+1(800) 291-6743</td>
</tr>
<tr>
<td>Authorized EU Representative Europe, Middle East, and Africa</td>
<td>Philips Medizin Systeme Boeblingen GmbH Cardiac and Monitoring Systems Hewlett-Packard Strasse 2 71034 Boeblingen, Germany</td>
<td>(+49) 7031 463-2254</td>
</tr>
<tr>
<td>Latin America</td>
<td>Philips Medical Systems Ltd. Av. Dr. Marcos Penteado Ulhôa Rodrigues, 401 Parte 16 – 06460-040 – Barueri/SP, Brazil</td>
<td>0800 7017789</td>
</tr>
<tr>
<td>Asia Pacific</td>
<td>Philips Electronics Hong Kong Ltd. 6/F, Core Building 1 1 Science Park East Avenue Hong Kong Science Park Shatin. New Territories, Hong Kong</td>
<td>+852 2821 5888</td>
</tr>
</tbody>
</table>

**Comments or suggestions?**

Please send your feedback and suggestions to:
eventreview.support@philips.com

**Supported help**

Customer support technicians provide help for the following:

- Explaining the proper use of application features and answering your questions about how the application works
- Explaining the proper installation and maintenance of the application
- Assisting you in selecting and configuring card readers

**Unsupported help**

Customer support technicians do not provide help for the following:
• Interpreting ECG or medical data. Please call your medical director or clinical specialist.

• Repairing hardware. The support technicians can help you determine if you have a hardware problem, but they cannot help you fix problems that are not related to the Philips HeartStart application software.

• Troubleshooting defibrillators. Instead, call Philips Customer Support and ask for defibrillator support.

• Troubleshooting non-Philips products.

**Helping us help you**

You can help our technicians give you good support by following these steps:

1. Call from a phone near your computer.
3. Have the following information:
   • Windows version.
   • The application version number. This is available from the Help menu. Click the **About** option.
   • A written copy of the error message text.
   • The activity and task you did when the error occurred.
Working with defibrillators

A wide variety of HeartStart defibrillators can transfer data to Event Review Pro, and data transfer methods vary by model.

Prepare for transferring data from your defibrillator to Event Review Pro by reviewing the following information, and ensuring that you have everything you need to perform the task before you need to do so.

Supported defibrillators

Familiarize yourself with the methods for transferring data from your defibrillator by reading the instructions that came with the device.

You can download product owners' manuals for supported defibrillators from the Philips support Web site.

Event Review Pro documentation uses the HS1 or HS1 family of defibrillators to refer to HeartStart Home, HeartStart OnSite, and HeartStart HS1 Defibrillators.

To download products and services materials

1. Navigate to this site: http://www.philips.com/productdocs
2. Click Resuscitation/Defibrillators products.
3. Click the defibrillator to display a page that lists the product user and service materials.

The defibrillators and the data transfer methods available for them are shown in the following table:

<table>
<thead>
<tr>
<th>Data source</th>
<th>Method used to read data</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>HeartStart FR3</td>
<td>Secure digital (SD) card or Bluetooth connection</td>
<td>Reading FR3 series cards on page 195</td>
</tr>
<tr>
<td>Data source</td>
<td>Method used to read data</td>
<td>Instructions</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HeartStart FR2</td>
<td>Compact Flash data card</td>
<td>Reading FR2 series cards on page 200</td>
</tr>
<tr>
<td>HeartStart FRx</td>
<td>Infrared (IrDA) connection</td>
<td>Downloading an ECG from an infrared connection on page 58</td>
</tr>
<tr>
<td>HeartStart HS1</td>
<td>Infrared (IrDA) connection</td>
<td>Downloading an ECG from an infrared connection on page 58</td>
</tr>
<tr>
<td>HeartStart MRx</td>
<td>Card reader or Bluetooth connection</td>
<td>Reading HeartStart MRx cards on page 196</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Downloading an ECG using a HeartStart MRx Bluetooth transmission on page 57</td>
</tr>
<tr>
<td>HeartStart XL</td>
<td>ATA flash data card</td>
<td>Reading HeartStart XL cards on page 201</td>
</tr>
<tr>
<td>HeartStart XL+</td>
<td>USB data drive</td>
<td>Transferring HeartStart XL+ data on page 201</td>
</tr>
<tr>
<td>Efficia DFM100</td>
<td>USB data drive</td>
<td>Transferring Efficia DFM100 data on page 202</td>
</tr>
</tbody>
</table>

## Selecting accessories for data transfer

If your HeartStart defibrillator model uses a data card or a data drive to transfer defibrillator data, refer to the following quick reference to ensure that you have the necessary accessories.

## Quick reference to data cards and drives

The following table shows the defibrillators with their associated data cards. If your computer did not come installed with the appropriate software or adapter for the transfer method, you can use an adapter or reader.

Not all defibrillator models use data cards or drives. Only defibrillators that use data cards or drives are included in the following table.
<table>
<thead>
<tr>
<th>Defibrillator Model</th>
<th>Storage Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>HeartStart FR3</td>
<td>FR3 defibrillators use Philips secure digital SD data cards, with the SD data-card reader.</td>
</tr>
<tr>
<td>HeartStart FR2</td>
<td>FR2 defibrillators use the Compact Flash cards with the Compact Flash card reader.</td>
</tr>
<tr>
<td>HeartStart MRx</td>
<td>HeartStart MRx monitor/defibrillators use Compact Flash cards with the Compact Flash card reader.</td>
</tr>
<tr>
<td>HeartStart XL</td>
<td>XL defibrillators use ATA flash cards.</td>
</tr>
<tr>
<td>HeartStart XL+</td>
<td>XL+ defibrillators use Philips USB data drives.</td>
</tr>
<tr>
<td>Efficia DFM100 (Where available)</td>
<td>Efficia DFM100 monitor/defibrillators use Philips USB data drives.</td>
</tr>
</tbody>
</table>
Reading FR3 series cards

The FR3 series defibrillators store information on a SD card. SD card readers are available through your Philips sales representative or local distributor.

To read a data card

1. One end of the data card has a series of contacts. Plug this end firmly into the card reader.

2. Check in Windows File Explorer to see that the card was recognized. When Windows recognizes the card, it assigns a drive letter to the card.

   At this point, Event Review Pro can read the data on the card.

3. If the card does not appear in Windows File Explorer, remove the card from the reader, and then insert it into the card reader again.

Retrieving FR3 data using Bluetooth transmission

You can download data from a HeartStart FR3 to the computer through Bluetooth transmission. All data contained on the HeartStart FR3 is transferred during the transmission, and it also remains on the device.

Preparing for Bluetooth transfer

Ensure that you have the option for Bluetooth wireless transfer for your HeartStart FR3. Confirm that you have a Bluetooth card installed in the defibrillator. For more information, see the most current release of the HeartStart FR3 Instructions for Administrators.

Pairing the Bluetooth option for the FR3 occurs automatically. When data matching the device type, serial number, date, and time appears in the Attach ECG window, that is your confirmation that Bluetooth wireless transfer has occurred.

You must have a supported adapter for Bluetooth transmission.

Most Microsoft®-compatible Bluetooth adapters are suitable. You can order an adapter from your Philips representative.
To transfer data from the HeartStart FR3

1. From an open case, click Attach ECG file.

   The Attach ECG window opens, and the Case Wizard begins scanning for any device in Bluetooth communication range.

   Data transfer begins as soon as the FR3 is ready for data transfer.

2. For assistance in preparing your FR3 for data transfer, click the Bluetooth icon, and then click the image of the HeartStart FR3, to start the Bluetooth Wizard.

   Follow the instructions in the wizard as it guides you through the steps necessary to prepare the FR3 for data transfer.

   Note: The Bluetooth Wizard, launched by clicking the Bluetooth icon in the Attach ECG window, does not initiate Bluetooth communication; it is simply a tutorial.

3. Watch the Attach ECG window.

   When data transfer occurs, all the data on the FR3 appears in the Attach ECG window, with columns for device type, serial number, and date and time, for use in identifying the data.

   If no data is on the FR3, a message appears indicating that there is no patient data.

4. Click the data to attach to your case, and then click Open.

   The data is added to the case.

5. Remember to save the case.

Reading HeartStart MRx cards

The HeartStart MRx defibrillator stores information in internal memory.

To open the information in Event Review Pro, transfer the information from the internal memory to an external CompactFlash card and then download it to Event Review Pro.

Follow the instructions in the HeartStart MRx Monitor/Defibrillator Instructions for use guide. After you transfer the information to a CompactFlash card, you can read the card in a card reader.

- CompactFlash cards and card readers are available through your Philips sales representative or local distributor.
To read a data card

1. Remove the data card from the HeartStart MRx data card tray.
2. One end of the data card has a series of perforations. Insert this end firmly into the card reader.
3. Check in Windows File Explorer to see that the card was recognized. When Windows recognizes the card, it assigns a drive letter to the card.

   Event Review Pro can read the data on the card.
4. If the card does not appear in Windows File Explorer, remove the card from the card reader, and then insert it into the card reader again.

Setting up Bluetooth transmissions for the HeartStart MRx

You can transmit HeartStart MRx data to Event Review Pro through Bluetooth® wireless transmission.

You must have a supported adapter for Bluetooth transmission.

Most Microsoft®-compatible Bluetooth adapters are suitable. You can order an adapter from your Philips representative.

To transfer the information from the defibrillator to Event Review Pro, you must set up the Bluetooth transmission on the defibrillator and the receiving computer that has Event Review Pro installed.

If your computer is not equipped with Bluetooth capability, it will require a Bluetooth dongle with a USB connector. The dongle connects the computer and the defibrillator.

Event summaries and HeartStart MRx 12-lead reports might contain information that could be considered Patient Healthcare Information (PHI) or patient-identifiable data. Handle the information in accordance with HIPAA or your local patient privacy requirements.
Bluetooth option prerequisites for the HeartStart MRx

The prerequisites for Bluetooth use are slightly different for the MRx and FR3 defibrillators.

The Bluetooth card on the HeartStart MRx is inside of the defibrillator. Confirm that you have a Bluetooth card installed and that the Event Summary Bluetooth transmission feature is enabled.

For implementation information, see "Support for MRx Bluetooth FTP using the Microsoft Bluetooth stack" in HeartStart Data Management Solutions Implementation Guide.

For detailed information on setting up the HeartStart MRx for Bluetooth transmission, see the most current release of the following documentation:

• HeartStart MRx Instructions for Use Addendum
• HeartStart MRx Instructions for Use
• HeartStart MRx Data Transmission Implementation Guide

Pairing and testing the HeartStart MRx Bluetooth option with the computer

Use this information to pair and test the Bluetooth option for HeartStart MRx.

💡 Make sure that the application computer is turned on and that the Bluetooth software and adapter are installed and visible or discoverable.

To pair the HeartStart MRx Bluetooth option with the computer

1. On the HeartStart MRx main menu, click Bluetooth Devices.
2. Click Add Device.
   
   The defibrillator searches for your computer.
   
   If your computer is not listed after the search, your computer Bluetooth is not enabled or set up correctly. Refer to the Bluetooth documentation to troubleshoot the setup.
3. Click the name of your computer and then press Enter.
4. Type a passkey for the Bluetooth option, using the number menu.
The passkey is a user-defined character sequence, such as 000, or 1234. For information on this sequence, see the documents listed in the Bluetooth option prerequisites for the HeartStart MRx on page 198.

5. At the top of the number menu, click Done.
6. On your computer, immediately watch for a pop-up message.
7. Click the pop-up message.
8. Type the same Bluetooth passkey that you typed on the defibrillator in step 4. The defibrillator and the computer now have a Bluetooth connection, and you are ready to test it.
9. Click Next and then Finish.
10. On the main menu of the HeartStart MRx, click File Transfer and then Enter.

HeartStart MRx displays the "transmission test passed" message.
11. Click Acknowledge.
12. Scroll to Exit and click Enter.
13. On the main menu of the HeartStart MRx, click Other, Data Management, and then Acknowledge.
14. After changing into Data Management mode, the HeartStart MRx displays a list of summary case data with the most recent incident at the top. Select the incident that you want to transmit.
15. Click Send and then All Event Data.
16. On your computer, in the Attach ECG dialog box, watch for a display that includes the HeartStart MRx folder, and open it to see the data that has been transferred.

**Sending the HeartStart MRx Bluetooth transmission**

You can download a case from HeartStart MRx to the computer through a Bluetooth transmission.

Before downloading, make sure that the HeartStart MRx has been paired with your computer. See Pairing and testing the HeartStart MRx Bluetooth option with the computer on page 198 for information on pairing and testing the connection.
To make a Bluetooth transmission

1. On the HeartStart MRx, place the defibrillator in the Data Management mode. If necessary, use the HeartStart MRx documents listed in Bluetooth option prerequisites for the HeartStart MRx on page 198.

2. Use Next Item or Prev Item to navigate to the incident of your choice.

3. Press Menu, and then navigate to Send.

4. Press Send.

5. Navigate to the information you want to transmit to Event Review Pro and press Enter.

6. The first time you send a Bluetooth transmission, a popup message appears, including an option to Always Allow Authorization. If you want to do this, check the box; if you do not, the checkbox will appear every time you send a transmission.

7. After the HeartStart MRx transmits the incident to the computer, you can attach the ECG from the HeartStart MRx in Event Review Pro.

For more information, see Downloading an ECG using a HeartStart MRx Bluetooth transmission on page 57.

Reading FR2 series cards

The FR2 series defibrillators store information on a Compact Flash card. Card readers are available through your Philips sales representative or local distributor.

To read a data card

1. One end of the data card has a series of perforations. Plug this end firmly into the card reader.

2. Check in Windows File Explorer to see that the card was recognized. When Windows recognizes the card, it assigns a drive letter to the card.

   Event Review Pro can read the data on the card.

3. If the card does not appear in Windows File Explorer, remove the card from the reader, and then insert it into the card reader again.
Reading HeartStart XL cards

The HeartStart XL defibrillator stores information on an ATA flash card. Read the documentation for the defibrillator to learn how to remove the card from the defibrillator.

You can read these cards in an ATA flash card reader or a PC Card (PCMCIA) reader. If the computer is not equipped with an adapter, you can add one as an external or internal card reader. The external card reader plugs into the desktop USB port.

To read a data card
1. One end of the card has a series of perforations. Insert this end firmly into the card reader.
2. Check in Windows File Explorer to see that the card was recognized. When Windows recognizes the card, it assigns a drive letter to the card.
   - The Philips Data Management Solutions application and Event Review Pro can read the data on the card.
3. If the card does not appear in Windows File Explorer, remove the card from the card reader, and then insert it into the card reader again.

Transferring HeartStart XL+ data

The HeartStart XL+ defibrillator uses a USB data drive to transfer event summary data. The USB data drive connects to a USB port on the computer running Event Review Pro.

You can export data from the HeartStart XL+ defibrillator to the USB data drive using a menu selection in the Data Management mode. Once the data is exported, you can transfer it to the computer running Event Review Pro. See Attaching an ECG from a USB port on page 56.

To export event-summary data from the HeartStart XL+ defibrillator to the USB data drive
1. Locate the USB data port on top of the HeartStart XL+ defibrillator and insert the USB data drive. For more information, see the HeartStart XL+ instructions for use.
2. Confirm that you are in Data Management mode.
3. Press the **Menu Select** button.
   The Internal Memory menu appears.
4. Use the navigation buttons to select the **Export All** option.
5. Press the **Menu Select** button to start the task.
   The data is exported to the USB data drive.

**Transferring Efficia DFM100 data**

The Efficia DFM100 defibrillator/monitor (where available) uses a USB data drive to transfer event summary data. The USB data drive connects to a USB port on the computer running Event Review Pro.

You can export data from the Efficia DFM100 defibrillator/monitor to the USB data drive using a menu selection in the Data Management mode. Once the data is exported, you can transfer it to the computer running Event Review Pro. See [Attaching an ECG from a USB port](#) on page 56.

**To export event-summary data from the Efficia DFM100 defibrillator/monitor to the USB data drive**

1. Locate the USB data port on the Efficia DFM100 defibrillator/monitor and insert the USB data drive. For more information, see the *Efficia DFM100 Defibrillator/Monitor Instructions for Use*.
2. Confirm that you are in Data Management Mode. When first entering Data Management Mode, the Internal Memory Screen is displayed.
3. From the Internal Memory Screen, press the **Smart Select** knob to enter the Internal Memory Menu.
4. Use the knob to navigate to the **Export All** menu option.
5. Press the **Smart Select** knob again to start the task.
   The data is exported to the USB data drive.

**Determining the HS1 and FRx case date and time**

Event Review Pro documentation uses the HS1 or HS1 family of defibrillators to refer to HeartStart Home, HeartStart OnSite, and HeartStart HS1 Defibrillators.
The HS1 family of defibrillators and FRx defibrillators do not have a real-time clock that keeps the defibrillator date and time. Instead, the defibrillator has a continuously running timer that starts when you insert the battery. Event Review Pro uses this timer and the computer date and time to calculate case and event time. The timer resets when you remove the battery. Therefore, do not remove the battery until after you have downloaded the patient data to the application.

Each time that Event Review Pro communicates with an HS1 and FRx defibrillator through IrDA, it uses the date/time of the computer clock and the timer of the HS1/FRx defibrillator to synchronize the date/time of all events and data since the battery was last inserted. This is called the "time sync point." If Event Review Pro does not find a time sync point, you need to set the case start time.

The time sync point might not match the date and time of the computer by 15 to 30 seconds.

**Using infrared connections for the HS1 and FRx**

Event Review Pro documentation uses the HS1 or HS1 family of defibrillators to refer to HeartStart Home, HeartStart OnSite, and HeartStart HS1 Defibrillators.

The HS1 family of defibrillators and the FRx defibrillator use an infrared (IrDA) communications port to transfer information. For information on how to determine the case date and time, see Determining the HS1 and FRx case date and time on page 202.

The infrared port is located on the lower right side of the defibrillator. To transfer information, the receiving computer must be set up for infrared communication.

Some computers have infrared ports. If the computer does not have an infrared port or the port does not work with the defibrillator, you can add an infrared adapter.

Use an infrared adapter that connects to a USB port, if you require an adapter.
Setting up an infrared adapter

The Event Review Pro software was tested with ACTiSYS adapters. More information is available at the following Web site:

http://www.actisys.com

To set up the infrared adapter
1. Read the instructions that came with the infrared adapter.
2. Use the CD that comes with the infrared adapter to run the driver setup program on the Windows operating system.
3. The New Hardware Wizard guides you through setting up the adapter.

Setting up the infrared connection

Downloading an ECG and device history information from an HS1 or FRx defibrillator requires an infrared connection between Event Review Pro and the defibrillator.

To transfer information, you must put the HS1 or FRx defibrillators into the Administration mode.

The following discussion explains how to set up each defibrillator to transfer information. The process is similar for the HS1 family of defibrillators and the FRx defibrillator. However, there are enough differences to warrant separate sections.

To set up the IrDA connection between an FRx defibrillator and Event Review Pro

If the FRx does not receive a transmission within 3 minutes of starting Administration mode, it cancels the mode. At that point, you must start over.

1. In Event Review Pro, complete one of the following procedures:
   a. Use the Case Wizard to create a case, up to the point where you see the Attach ECG dialog box.
   b. Create a case for the infrared transmission, and then (on the toolbar) click Attach ECG file.
   c. Open an existing case for the transmission, and then (on the toolbar) click Attach ECG file.
2. Remove the pads connector.

3. If you haven't done so already, insert the battery into the defibrillator.
   You will hear voice prompts to plug in pads connectors. Disregard these prompts in this instance. These messages end once you place the defibrillator in Administration mode.

4. On the defibrillator, press and hold the blue Information button, and wait for three tones.

5. Release the blue Information button.
   The voice message announces Administration. The defibrillator enters data transfer mode.

6. Position the defibrillator to communicate with the computer.
   The defibrillator and computer should be between 4 and 24 inches apart and aligned with each other, with an unobstructed path between them. For help aligning the defibrillator and the computer, click the IrDA icon on the Attach ECG window and follow screen instructions.
   You can now send and receive information between the defibrillator and the computer. The device announces transferring data.

7. When sending and receiving information is complete, plug the pads connector in again. You can now turn off the defibrillator.
   For more information, refer to the defibrillator documentation.

To set up the IrDA connection between an HS1 defibrillator and Event Review Pro

Event Review Pro documentation uses the HS1 or HS1 family of defibrillators to refer to HeartStart Home, HeartStart OnSite, and HeartStart HS1 Defibrillators.

If the HS1 does not receive a transmission within 3 minutes of starting Administration mode, it cancels the mode. At that point, you must start over.

1. In Event Review Pro, complete one of the following procedures:
   a. Use the Case Wizard to create a case, up to the point where you see the Attach ECG dialog box.
   b. Create a case for the infrared transmission, and then (on the toolbar) click Attach ECG File.
   c. Open an existing case for the infrared transmission, and then (on the toolbar) click Attach ECG File.
2. Remove the pads cartridge. Locate the latch at the top, and then slide the latch to the right to release the pads cartridge.

3. If you haven't done so already, insert the battery into the defibrillator.

4. You will hear voice prompts to plug in the pads cartridge. Disregard these prompts in this instance. These messages will be silenced once you place your defibrillator in Administration mode. After the battery is inserted, the defibrillator automatically turns on.

5. On the defibrillator, press and hold the blue Information button, and then wait for three tones.

6. Release the blue button.
   A voice message announces Administration.

7. Briefly press the blue Information button again.
   The voice message says Mode 1.

8. Position the defibrillator to communicate with the computer.
   The defibrillator and computer should be at least 12 inches apart and aligned with each other. For help aligning the defibrillator and the computer, click the IrDA icon on the Attach ECG window and follow screen instructions.
   You can now send and receive information between the defibrillator and the computer. The device announces sending data.

9. When sending and receiving information is complete, reinstall the pads cartridge. You can now turn the defibrillator off.
   For more information, refer to the defibrillator documentation.

**Understanding voice and system messages**

Defibrillators and Windows use messages to announce the current state.

**Defibrillator voice messages**

Philips designed the defibrillators to ensure that they are always ready for use in an emergency.

---

Event Review Pro documentation uses the HS1 or HS1 family of defibrillators to refer to HeartStart Home, HeartStart OnSite, and HeartStart HS1 Defibrillators.
Remember to insert the HS1 pads cartridge or plug in the FRx pads connector when you finish transferring information. This will ensure that the defibrillator is ready for use on the next patient.

At several points in the Event Review Pro instruction, you are instructed to ignore the defibrillator voice message that says "Insert the pads cartridge (for HS1)" or "No connector installed. Plug in pads connector (for FRx)." The message is there to ensure that you are aware of the defibrillator's current state. If you remove the HS1 pads cartridge or the FRx pads connector, the defibrillator is not available for use on the patient. When the defibrillator enters the Administration mode, the message stops.

You can put the FR3 into Admin mode without removing pads.

System messages

If Windows detects an active wireless device, it starts the Windows Wireless Link. Event Review Pro does not use this application and cannot disable it. As a result, the Windows Wireless Link might display messages. These messages do not apply to your current task. You can ignore them.

Emailing device history data

If you ask for assistance from Philips Customer Support, you may be asked to retrieve the device history data (self-test data) from a specific defibrillator. Use the following steps (or do as directed by Customer Support) to retrieve and email this data.

Email a device self-test file to customer support only when instructed to do so by a Philips support technician.

To email device self-test data to Customer Support

1. From the Help menu, click Email with Device Self-Test File. The Device Self-Test Wizard appears.
2. Set up the device that you are sending data from. For details on how to set up your device to transmit data, see Set up an AED device to transfer self-test data on page 208.
3. From the list of devices, click the one that you want to send data for and click **Next**.
   An email message box appears, with the device history data appearing as an attachment.
4. Type any comments you want to add to the message.
5. Click **Next**.
   The message is sent and a status message appears.

**Set up an AED device to transfer self-test data**

The process for setting up an AED device to transmit data varies by model. See the following for information by model.

**HS1 and FRx devices**

If you are sending data from an FRx or HS1 device, put the device into Administration mode. For details on setting up the connection, see [Setting up the infrared connection](#) on page 204.

**FR2 devices**

If you are sending data from an FR2 device using a data card, the data card must be installed, and the Battery Insertion Test (BIT) must be run before the self-test data is available to transfer. See the instructions that came with the FR2 device for further information about running BIT. When the device history data file is on the card, insert the card into a card reader attached to your computer.

**FR3 devices**

When sending self-test data from an FR3 device by any method, before the self-test data is available to transfer, the data card must be installed in the device, and the User-Initiated Test (UIT) must be run. (See the instructions that came with the FR3 device for further information about running UIT.)

**Transfer FR3 self-test data using the data card**

Remove the data card from the FR3 and insert the card into a card reader attached to your computer.

**Transfer FR3 self-test data using the Bluetooth connection**

Turn on the FR3 device, wait for the voice prompts, put the device into Administration mode, press the **option** button, and select **Wireless Data Transfer**. (See the instructions that came with the FR3 device for further information about putting the device into Wireless Data Transfer mode.)
Importing device self-test data using the Device Self-test Wizard

The Devices workspace provides tools for transferring self-test data from Philips HeartStart AEDs to the Event Review Pro database, and tables where you can view and manage the self-test data.

Device self-test data can be imported from HeartStart AED devices. However, the importation of device self-test data from HeartStart monitor/defibrillators, such as the HeartStart MRx, is not supported.

The Device Self-test Wizard

Use the Device Self-test Wizard to transfer self-test data from the HeartStart FR3, FR2 series, FRx, or HS1 AEDs.

Event Review Pro documentation uses the HS1 or HS1 family of defibrillators to refer to HeartStart Home, HeartStart OnSite, and HeartStart HS1 Defibrillators.

Opening the Device Self-test Wizard

1. In the navigation pane, click Devices.
   The Devices pane opens.
   The Device Self-test Wizard opens.
3. Follow the steps in the wizard, clicking Next to move to the next section.

Preparing the AED to transfer data

You can use the Device Self-test Wizard to transfer data wirelessly from the FR3 device using Bluetooth wireless data transfer.

When sending self-test data from an FR3 device by any method, before the self-test data is available to transfer, the data card must be installed in the device, and the User-Initiated Test (UIT) must be run. (See the instructions that came with the FR3 device for further information about running UIT.)
Turn on the FR3 device, wait for the voice prompts, put the device into Administration mode, press the **option** button, and select **Wireless Data Transfer**. (See the instructions that came with the FR3 device for further information about putting the device into Wireless Data Transfer mode.)

Click the icon only if you want setup instructions; clicking an icon does not start data transfer.

**To use the Wizard to transfer self-test data**

1. In the wizard, navigate to the **Device Selection** page, and then prepare your defibrillator for data transmission.

   When the user selects a transfer method (for example, *Bluetooth*, or IrDA), and clicks Next, the wizard then begins data acquisition.

2. Allow the transmission to complete before moving the device.

   When the self-test data is transferred, a message appears in the wizard: "All tasks have been successfully completed", and the All Devices table opens.

3. Return the defibrillator to ready-to-use state.

**The All Devices table**

When the Device Self-test Wizard completes data transfer, devices whose self-test data has been acquired through the Device wizard appear in the All Devices table. In each row, the table shows a device icon, device serial number, device manufacture date, and the date that the last self test data was acquired, to assist you in locating the correct self-test data.

**To open the All Devices table directly**

- On the **Devices** pane, click **All Devices** to open the All Devices table directly.

**To view device self-test data**

1. In the **All Devices** table, double-click a row to view the self-test data for that device.

   The Self-test Results table opens, with self-test data for the selected device. At the top of the table, the device model and serial number appear.

2. To print the data, click **Print** on the toolbar or in the File menu.
The Self-test Results table

The Self-test Results table includes the following columns of self-test information:

- Sequence Number
- Date
- Time
- Relative Time
- Description
- Status

For information about sending self-test data to Philips Customer Support, see Emailing device history data on page 207.
Managing the database

Event Review Pro stores the application database in Microsoft SQL Server 2014 SP1 Express Edition. This is a free version that Philips installs by default. It limits the database size to 10GB. The number of cases that can be stored in a database of this size varies depending on the length of captured ECGs and whether or not the file includes audio.

The versions sold by Microsoft are limited only by the size of the hard disk.

The Event Review Pro database is low-maintenance, compared to many other databases. Nonetheless, attention to routine maintenance tasks will help to ensure database integrity.

It is the database administrator’s responsibility to set up the appropriate database management features and to check that they execute successfully.

Back up the database on a regular basis (preferably every day) to tape or some other medium. Disaster-recovery experts recommend that you store the backup tapes somewhere safe, so that disasters such as fire or theft cannot harm them. Without a recent backup, you have no chance of recovery after a catastrophe, such as a disk failure or fire. Use your organization's backup and recovery policy to set up this procedure.

Microsoft has procedures and tools for managing SQL Server.

For information on migrating data from an older version of the application, see Migrating cases from previous versions on page 214.
Using the Event Review Pro database on a remote database server

Event Review Pro supports use of a remote database that is installed on another machine. Multiple instances of Event Review Pro can share the database.

You must install the same version of Event Review Pro on each client machine connected to a shared database.

Philips recommends that Information Technology (IT) personnel install and configure the remote database server.

Use this feature with care. Before implementing the application on a shared database server, keep the following in mind:

- The application saves only the changes made by the most recent user to save the case. For example, when more than one user opens the same case, makes changes, and saves the case, the application saves the changes made by the last user to save the case.
- Event Review Pro installed on a client machine cannot run when the shared database is unavailable, such as when the database server is down, or the network is disconnected (if the shared database resides on another computer).

Using Microsoft SQL

You can purchase the SQL Server software to set up a shared database environment for Event Review Pro.

For information about installing and setting up a shared database, refer to the HeartStart Data Management Solutions Implementation Guide, available from Philips customer support.

The following information is intended for users who have already set up their databases.

Changing the database server

You can change the Event Review Pro database server in the following ways:
To change the database server from the Tools menu

1. From the Programs menu, right-click Event Review Pro and click Run as Administrator.
2. On the Tools menu, click Database Server.
   The Configure SQL Server for Event Review Pro 5.0 window opens, showing the current database name.
3. In the SQL Server name box, use the down arrow to display a list of all available SQL Servers on the network.
4. Click the SQL server name that you want.
5. To verify the connection, click Test.
   A message from the SQL server software appears, noting success or failure. If Event Review Pro displays a failure message, refer to your SQL Server documentation or your local database administrator for instructions.
6. If you see a success message, click the database you wish to use, then click OK.

   This database must use the Event Review Pro 5.0 schema. You cannot use an older database that uses a different schema.

   A message appears stating that you must restart Event Review Pro to use the new database server.

To verify the database server on the About box of Event Review Pro

3. On the Server line, confirm that Event Review Pro is connected to the correct server database.

Migrating cases from previous versions

You can migrate cases from HeartStart Event Review 3.5, 4.2, or 4.3, and from Event Review Pro 3.5, 4.0, 4.1, 4.2, or 4.3 to the Event Review Pro 5.0 database.
HeartStart Event Review 4.3 and HeartStart Event Review Pro 4.3 had limited geographical distribution.

If the source database is on another machine, see your IT professional for assistance.

Steps for migrating the data

1. Identify the database from which the cases are to be migrated—the source database.
2. Event Review Pro creates a list of all the cases from the source database and compares them (using the case ID) to the cases in the current Event Review Pro 5.0 database (the destination database). Cases that are not already in the destination database are marked for migration.
3. Migrate the marked cases.

Use the following procedures to complete the migration.

To select and identify the source database

1. In the main workspace, click the Administration button.
2. In the Administration navigation pane, click one of the following options:
   - Migrate Records from Event Review 3.5
   - Migrate Records from Event Review 4.2
   - Migrate Records from Event Review 4.3
   - Migrate Records from Event Review Pro 3.5
   - Migrate Records from Event Review Pro 4.0
   - Migrate Records from Event Review Pro 4.1
   - Migrate Records from Event Review Pro 4.2
   - Migrate Records from Event Review Pro 4.3

A database selection dialog box appears, displaying only those computers with the expected, well-known instance and database names, as shown in this table:

<table>
<thead>
<tr>
<th>Event Review Pro version</th>
<th>SQL Server instance name</th>
<th>Database name</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.5</td>
<td>HeartStart</td>
<td>ERPro35</td>
</tr>
<tr>
<td>4.0</td>
<td>Philips</td>
<td>ER40</td>
</tr>
</tbody>
</table>
3. Click the appropriate source database.

4. (Recommended) To test the accessibility of the source database, click **Test**.
   
   A message appears reporting the success or failure of the test.

5. Click **OK** to continue the migration process.

### To view and confirm the list of cases to be migrated

1. Once you have selected the source database, Event Review Pro connects to this database and displays a list of all the cases. The ones to be migrated have the + sign.

2. If a case with the same case ID already exists in the destination database, the case will not be migrated. If you still want to migrate such a case, cancel the migration, rename or delete the case in the destination database, and then restart the migration process.

### To migrate the cases

1. Click **OK**.

   The data migration begins. This takes some time, particularly if you have many cases.

2. If you need to cancel migration, click **Cancel**. You can restart the migration process at another time. Because any already migrated cases will have the same case ID as those in the source database, those cases will not be migrated again.

   The migration status of each case is logged in the System Log, including any errors.

   The successfully migrated cases are now in the database, and appear in the case selection table.

<table>
<thead>
<tr>
<th>Event Review Pro version</th>
<th>SQL Server instance name</th>
<th>Database name</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1</td>
<td>Philips</td>
<td>ER41</td>
</tr>
<tr>
<td>4.2</td>
<td>PHILIPS42</td>
<td>ER42</td>
</tr>
<tr>
<td>4.3</td>
<td>PHILIPS42</td>
<td>ER43</td>
</tr>
</tbody>
</table>
The Cerebral Performance Categories (CPC) and Overall Performance Categories (OPC) are two scores that are used when reporting cardiac arrest. The Follow-up tab uses these categories.


This section explains the scores for each category.

### Cerebral performance categories table

<table>
<thead>
<tr>
<th>Score</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Good cerebral performance</strong>: Conscious. Alert, able to work and lead a normal life. May have minor psychological or neurological deficits (mild dysphasia, nonincapacitating hemiparesis, or minor cranial nerve abnormalities).</td>
</tr>
<tr>
<td>2</td>
<td><strong>Moderate cerebral disability</strong>: Conscious. Sufficient cerebral function for part-time work in sheltered environment or independent activities of daily life (dressing, traveling by public transportation, and preparing food). May have hemiplegia, seizures, ataxia, dysarthria, dysphasia, or permanent memory or mental changes.</td>
</tr>
<tr>
<td>3</td>
<td><strong>Severe cerebral disability</strong>: Conscious. Dependent on others for daily support because of impaired brain function (in an institution or at home with exceptional family effort). At least limited cognition; includes a wide range of cerebral abnormalities from ambulatory with severe memory disturbance or dementia precluding independent existence to paralytic and able to communicate only with eyes, as in locked-in syndrome.</td>
</tr>
<tr>
<td>4</td>
<td><strong>Coma, vegetative state</strong>: Not conscious. Unaware of surroundings, no cognition. No verbal or psychological interactions with environment.</td>
</tr>
<tr>
<td>5</td>
<td><strong>Death</strong>: Certified brain dead by traditional criteria.</td>
</tr>
<tr>
<td>Score</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>1</td>
<td><strong>Good overall performance</strong>: Healthy, alert, capable of normal life. Good cerebral performance (CPC1) plus no or only mild functional disability from noncerebral organ system abnormalities.</td>
</tr>
<tr>
<td>2</td>
<td>Moderate overall disability: Conscious. Moderate cerebral disability alone (CPC2) or moderate disability from noncerebral system dysfunction alone or both. Performs independent activities of daily life (dressing, traveling, and food preparation). May be able to work part-time in sheltered environment but disabled for competitive work.</td>
</tr>
<tr>
<td>3</td>
<td>Severe overall disability: Conscious. Severe cerebral disability alone (CPC3) or severe disability from noncerebral organ system dysfunction alone or both. Dependent on others for daily support.</td>
</tr>
<tr>
<td>4</td>
<td>Coma, vegetative state: Not conscious. Unaware of surroundings, no cognition. No verbal or psychological interactions with environment.</td>
</tr>
<tr>
<td>5</td>
<td>Death: Certified brain dead by traditional criteria.</td>
</tr>
</tbody>
</table>
Glasgow Coma score

The Glasgow Coma score is a score given to head trauma victims based on the Glasgow Coma Scale (GCS). The total score is based on examination of eye opening, verbal output, and motor (movement) responses to different modalities and intensity of stimulation. You give each of these three attributes a score, and then Event Review Pro totals the three scores.

The choices in the GCS Total field are:

0 (3) (total up to 3)
1 (4-5) (total from 4 to 5)
2 (6-8) (total from 6 to 8)
3 (9-12) (total from 9 to 12)
4 (13-15) (total from 13 to 15)
Unknown

A score of “unknown” indicates that one or more response scores do not have an entry or have an entry of “unknown.”

<table>
<thead>
<tr>
<th>Eye opening</th>
<th>Verbal output</th>
<th>Motor (movement) responses</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Score</td>
<td>Finding</td>
</tr>
<tr>
<td>Obeys commands or Spontaneous or purposeful Patient follows commands</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Oriented or Coos or babbles</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Purposeful or Withdrawal from</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eye opening</td>
<td>Verbal output</td>
<td>Motor (movement) responses</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Normal, fluent, appropriate speech</td>
<td>touch</td>
<td>Patient locates pain on own body</td>
</tr>
<tr>
<td>4 Spontaneous</td>
<td>Confused or Irritable and continually crying</td>
<td>4 Withdraws from pain</td>
</tr>
<tr>
<td>Exes open without stimulation</td>
<td>Confused but fluent speech</td>
<td></td>
</tr>
<tr>
<td>3 To voice</td>
<td>Inappropriate or Cries to pain</td>
<td>3 Flexion to pain</td>
</tr>
<tr>
<td>Eye opening to loud noise</td>
<td>Mumbling, occasional word recognizable</td>
<td></td>
</tr>
<tr>
<td>2 To pain</td>
<td>Incomprehensible or Moans to pain</td>
<td>2 Extension to pain</td>
</tr>
<tr>
<td>Eye opening to pain only</td>
<td>Vocalizations but not verbalizations (no words)</td>
<td></td>
</tr>
<tr>
<td>1 None</td>
<td>None</td>
<td>1 None</td>
</tr>
<tr>
<td>No eye opening</td>
<td>No vocalization or verbalization</td>
<td></td>
</tr>
</tbody>
</table>
ACI-TIPI

For acute cardiac ischemia time-insensitive predictive instrument. A Philips software tool in that can provide a second opinion and decrease the time between the onset of a patient’s acute cardiac ischemia (ACI) symptoms and the treatment of interventional cardiology. The ACI-TIPI feature computes a patient’s likelihood of having an ACI based on the patient’s age, gender, chest pain status, and acquired 12-lead ECG. When the defibrillator runs the ACI-TIPI analysis, the interpretative block on the 12-lead report includes ACI-TIPI data.

Impedance

Commonly denoted as Z. Electrical resistance.

License Manager

The License Manager allows you to type in your registration key to activate HeartStart software.

PEA

Pulseless Electrical Activity.

PR

Perfusing Rhythm.

PST

For Periodic Self Test. A self-administered test mode that a HeartStart defibrillator runs to ensure that all defibrillator components are functional and work properly. Test results are Pass, Warning, or Call customer support.

Q-CPR

Q-CPR is a Laerdal registered trade mark. The name was derived from Quality of Cardiopulmonary Resuscitation

URL

URL stands for Uniform Resource Locator, an address for a resource on the Internet. URLs are used by Web browsers to locate Internet resources.
XML

Stands for eXtensible Markup Language. This file format has a set of rules for encoding documents in machine-readable form.

zCPR

Impedance-derived cardiopulmonary resuscitation quality. zCPR derives compression rate, hands on time and hands off time from the impedance recorded across the AED therapeutic pads. Unlike Q-CPR, zCPR does not provide compression depth or compression release calculations.
Index

12-lead information 60, 119, 121
  attaching 52
  magnifying 122
  reviewing 122
12-lead reports 156

A
activating the product 14
  Internet 15
  within 60 days 17
Administration workspace tasks 25
  annotations
    CPR responder 128

B
Bluetooth 119, 195, 197, 199
  attaching ECGs 53, 56-57
  automatic synchronization 67
  erasing data source 67
  exchange folders 58
  pairing and testing 198
  prerequisites 198

C
card readers 193
  Case Details report 155

ventilation 127
ATA flash card reader 201
attachments 34, 53
  Bluetooth 53
  ECGs 48, 51, 54-58, 60, 201
  printing 136
Attachments table 34
audio, playing on ECGs 107
Average Response Times—Total System report 184
Average Response Times report 185
Index

Case Editor tabs 28, 88
Case Editor, default view 28, 89
Case Editor, viewing 12-leads 120
case ID 70
case selection table 26, 33
Case Summary 48
Case Wizard 47, 51
cases 43, 48, 62
  adding details 78
  adding patient information 87
  attaching files 135
  creating 43, 47, 50
  defined 19, 43
  deleting 72
duplicate ECGs 73
  emailing 71
  exporting 69
  hiding and displaying 63
  identifying 79
  importing automatically 65
  importing manually 64
  merging automatically 76
  merging manually 74
  migration from earlier versions 214
  opening 50
  printing 69
  reviewing events 133
  saving 66
  sorting and grouping 62
CDR file, sending to Customer Support 207
Cerebral Performance Categories (CPC) 217
color
  ECG selections 110
  vital trends display 119
CompactFlash card reader 196
compatibility 18
confirmation messages, restoring 42
CPR
  adding notes to ventilation channel 127
  creating exclusions 125
  customizing episodes 123
  removing exclusions 126
  report data 169
  response times 173
CPR guidelines 150
cumulative device records, sending to Customer Support 207
cursor delta time 108
customer support 189
e-mailing System Log to 145

data card for attaching ECGs 55, 193
data migration from older versions 18
data source, erasing 67
data, migration from earlier versions 214
database 212
  remote server 213
  verifying location 213
date and time
  adjusting defibrillator 66
  events, changing 87
defibrillators
  adjusting date and time 66
  supported 192
  transferring self-test data 209
  voice and system messages 206
detaching ECGs 61
device tests 207
Do Not Show This Message Again 42
document conventions 21
downloading ECGs 51
Duplicate ECGs table 139

detaching ECGs 61
device tests 207
Do Not Show This Message Again 42
document conventions 21
downloading ECGs 51
Duplicate ECGs table 139

ECG Pre- and Post-shock report 156
ECG selections 108
  color 110
  creating 109
  managing 109
  naming and sorting 111
Q-CPR 110
  templates 112

ECGs 88
  12-Lead view 121-122
  adding 51, 54-58, 60
  attaching 48, 51, 54-58, 60, 201
  changing time scale 101
  Channels pane 32, 92
  copying to clipboard 113
  customizing display 117
  detaching 61
  duplicates 73, 139
  Events pane 31, 92
  navigating on waveform 107
  Overview pane 31, 92
  playing audio 107
  printing reports 108
  removing 61
  reports 155
  shortcuts 129
  tab 88
  Transport pane 32, 93
  view 28, 88
  viewing information 108
  vital trends 117

Efficia DFM100 56
  Efficia DFM100 defibrillator/monitor 54

email
  cases 71
  reports 50

EMS edition 9

erasing data source 67

events 34
  adding 85
  changing date and time 87
  documenting 85
  editing 85-86
  expanding and collapsing nodes 94
  expanding list 93
  filtering 134
  filtering entries 37
  finding and viewing 94
  grouping 36, 134
  hiding and displaying 95, 134
  icons 93
  managing notes 96
  printing 134
  removing 85
  searching for 95
  sorting 36, 86

Events pane 31, 92

Excel
  exporting Q-CPR Details Report data 169
  exporting table data 40
  exclusions for Q-CPR
    creating 125
    removing 126
  exporting files 49
    password protection 49

F

F1, using for Help 20

fields, completing 40

files, adding to case 135
files, attaching ECGs from 60, 135

filtering events 134
filtering imported device data 140
filters
  removing 39

Final Review tab
  Case Reviewed box 137

G

Getting Started options 23

Glasgow Coma Score (GCS) 219

grouping events 134

guidelines 150
H

HeartStart FR2 defibrillators 56
  attaching ECGs 54
  data cards 200
HeartStart FR3 defibrillators 53-54, 56
  Bluetooth 195
  data cards 195
  synchronizing clock via data erasure 69
HeartStart FRx defibrillators 55, 58
  Admin mode 204
  case date and time 203
HeartStart Home defibrillators 55
HeartStart HS1 defibrillators 55, 58
  Admin mode 205
  case date and time 203
HeartStart MRx monitor/defibrillators 48, 53-54, 57, 79, 119
  Bluetooth 198-199
  data cards 196
HeartStart OnSite defibrillators 55
HeartStart XL defibrillators
  attaching ECGs 54
  data cards 201
HeartStart XL+ defibrillators 56, 69, 201
  attaching ECGs 54
  data cards 201
help 20, 22, 189
hiding and displaying cases 63
Hospital edition 9
HTTP, using for Import Service 143

I

icons for events 93
Import Service 65, 138, 143
  configuring 141

filtering data 140
managing inboxes 139
purging archive folders 142
importing files 138
  automatically 65
  manually 64
infrared connections 53, 58, 203-204
installation 8
IrDA connections 53, 58, 203

K

key command shortcuts 129

L

license types 9

M

merging related cases manually 74
migration of older data 8, 214
mouse 129

N

navigation pane 24, 26
  minimizing 24
new features, version 5.0 19
notes, managing 96
Index

offset, waveform 104
online help 21
Overall Performance Categories (OPC) 217
Overview pane 31, 92

password protection 49, 65, 69, 139
patient identity, removing 49
patient information, adding 87
PC card reader 201
PCMCIA card reader 201
pediatric option for FR2 56, 60
Percentile Response Times—Total System report 185
Percentile Response Times report 185
pinning and unpinning 99
point style, vital trends view 118
printing
case information 69
reports 49
product support 189
purging archive folders for imported device data 142

quick note 115

redaction 70-71, 79, 147
removing ECGs 61
removing the application 17
reports 147
12-lead 156
case details 155
ECGs 155
emailing 50
exporting 154
generating for open case 151
generating from database 152
printing 50
Q-CPR 158
Response Times 183
Select Cases 148
toolbar icons 153
Vital Trends 183
Reports
12 lead 156
resetting ECG display layout 99
resizing panes and workspaces 41
Response Times report 183
Reviewed column in Patient Cases table 137
reviewer notes, adding to a case 137

saving cases 42, 66
scale, waveform 106
search for cases
queries 44, 46
Quick Selections 44
search criteria 44
selections templates, ECGs 112

Q-CPR data 123
Q-CPR Report Card report 158
queries, creating 46
queries, deleting 47
T

tables
  duplicate ECGs 73
  printing 69
Tablet Mode 41
Tablet PC 41
telephone support 189
time
  changing on waveform 100
  changing scale 101
Timeline tab 85
tooltips 20
transferring self-test data from a device 209
Transport pane 32, 93

U

uninstalling
  current version software 17

V

ventilation channel, adding notes to 127
vital trends 117
  color 119
  point style 118
Vital Trends report 183

W

waveforms 97
  audio 101
  changing color 104
  changing display time 100
  changing scale 106
  displaying and hiding 99
  displaying in channel 103
  ECG information 108
  exporting data 113
  magnifying 100
  magnifying waveforms 100
  measuring value 108
  navigating ECG events 107
  notes 114
  offsets 104
  selecting 98
  viewing 97
  viewing ECG information 108
  zooming in and out 116

Unwitnessed with Bystander CPR
  report 186
updates, checking for 13
upgrade 8
USB data drive, attaching ECGs from 56, 201
using Select Cases for reports 148
Utstein guidelines 186, 217
Utstein reports 186
Waveforms pane 32, 92, 101-102
What would you like to do today? 23
Witnessed with Bystander CPR report 187
Witnessed without Bystander CPR report 187
wizards 20, 59, 209

Z

zCPR data 123
zCPR, customizing episodes 123